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About this Guide

The Xplorer GLX Users’ Guide is divided into two parts.

Part 1 contains detailed information about operating the GLX, including descriptions of every screen, win-
dow and menu within the GLX environment, and instructions for common procedures.

Part 2 contains step-by-step instructions for science activities and experiments that can be done with the 
GLX, its standard included equipment, and commonly available supplies.

This is revision F of the User’s Guide, for version 1.4x of the GLX firmware. Visit 
www.PASCO.com/glx/ for downloadable updates to the Users’s Guide and firmware. If you have updated 
your GLX from a previous version, be sure to check out these new features:

Technical Support

For assistance with the Xplorer GLX and other PASCO products, contact PASCO Technical Support at:

New for Version 1.4x Update firmware from USB flash drive, p. 93
Cell-selective manual sampling with Table display, p. 60
Instant data monitoring in Digits and Meter displays, pp. 37 & 38
Automatic calculation creation from Linear Fit, p. 22
Export data to text file, p. 32

New for Version 1.3x Swap Cursors, p. 21
Toggle Active Data, p. 21
Zoom Tool, p. 25

New for Version 1.2x Voice and Text Data Annotation, p. 25
USB flash drive support, p. 83
GLX-to-GLX data transfer, p, 84

New for Version 1.1x Scope Mode, p. 22
Output-control Calculations, p. 50
Built-in Sound Sensor, p. 58
Data Collection with ScienceWorkshop Sensors pp. 59, 67

Address: PASCO scientific
10101 Foothills Blvd.
Roseville, CA, 95747-7100 USA

Phone: (800) 772-8700 (in the U.S.)
(916) 786-3800 (worldwide)

Fax: (916) 786-7565

Web: www.pasco.com/support/

Email: support@pasco.com

Copyright
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or services of, their respective owners. For more information visit www.pasco.com/legal.
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How to Store the 

Even when the screen is blank, the GLX is active: it powers its memory, it periodically checks its battery, and it 
monitors its keypad. Like other hand-held computers, the GLX never turns off—it just goes to sleep.

Before you put your GLX away, read these instructions.

With proper care, you can ensure that your GLX will be ready for use whenever you need it.

*Note for early hardware versions: Early versions of the GLX do not support deep sleep mode. If you have one of these GLXs, leave it 
plugged in or remove the battery for long-term storage. (But don't plug in the AC adapter when the battery in not installed.) See page 95 of the 
Users' Guide for more information.

TAPE THIS SHEET TO THE INSIDE LID OF THE GLX STORAGE BOX OR POST IT WHERE THE GLX WILL BE STORED.

Visit www.pasco.com/glx to download the latest GLX firmware update and Users’ Guide.012-08950F

Storage Time What You Should Do

WHENEVER 
POSSIBLE

Leave the GLX Plugged In

Leave the GLX connected to AC power so it can keep its battery charged and store data 
files indefinitely. This is the best way to store the GLX for any length of time.

Unplugged for
MORE THAN
A FEW DAYS

Backup Your Data

Data files stored in RAM are temporary. If you want to keep your data files, transfer them to 
the GLX's internal Flash memory, a USB Flash drive, or a computer. See pages 78–84 and 
100 of the Users' Guide for more information.

Fully Charge the Battery

Put the GLX away with a full battery to keep the RAM active (for up to two weeks) and 
ensure that the battery has power the next time you use it. 

Any time within two weeks, simply press and hold the power button to turn it on. Data 
saved in RAM will still be there.

After two weeks, plug in the AC adapter to turn on the GLX (or press the reset button on 
the back) and retrieve data files from your backup location.

Unplugged for
MORE THAN

A MONTH
Put the GLX into Deep Sleep*

In deep sleep mode, an internal switch opens to disconnect the battery. To put the GLX 
into deep sleep: backup your data; allow the battery to fully charge; unplug the AC adapter; 
go to the settings screen, press , and press ; follow the on-screen instructions.

Why is deep sleep important?
Nickel metal hydride batteries last longer when they are kept as fully charged as possible. 
Deep sleep mode prevents unnecessary discharging.

What if I forget to put it into deep sleep?
Don't worry. If the GLX is left unplugged and unused from more than two weeks, it puts 
itself into deep sleep. 

How do I wake up the GLX from deep sleep?
When you're ready to use it again, just plug in the AC adapter (or press the reset button on 
the back) and retrieve data files from your backup location.
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Introduction 
The Xplorer GLX is a data collection, graphing, and analysis tool designed for science students and educators. The Xplorer 
GLX supports up to four PASPORT sensors simultaneously, in addition to two temperature probes and a voltage probe con-
nected directly to specialized ports. 

An optional mouse, keyboard, or printer can be connected to the Xplorer GLX’s USB ports. The Xplorer GLX contains an 
integrated speaker for sound generation and a stereo signal output port for optional headphones or amplified speakers.

The Xplorer GLX is fully functional stand-alone handheld computing device for science. It also operates as PASPORT sensor 
interface when connected to a desktop or laptop computer running DataStudio software.



4 I n c l u d e d  E q u i p m e n t
Included Equipment

B CA

D

E F G H

A) GLX Users’ Guide

B) Xplorer GLX

C) AC Power Adapter

D) Registration Card

E) Getting Started with the Xplorer GLX CD-ROM

F) Two Fast-response Temperature Probes
(-10 to 70 °C)

G) Voltage Probe (-10 to +10 V)

H) USB Host-connection Cable

I) Poster (not pictured)
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Quick Start
Getting started with the GLX is easy—simply plug in the AC adapter, connect 
one of the included sensors, and collect data. In the example below, you will start 
the GLX and collect temperature data.

1. Plug In the AC Adapter

Connect the AC adapter to the power port on the right side of the GLX and plug 
the adapter into a power outlet (100 to 240 VAC, depending on your location). 
When you connect the AC adapter, the GLX turns on automatically.

The first time you use the GLX, leave it plugged in overnight (at least 14 hours) 
to allow the battery to fully charge.

If the battery has already been charged, you can use the GLX without the AC 
adapter. To turn it on using battery power, push the power button at the lower-
right corner of the keypad ( ) and hold it for about one second.

2. Connect a Sensor

Connect a temperature probe to one of the temperature ports on the left side of 
the GLX.

In most cases, the Graph display will launch automatically with the axes labeled 
“Temperature (°C)” and “Time (s).”

3. Collect Data

Press .

The GLX is now recording and graphing data from the sensor. Press  to 
automatically scale the graph.

Hold the end of the temperature probe in your hand and observe how the data 
plotted on the Graph react.
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6 O v e r v i e w  o f  t h e  G L X
To stop data recording, press  again.

You have just collected and graphed a run of temperature data. To collect addi-
tional data runs, press  again.

There are several different ways to collect data with the GLX. This is the sim-
plest and most common. See “F1 Mode” on page 57 for other options. You 
can find a complete description of the Graph display starting on page 13.

Overview of the GLX
The example above represents just a small part of the GLX’s capabilities. This 
overview will outline some of the set-up options to customize your GLX and pre-
pare it for an activity; then (starting on page 9) survey the GLX’s Home Screen 
as a gateway to the entire GLX environment.

Equipment Set-up Options

Power Source Whenever possible, it is a good idea to use the GLX connected 
to the AC power supply. For maximum operating time on battery power, first 
connect the GLX to AC power for at least 14 hours, or until the Battery Gauge 
indicates a full charge.1

Power On The power turns on automatically when you plug in the AC adapter. 
If the GLX is running on batteries, or if the AC adapter is already connected, 
push and hold the power button ( ) for about 1 second to turn it on.

By default, the GLX is set to start with a new data file; however, if the Startup 
Action of the GLX has been set to “Open Last Experiment,” it will automatically 
open the most recently saved file. See page 86 for more information.

Back Light To turn on the screen’s back light, press and hold  while you 
press .2

Screen Contrast There are 21 levels of screen contrast. Push and hold , 
then use the up and down arrow keys ( ) to adjust the contrast to a comfortable 
level.

Language In its factory configuration, the GLX is set up to operate in English. 
If you would like to change the language, refer to “Settings Screen” on page 85.

PASPORT Sensors Connect up to four PASPORT sensors to the main ports 
on top of the GLX.

In some cases, the GLX may automatically launch the Graph or other display 
when you plug in a sensor. See “Sensor Auto-Display” on page 86 for more 
information about this feature.

Temperature Probes Connect the included fast-response probes or other 
PASCO temperature probes to the two temperature ports on the left side of the 
GLX. The range is -10 to +70 °C with fast-response probes, or -10 to +135 °C 
with stainless steel probes.

Voltage Probe Connect the included voltage probe to the voltage port on the 
left side of the GLX to measure voltages between -10 and +10 V. The voltage 
probe should be connected to voltage sources only when it is also connected to 

1See “Battery Gauge” on page 11.

2The backlight and other aspects of the 
Xplorer GLX can also be adjusted in the 
Settings Screen. See page 85.
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 X p l o r e r  G L X  U s e r s ’  G u i d e 7
the GLX. Do not connect a voltage source until after the probe is connected to the 
GLX; remove any voltage sources before disconnecting the probe.

Sound Sensor To configure the GLX’s microphone as a sound sensor, press 
 and  together to enter the Sensors screen; then press  to open the 

Microphone menu. From the menu, select Sound Sensor to record the sound 
waveforms, or select Sound Level to measure sound level in decibels. See “F3 
Microphone” on page 58 for more information.

Computer If you will be using the GLX with a computer, use the included USB 
host-connection cable to connect the GLX to the USB port of the computer. 
Refer to page 99 for instructions on setting up the computer.

Mouse  If you will be using an optional mouse (PS-2539), connect it to the USB 
port on the right side of the GLX.

A mouse can be convenient, but it is never required; anything that you can do 
with the mouse can also be done through the GLX’s keypad. New users often 
find that operating the GLX is easier with a mouse. For experienced users, using 
the keypad rather than a mouse is usually faster.

Keyboard If you plan to do a lot of text entry, connect a USB keyboard
 (PS-2541) to the port on the right side of the GLX. 

To connect a mouse and a keyboard simultaneously, use the optional 
PS-2536 Peripheral Cable. 

Signal Output If you have headphones or a pair of amplified stereo speakers 
that you wish to use for sound generation, connect them to the signal output port. 
You also have the option of using the GLX’s built-in speaker for sound output. 
See “Output” on page 39 for more information.

USB Storage Device If you have a USB storage device (such as a flash drive) 
you can connect it to the GLX’s USB port for extra file-storage capacity and data 
backup. See page 83 for more information.

GLX-to-GLX Transfer If you have two GLXs that you would like to transfer 
files between, connect them using the included host-connection cable. See 
page 84 for more information.

Shutting Down

Manual Shut Down

To turn off the GLX, press and hold  for 1 second. The GLX will prompt you 
to save your data and experiment setup before it shuts down. Press  to save 
your work, press  to shut down without saving, or press  to not shut 
down. See page 80 for instructions on opening the saved file.

If you hold the power button for 5 seconds, the GLX will shut down without 
saving your data.

The GLX cannot shut down while the battery is charging; if you try to turn it off, 
a message will appear informing you that charging is in progress. When the bat-
tery is fully charged, and the GLX has been idle for 60 minutes, it will shut down 
automatically (see below).
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8 O v e r v i e w  o f  t h e  G L X
Auto Power Off

Timed Auto Power Off If it is running on battery power, the GLX will auto-
matically save your data and shut down after a certain amount of continuous idle 
time (5 minutes by default).3

To set the idle time that must elapse before auto shut down on battery 
power, see “Auto Power Off” on page 85.

If the GLX is running on AC power and the battery is fully charged, it will auto-
matically shut down after 60 minutes of idle time. 

The GLX will warn you that it is about to shut down 30 seconds before it actually 
does. If you see the warning, press  to proceed with the shutdown, or press 

 to keep the GLX turned on. 

Battery Auto Power Off The GLX will also save data and shut down automat-
ically if the batteries drain to a critical level. Connect AC power before turning 
the GLX back on.

Auto Data Save Just before the GLX shuts down, it will save the open file 
(which includes all data, displays, calculations and set-up information). If you 
have named the file, it will be saved under that name. If you have not named the 
file, it will be saved with the filename “Untitled.”

Resuming after Auto Power Off To resume your work after the GLX auto-
matically shuts down, push and hold the power button ( ) for about 1 second to 
turn it on. If the automatically saved file does not open automatically, go to the 
Data Files screen (see page 78) and open the file. (See page 80 for instructions on 
opening a file.)

If you have set the Startup Action of the GLX to “Open Last Experiment,” the 
file will automatically open when you turn on the GLX. See page 86 for more 
information.

Sleep Between Samples If the GLX is running on battery power and collect-
ing data at a rate of once every 30 s or slower, and it has been otherwise idle for 
the set auto-power-off time (see page 85), it will “sleep” between samples. When 
the GLX is sleeping, the screen and any connected sensors are turned off to save 
power, and the green LED on the front of the unit blinks once every two seconds. 
When it is time to collect a data point, the GLX wakes up briefly, records data, 
and goes back to sleep. Press any key to wake up the GLX.

The Record Button

Default Recording Mode Whenever you have one or more sensors connected 
to the GLX, you can press  to start data collection. In its default mode, the 
GLX will begin recording data continuously from all connected sensors. Press 

 again to stop data collection. To start recording another data run, press  
yet again.

Sticky Start Use the Sticky Start feature to prevent data collection from being 
unintentionally stopped when you take the GLX on an amusement park ride. To 
start data collection with Sticky Start, press and hold  for about 5 seconds. 
You will hear three beeps and see the Sticky Start icon ( ) appear at the top of 
the screen. Data recording will continue after you release . To stop data 

3The GLX is considered idle when
• the GLX is not collecting data,

• the Stopwatch is not running,

• the GLX is not connected to a com-
puter running DataStudio, and

• the GLX is not receiving input through 
its keypad, a mouse, or a USB key-
board.
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 X p l o r e r  G L X  U s e r s ’  G u i d e 9
recording, you must press and hold  until you hear three beeps again. Data 
recording will stop when you release .

Alternative Recording Modes If you have put the GLX into Manual Sam-
pling mode (see page 57), it will not start recording when you press ; rather it 
will stand by to record a data point whenever you press . If you have turned 
on the Trigger in the Graph display (see page 20), then the GLX will delay the 
start of recording after you press  until the specified trigger condition is 
reached. 

Home Screen

The Home Screen is the center of the GLX environment. All other screens are 
just one step away from the Home Screen. From any other screen, you can 
always return to the Home Screen by pressing .

The Home Screen consists of three sections: the Main Icons, the Bottom Row, 
and the Top Bar.

Main Icons

The main icons on the Home Screen lead to the other screens of the GLX envi-
ronment.

To open another screen via one of the main icons, use the up, down, left, and 
right arrow keys to highlight the desired icon, then press .

The highlight wraps around, so you can move it to any icon within three key 
presses. For instance, if the highlight is in the first column, and you want to 
move it to the fourth column, press the left arrow key once.

Alternatively, if you are using a mouse, simply click on the desired icon.

You can also access the four icons in the bottom row using the function keys. 
See “Bottom Row” on page 10 for more information.

The icons and the screens they lead to are described briefly here, and in more 
detail elsewhere in the following chapters.

Data Files Once you have collected data or configured the GLX for an experi-
ment, you can go to the Data Files screen to save your work. You can also open 
or delete saved files and manage the displays, sensors, calculations, and manually 
entered data sets that are part of a data file. See page 78 for more information.
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10 O v e r v i e w  o f  t h e  G L X
Digits This screen is useful for displaying live data as they are collected from 
sensors and calculations. Up to six data sources can be displayed simultaneously. 
See page 37 for more information.

Meter This display simulates an analog meter with a needle that deflects in pro-
portion to a measurement made by a sensor. See page 38 for more information.

Stopwatch With this screen, the GLX can be used like a regular stopwatch to 
time events. The stopwatch is started and stopped by the user through the GLX’s 
keypad, so no sensors are necessary. See page 54 for more information.

Timing Use the Timing screen to configure photogates, Super Pulleys, and other 
switch-type or counting-type digital sensors. See page 62 for more information.

Settings Go to the Settings screen to change the GLX’s name, time and date, 
and screen settings, set how long the GLX waits before automatically turning off, 
and control how the GLX behaves when you turn it on or connect a sensor. See 
page 85 for more information.

Output The Output screen contains the controls for the signal that the GLX gen-
erates and outputs through the built-in speaker, or through the signal output port 
to headphones or amplified speakers. See page 39 for more information.

Notes In the Notes screen, you can create, read, and edit pages of text notes to 
be saved along with an experiment configuration or collected data. See page 53 
for more information.

Graph Use the Graph to plot and analyze data. In many cases, the Graph is the 
best way to view data as they are being collected. See page 13 for more informa-
tion.

Table The Table displays data numerically in columns. It can be used for editing 
and entering data and for statistical analysis. See page 28 for more information.

Calculator You can use the calculator like a regular calculator for finding the 
result of a simple expression and like a graphing calculator for plotting equations. 
The calculator can also perform operations on streams of data collected from sen-
sors and on sets of manually entered data. See page 41 for more information.

Sensors Use the Sensors screen to customize the way sensors collect data. The 
screen shows which sensors are connected to the GLX and contains controls for 
how each sensor operates. See page 85 for more information.

Bottom Row

Bottom Row

The icons in the bottom row of the Home Screen are selectable via the four func-
tion keys: , , , and . Graph, Table, Calculator, and Sensors 
are the most commonly used screens, and therefore the most easily accessible. To 
make the bottom row of the Home Screen appear temporarily from anywhere in 
the GLX environment, press and hold ; while holding , press one of the 
function keys to open the corresponding screen.

In other screens, you will usually see four choices at the bottom of the screen that 
can be accessed with the function keys.
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Top Bar

The Top Bar is the part of the Home Screen that is always visible from anywhere 
in the GLX environment. It shows the time and date and the name of the GLX or 
the name of the open file. It also indicates the recording status, battery level and 
memory usage. 

Time and Date The time and date displayed in the Top Bar are set automati-
cally when you connect the GLX to a computer running DataStudio (see 
page 99). You can also go to the Settings screen (see page 85) to set the time and 
date manually and change the format in which they are displayed.4 

GLX Name By default, the name displayed in the Top Bar is “XplorerGLX.” If 
you are using more than one GLX in your classroom or lab, you may wish to give 
each one a unique name. See “Settings Screen” on page 85 for instructions.

When a previously saved filed is open, the name of that file appears in place of 
the GLX Name. See page 78 for more information about saving and opening 
files.

Home Icon If you are using a mouse, you can click the Home Icon ( ) in the 
Top Bar, instead of pressing  on the keypad, to return to the Home Screen 
from any other screen in the GLX environment.

Recording Status The Recording Status icon changes to indicate when the 
GLX is collecting data, and in what sampling mode it is operating (see page 57 
for more information about the sampling modes). It also indicates when an audio 
note is being recorded or played (see “Data Annotation” on page 25).

If you are using a mouse, you can click the Recording Status icon, instead of 
pressing  on the keypad, to start and stop data collection.

Memory Gauge The Memory Gauge indicates the GLX’s available memory. 
As data are stored in random access memory (RAM), the icon becomes shaded 
from the bottom up. An entirely shaded icon means that there is little or no capac-
ity remaining for recording data. See “Data Files Screen” on page 78 for instruc-
tions on deleting files or data runs to make more memory available.

If you are using a mouse, you can click the Memory Gauge to open the Data Files 
screen, start a new file, or save the file that you are working with. (Without a 
mouse, the Data Files screen, which includes the New File and Save File options, 
is accessed through the Home Screen; see page 78.)

Battery Gauge When the GLX is running on battery power, the Battery Gauge 
indicates the level of charge of the battery. It is fully charged when the entire 
gauge is shaded. 

Each GLX learns the particular charge and discharge characteristics of its 
battery as it is used. To make the gauge more accurate, allow the battery to 
fully charge, then fully discharge at least once. 

The Battery Gauge also indicates when the GLX is connected to AC power and 
charging the battery.

�����
���+
��
%&'�,
��
���-����,
��

.���
����

)�����
%
���

!
�����
%
���

����"���

��������������

���������������
���
������������������
/����"������
���
������
0

Top Bar

4The time can be displayed in 12-hour or 
24-hour format; the date can be dis-
played as month/day/year or
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Chapter 1: Displays
The GLX has four screens for displaying data: Graph, Table, Digits, and Meter. 
This chapter will describe the structure and use of each display.

Open any of the displays to monitor live data as it is collected. Open the Graph or 
Table to view previously recorded measurements or manually entered data.

Graph
The Graph plots data on a pair of axes. Use the Graph to view, compare, and ana-
lyze data sets.

To Open the Graph

From the Home Screen, do one of the following:

press , the function key below the Graph icon;

use the arrow keys to highlight the Graph icon, then press ; or

click the Graph icon.

From anywhere in the GLX environment, you can always open the Graph with 
the shortcut + .

In some cases, the Graph opens automatically when you connect a sensor.

The Graph Display

��

The Graph icon on 
the Home Screen

��
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Active Fields

Active fields of the Graph

Active fields are the areas on the Graph (and other display screens) through 
which you control what data are shown. When you select an active field, a menu 
opens containing choices of data source, units, or run number. Follow the steps 
below to select an active field using the keypad.

1. Press  to “light up” the active fields—shaded boxes appear around the 
active fields.

2. One of the shaded boxes is darker than the others, designating the high-
lighted field. Use the arrow keys to move the highlight to the field that you 
would like to select. 

3. Press  again to select the highlighted field, which causes a menu to open. 

To select an option from the menu:

• use the up and down keys to highlight the desired menu option, then press 
;

or

• press the number on the keypad corresponding to the desired menu option.

To turn off the highlight without selecting one of the fields, or to close a menu 
without selecting an option, press .

If you are using a mouse, you can left-click an active field to select it and 
open the menu, then click one of the menu options. (It is not necessary to press 

 first.)

Selecting a field with the mouse
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Choosing Data to Display

Data Source A graph is generated from two data sources: one on the vertical 
axis and one on the horizontal axis. The possible types of data source are

• a sensor measurement,

• time (horizontal axis only),

• a calculation,

• manually entered numeric data, and

• manually entered text data (horizontal axis only).1

If you configure the Graph with data sources that already contain data, the data 
will appear immediately. If the selected data sources have not yet collected data, 
the Graph will initially be blank; when data collection starts, each data point will 
be plotted as it is acquired.

Data source menu for the horizontal axis

If there is at least one sensor connected to the GLX, the Graph will automatically 
set one of the sensor measurements as the vertical data source, with time as the 
horizontal data source. Select the vertical or horizontal data source field2 to 
choose a different source.

When you chose a data source, it replaces the previously displayed one. 
See “Two Measurements” on page 23 and “Two Graphs” on page 24 for 
instructions on displaying two vertical data sources simultaneously.

If you do not see the sensor measurement that you want in the data source menu, 
select More to expand the menu. 

For more information on selecting data from the Data Source menu when 
you are working with more than one sensor, or with a multiple-measurement 
sensor, see “Data Source Menus” on page 89.

Also from the Data Source menu, you can select Properties to edit the name and 
other properties of the currently displayed data set. See “Data Properties” on 
page 69 for more information.

Units Select the units field2 to choose different units (if available) for the chosen 
data source.

Run Number Select the run number field2 to choose a different data run. You 
can also choose to display no data.

1For more information on calculations, 
see page 41. For more information on 
manually entered data see page 32.

2To select a data source, units, or run 
number field

Keypad
1. Press  to light up the active fields. 
2. Use the arrow keys to move the high-

light to the desired field. 
3. Press  again to open the menu. 
4. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click the desired field to open the 

menu.
2. Click the desired menu option.

Run number menu
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In normal mode, one data set is displayed at a time. See “Two Runs” on 
page 24 for instructions on displaying two runs simultaneously.

The next-to-last option in the run number menu is Delete Run, which deletes the 
currently displayed run. That run will be deleted from all measurements, not just 
the one displayed in the Graph.

The last option in the run number menu is Rename Run. By default, data runs are 
names “Run #1,” “Run #2,” etc. When you select Rename Run, the GLX 
prompts you for a new run name. Enter the new name using multipress text entry 
(or an attached keyboard) and press  to accept the change (or press  to 
cancel the change). The new name will be applied to that run from all measure-
ments, not just the one displayed in the Graph.

For more information on multipress text entry, see page 90.

Data Cursor and Coordinates

The circle around one of the data points is the Data Cursor. Use the arrow keys to 
move the Data Cursor; the left and right arrow keys step the Data Cursor to adja-
cent data points, the up and down arrow keys make the cursor jump to the first 
and last visible data points. Press and hold the left and right arrow keys to move 
the cursor quickly.

The coordinate pair near the top of the Graph indicates the “X” and “Y” values of 
the Data Cursor.

If you have a mouse, you can move the Data Cursor by dragging it: click 
on the Data Cursor, hold down the mouse button, and move the mouse left and 
right to move the Data Cursor along the data plot.

Graph Function Keys

In the Graph, the function keys are used to change the scale and to open the Tools 
and Graphs menus.

F1 Autoscale

Press  to make the scale of the Graph adjust automatically so that all data 
are visible.

F2 Scale/Move

Pressing  cycles the graph through Scale mode (first press) and Move mode 
(second press). 
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The GLX prompts you to enter a new 
data run name
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In Scale mode, the left and right arrow keys compress and stretch the Graph hor-
izontally; the up and down arrow keys stretch and compress the Graph vertically.

In Move mode, the arrow keys make the graph move left, right, up, and down.

To return to normal mode (indicated when the  function reads “Scale/
Move”), press . If the Graph is in Scale or Move mode and the arrow keys are 
not pressed for several seconds, the Graph will return to normal mode automati-
cally.

See “Zoom” on page 21 for another way to rescale the Graph.

Scale and Move with a Mouse

If you have a mouse, you can scale and move the Graph by dragging it with the 
mouse cursor. (It is not necessary to press  first.)

To change the scale, click and drag on (or between) the numeric labels on the 
edges of the Graph to change the vertical and horizontal ranges.

To move the plot up, down, left, and right, click and drag anywhere in the “back-
ground” of the Graph.

To zoom in on part of the Graph, hold down  while you click and drag to 
draw a rectangle. The area enclosed by the rectangle will enlarge to fill the 
screen.

F3 Tools Menu

Use the analysis tools contained in the Tools menu to obtain numerical informa-
tion from the Graph (such as coordinates and statistics), to visualize different 
properties of the plotted data (such as slope and area), and to enlarge a selected 
area. This menu also contains an options to configure the Trigger (see page 20).
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When you select a tool from the Tools menu,3 a check mark ( ) appears next to 
it. To turn off a tool, select it from the menu again, which removes the check 
mark and returns the Graph to normal mode. If you have a tool turned on and you 
choose a different tool, the previous tool will automatically turn off. 

The options in the Tools menu are described below.

Smart Tool When the Smart Tool is selected from the Tools menu, a pair of 
crosshairs appears on the Graph with labels indicating its coordinates. Use the 
left and right arrow keys to move the Smart Tool to adjacent data points. Use the 
up and down arrow keys to send it to the first and last visible data points. Press 
and hold the left or right arrow key to move the Smart Tool quickly.

If you have a mouse, you can move the Smart Tool by dragging the cir-
cle at the intersection of the cross hairs left and right.

Delta Tool When the Delta Tool is selected from the Tools menu, a dashed rect-
angle appears on the Graph. One corner is marked with a circle, the other is 
marked with a triangle. Labels on the edges of the Graph indicate the width (∆X) 
and height (∆Y) of the rectangle, measured from the circle to the triangle.

When you first turn on the Delta Tool, the circle and triangle appear at the same 
point. Press the left or right arrow a few times to separate them.

The left and right arrow keys move the triangle to adjacent data points; the up 
and down arrow keys send the triangle to the first and last visible data points. 
Press and hold the left or right arrow key to move the triangle quickly.

If you have a mouse, you can move the triangle by dragging it left or 
right.

The triangle designates the active corner of the Delta Tool, which is the corner 
that moves when you press the arrow keys or drag it with the mouse. To make the 
other corner active, hold  and press . The triangle and circle will swap 
places when you release both keys.

Note that when the cursors swap places, the signs of ∆X and ∆Y change. These 
values are always measured from the circle to the triangle; ∆X is the triangle’s X 
coordinate minus the circle’s X coordinate, ∆Y is the triangle’s Y coordinate 
minus the circle’s Y coordinate. You would most typically be interested in the 
values reported when the triangle is to the right of the circle.

3To select a tool from the Tools 
menu:

Keypad
1. Press  to open the Tools menu.
2. Use the arrow keys to move the high-

light to the desired tool and press ; 
or press the number on the keypad 
corresponding to the desired tool.

Mouse
1. Click “Tools” at the bottom of the 

screen to open the Tools menu.
2. Click the desired tool.
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The Tools menu
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Slope Tool Select the Slope Tool from the Tools menu to measure the slope of 
a tangent line at one point on the data plot. A pair of crosshairs marks the point at 
which the slope is measured. Labels on the Graph’s edges show the coordinates 
of the point, and the slope is displayed at the bottom of the screen.

Use the left and right arrow keys to move the Slope Tool to adjacent points. Use 
the up and down arrow keys to send it to the first and last points. Press and hold 
the left or right arrow key to move the Slope Tool quickly.

If you have a mouse, you can move the Slope Tool by dragging the circle 
at the intersection of the cross hairs left and right.

Statistics Select Statistics from the Tools menu to put the Graph into Statistics 
mode. The Graph displays the minimum, maximum, average, and standard devi-
ation (σ) of the data inside the region of interest (ROI), which is indicated by a 
dashed box.

Statistics mode

Two cursors designate the left and right sides of the ROI. The larger cursor is the 
active one and can be moved with the arrow keys or mouse.4 As the active cursor 
moves, one side of the box moves with it.

The smaller cursor indicates the side of the ROI that does not move.

To switch the active cursor to the other side of the box, hold  and press .

Linear Fit When Linear Fit is selected from the Tools menu, a best-fit line is 
applied to the data in the ROI. (See “Statistics” above for instructions on setting 
the ROI.)

The slope, the Y-intercept, the mean squared error (MSE), and the root mean 
squared error  of the linear fit are displayed at the bottom of the screen 
along with the correlation coefficient (r) of the data in the ROI.
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4See page 16 for detailed instructions on 
moving the cursor with the keypad or 
mouse.
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When the Linear Fit is turned on, the special option Create Calculation from Lin-
ear Fit appears in the Tools menu (see page 22).

Linear Fit can be useful even when the graphed data are not linear (qua-
dratic or exponential, for instance). See “Graph Linearization” on page 47.

Area Tool Select the Area Tool from the Tools menu to measure the area 
between the data plot and the X-axis in the ROI. (See “Statistics” above for 
instructions on setting the ROI.)

For data plotted below the X-axis, the area is measured as negative. The value of 
area displayed at the bottom of the screen is the total area above the X-axis minus 
the total area below the X-axis.

Area Tool

Derivative This tool overlays a graphical representation of the derivative (or 
rate of change) of the data. In some cases, the Graph may need to be rescaled in 
order to see the overlaid derivative. The Derivative Tool is designed for titration 
experiments in which it is necessary to identify a point in a data set at which the 
maximum rate of change occurs.

Trigger The Trigger is a tool that allows you to control how the GLX collects 
data. With the Trigger, you make the GLX delay data recording (after you press 

) until a certain condition is met by the incoming data. The Trigger has two 
parameters: Trigger Edge, which can be rising or falling, and Trigger Level, 
which specifies the data value that must be crossed. For example, on a voltage 
versus time graph, if you set the Trigger Edge to rising and the Trigger Level to 5 
volts, data recording will not start until the measured voltage rises above 5 volts.

The Trigger can be used in normal graph mode to start continuous recording, or it 
can be used in Scope Mode (see page 22) to repeatedly trigger bursts of data col-
lection. In both modes, the Graph must have time on the horizontal axis.

To turn on the Trigger, select it from the Tools menu.5 A horizontal dashed line 
appears on the Graph indicating the Trigger Level. Press the up and down arrow 
keys to change the Trigger Level. Press the right arrow key to cycle through ris-
ing edge, falling edge, and disabled. (The Trigger is initially disabled, so you 
must press the right arrow key at least once to enable it.)
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5The Trigger turns on automatically 
when you turn on Scope mode. See 
page 22.
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The Trigger affects data recording even if you are not viewing the Graph. If you 
have set up two or more triggers on separate Graph pages,6 data recording will 
start when the most recently set trigger condition is met.

Trigger Settings When the Trigger is turned on, you can open the Trigger Set-
tings dialog box by pressing the left arrow key (you can also select it from the 
Tools menu). In the dialog box, use the arrow keys to highlight Trigger Enabled 
and press  to enable or disable the Trigger. To change the edge from rising to 
falling, or vice-versa, use the arrow keys to highlight Trigger Edge and press 

. To set the level, use the arrow keys to highlight Trigger Level, press , 
enter the desired value on the keypad, and press  again. 

You can also turn on the Stop Condition, which causes data collection to auto-
matically stop at a specified time. To turn on the Stop Condition in the Trigger 
Settings dialog box, use the arrow keys to highlight Stop Condition and press 

. When the Stop Condition is on, an icon ( ) and vertical dashed line 
appear on the Graph indicating the stop time. While viewing the Graph, hold 
down  and press the left and right arrow keys to adjust the stop time. For the 
Stop Condition to work, the Trigger must be turned on (but does need to be 
enabled). 

When you have finished changing the settings in the Trigger Settings dialog box, 
press  to accept the changes, or press  to cancel them.

Zoom Use the Zoom Tool to enlarge an area that you define by drawing a rect-
angle. Select Zoom from the Tools menu; a zoom cursor ( ) appears. Move the 
cursor (using the arrow keys) to where you want one corner of the rectangle. 
Press . Move the cursor to define the diagonally opposite corner of the rect-
angle. Press  again. The area enclosed by the rectangle enlarges to fill the 
screen.

 If you have a mouse, you do not have to open the Tools menu to zoom. 
Just hold down  while you click and drag on the Graph to draw the rectangle.7 

Zoom Tool

Swap Cursors This option appears in the Tools menu when you are using the 
Delta Tool, Statistics, Linear Fit, or Area Tool. When you select Swap Cursors, 
the active and inactive cursors swap places, allowing you to move the previously 
stationary corner of the Delta Tool or side of the ROI. 

To swap cursors without opening the menu: hold , press , and release 
both keys.

Toggle Active Data This option appears in the Tools menu when the Graph is 
in one of the two-data set modes (see pages 23–24). Select it to switch focus from 
one data set to the other. The active data set is the one to which the Data Cursor 

6For information about multiple Graph 
pages, see “New Graph Page” on 
page 24.
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scale the Graph with a mouse.
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and other tools are applied. In cases where the two data sets are scaled separately, 
the active that is scaled.

To toggle data without opening the menu: hold , press , and release both 
keys.

Create Calculation from Linear Fit This option appears in the Tools menu 
when the Linear Fit (see page 19) is turned on. Select this option to automatically 
create an equation in the calculator based on the slope and y-intercept of the cur-
rently display best-fit line. If the equation of the best fit line is , 
where m is the slope and b is the y-intercept, then the calculation will take the 
form . This calculation will appear in the Calculator and in 
data source menus with the name “Linear Fit Cal.” For instructions on working 
with calculations, see page 41.

F4 Graphs Menu

The Graphs menu contains options8 to control the appearance of the Graph, make 
it emulate an oscilloscope, make it plot two data sets simultaneously, manage 
multiple pages, and print.

Data Cursor Select this option to turn on or off the Data Cursor and Coordi-
nates displayed on the Graph. See page 16 for more information.

Connected Lines Select this option from the Graphs menu to turn on or off the 
lines connecting the data points.

Graph with connected lines (left) and without connected lines (right)

Scope Mode Select Scope mode from the Graphs menu to make the GLX emu-
late a digital storage oscilloscope. In this mode, the GLX collects and displays 
data in repeated bursts. The length of the burst and the sample rate are deter-
mined by the time scale of the Graph display. Scope mode can be used with any 
sensor to collect bursts of data; it is especially useful with the GLX’s built-in 
sound sensor (see page 58) or voltage sensor.

When you turn on Scope mode, the Graph automatically sets its time range to 
30 milliseconds and turns on the Trigger.9 It also adjusts the sampling rate of the 
displayed sensor so that it will collect about 500 data points (or as many as possi-
ble) in each burst. If you change the Graph’s time scale,10 the GLX automatically 
adjusts the sampling rate.

+
Toggle Data Shortcut
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8To select an option from the Graphs 
menu

Keypad
1. Press  to open the Graphs 

menu.
2. Use the arrow keys to move the high-

light to the desired menu option and 
press ; or press the number on the 
keypad corresponding to the desired 
menu option.

Mouse
1. Click “Graphs” at the bottom of the 

screen to open the Graphs menu.
2. Click the desired menu option.

��

The Graphs menu

Scope mode

9The Trigger is initially disabled. See 
page 20 for instructions on enabling and 
setting the Trigger.

10See “F1 Autoscale” and “F2 Scale/
Move” on page 16.



 X p l o r e r  G L X  U s e r s ’  G u i d e 23
After you press , the GLX begins collecting and displaying a series of data 
bursts (each burst is enough data fill the Graph from left to right). If you have 
enabled the Trigger, the GLX waits for the trigger condition to be met before col-
lecting each burst.

While Scope-mode data collection is in progress, you can change the scale of the 
Graph (with  Autoscale,  Scale/Move, or the mouse) and you can 
change the Trigger settings with the arrow keys.

To stop data collection, press  again. The GLX will save the last-collected 
data burst as Run #1 (or #2, #3, #4, etc.). You can also use the Trigger’s Stop 
Condition (see page 21) to make the GLX stop automatically after collecting a 
single data burst.

You can use Scope Mode in conjunction with Two Measurements mode or 
Two Graphs mode (see below) to display two traces simultaneously.

Two Measurements Select this option from the Graphs menu to put the Graph 
into Two Measurements mode. In this mode, two measurements (or data sets) are 
graphed simultaneously.

Two Measurements mode

The data source and scale of the First Measurement are displayed on the left side, 
and the data source and scale of the Second Measurement is displayed on the 
right side. Select either the left or right data source field11 to change the corre-
sponding measurement.

The run number of the First Measurement is displayed in the upper left corner of 
the Graph, and the run number of the Second Measurement is displayed in the 
upper right corner. To change the run number of either measurement, select the 
corresponding run number field.11

One of the measurements is plotted in black, and the other one in gray. The mea-
surement in black is the active data. To switch activity to the other measurement, 
hold  and press .

The Data Cursor appears on the active data. If you select a tool from the Tools 
menu, it is applied to the active data set. If you press  to scale or move ver-
tically, only the active data will change.12 However, moving the Graph horizon-
tally or changing the horizontal scale will affect both sets.

If you are using a mouse, you can switch activity to a measurement by 
clicking on the line above its run number. Vertically scale each measurement by 
dragging its numeric labels (on the left or right side of the Graph).
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11To select a data source field or run 
number field:

Keypad
1. Press  to light up the active fields.
2. Use the arrow keys to move the high-

light to the desired field.
3. Press  again to open the menu.
4. Use the arrow keys to move the high-

light to the desired menu option and 
press ; or press the number on the 
keypad corresponding to the desired 
menu option.

Mouse
1. Click the desired field to open the 

menu.
2. Click the desired menu option.

���

��

12The exception to this rule is when both 
data sets are of the same units (both 
temperature in °C, for instance); in that 
case, both data sets scale together.
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Typically you would use Two Measurements mode to display data from two 
different sources, but you can also use it to display two runs from the same 
source. Select the same source from both data source fields, and different 
runs from each run number field. For another way to display two runs from 
the same source, see “Two Runs” below.

Two Runs Select Two Runs from the Graphs menu to display two data sets 
from a single data source.

In this mode, a second run appears on the Graph. A second run number field 
appears in the upper right corner (below the first run number), which you can 
select to choose a different run.

One of the runs is plotted in black, and the other one in gray. The run in black is 
the active data. To switch activity to the other run, hold  and press . The 
Data Cursor appears on the active data. If you select a tool from the Tools menu, 
it is applied to the active data set. 

Both runs share a single pair of axes and they are scaled and moved together.

If you are using a mouse, you can switch activity to a run by clicking on 
the line above its run number.

Two Graphs Select Two Graphs from the Graphs menu to display two separate 
graphs simultaneously. This mode is similar to Two Measurements mode (see 
page 23), but each measurement is plotted on the top or bottom half of the screen, 
rather than overlapping.

One of the measurements is plotted in black, and the other one in gray. The mea-
surement in black is the active data. To switch activity to the other measurement, 
hold  and press .

The Data Cursor appears on the active data. If you select a tool from the Tools 
menu, it is applied to the active data. If you press  to scale or move verti-
cally, only the active data will change. However, moving the Graph horizontally 
or changing the horizontal scale will affect both sets.

If you are using a mouse, you can switch activity to a measurement by 
clicking on it.

New Graph Page The GLX supports an unlimited number of graph pages. 
Select New Graph Page from the Graphs menu to configure a new graph while 
preserving the previous one.

When two or more graph pages exist, each page appears in the Graphs menu. To 
make a page visible, select it from the menu.

If added graph pages make the Graphs menu too long to fit on the screen, an 
arrow or arrows ( , ) will appear on the right side of the menu to indi-
cate that some of the menu options are not visible.

Press the up or down arrow key multiple times to move the highlight beyond 
the visible portion of the menu. The menu will scroll to bring other options into 
view.

If you are using a mouse, you can click the arrows to scroll the menu.

Two Runs mode

���

Two Graphs mode

���

��

The Graphs menu as it appears when 
multiple pages exist
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Print If there is a printer connected to the GLX, select Print from the Graphs 
menu to print the currently displayed graph page.

Print All Select Print All to print all of the graph pages.

For more information, see “Printing” on page 91.

Delete Graph Page This option is available when two or more graph pages 
exist. When you select Delete Graph Page from the Graphs menu, the currently 
displayed page is deleted and the next page appears. (If there is no next page, the 
previous page appears.)

Data Annotation

The GLX’s data-annotation capability allows you to attach notes to data points in 
the Graph display. You can add these notes while you are viewing the Graph 
either during or after data collection.13 A note (represented by a flag icon: ) can 
include a text message, an audio recording of your voice, or both; it can also be 
“empty” (not containing text or audio).

Data with notes

There are two ways to attach a note to a data point in the Graph display: 

• Press  quickly to mark a data point with an icon ( ) representing an 
empty note. You can later add text and audio to this note.

• Press and hold  and begin speaking to mark a point and immediately 
record an audio message. When you are finished speaking, release .14

In both cases, the note is added at the location of the Data Cursor.15

See page 16 for instructions on moving the Data Cursor. If you are adding 
notes during data collection, it is often convenient to have the cursor tracking 
the data so that notes are always attached to the most recently collected 
point; press the down arrow key to make the cursor track the data.

After you have added a note, you can access its audio and text by positioning the 
Data Cursor on it.

13In order to add a note during data col-
lection, the GLX must be in Continuous 
Sampling mode (its default mode), rather 
than Manual Sampling mode. See 
page 57 for more information.

14The GLX cannot record audio for a 
data note when the microphone is con-
figured as a sound sensor or sound level 
sensor. See page 58 for more informa-
tion.

15The Data cursor must be turned on 
(see page 22) in order to use data anno-
tation.
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A note with the Data Cursor positioned on it

To make the Data Cursor jump directly to a note, hold  and press one of the 
arrow keys. Press  plus the left or right arrow key to make the cursor jump to 
the next visible note in either direction; press  plus the up or down arrow key 
to make the cursor jump to the first or last visible note. When the cursor lands on 
a note, the audio portion (if any) starts playing16 and the text portion of the note 
(if any) appears. 

Annotation Menu

To change any of a note’s attributes, position the Data Cursor on the note and 
press ; the Annotation menu will open.

If you have a mouse, you can open the menu by clicking the flag icon.

Annotation Menu

Select17 any of the following menu options.

Edit Note Select this option to open the Note Editor dialog box. There you can 
read the text, listen to the audio, enter new text, change existing text, and record 
new audio. See “Note Editor Dialog Box” below for instructions.

Always Show Text This option is either turned on (with a check mark appear-
ing next to it in the menu) or off (no check mark). When the option is on, the 
note’s text is visible on the Graph even when the cursor is not on the note. To 
switch Always Show Text on or off, select it from the Annotation Menu.

Delete Note Select this option to delete the entire note, including the text and 
audio portions and the flag icon.

Move Select this option to move the note to a different data point. After you 
have selected Move, the flag icon becomes mobile; use the arrow keys (or 
mouse) to move the icon to a different data point and press  to attach it to that 
point.

Hide All Text and Show All Text Select either of these options to hide or 
show the text of all notes in the displayed data run. These options are equivalent 
to turning on or off the Always Show Text option for every note. 

Delete All Notes Select this option to delete every note in the displayed data 
run.

���

���

���

16If you have not changed the default 
setting, the audio plays through the 
GLX’s built-in speaker; otherwise it plays 
through the output device specified in 
the Audio Settings dialog box, which is 
accessed from the Settings screen. See 
page 87 for more information.

17To select and option from the 
Annotation menu

Keypad
1. Position the Data Cursor on the data 

note.
2. Press  to open the menu.
3. Use the arrow keys to move the high-

light to the desired menu option and 
press ; or press the number on 
the keypad corresponding to the 
desired menu option.

Mouse
1. Click the flag icon ( ) to open the 

menu.
2. Click the desired menu option.
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Note Editor Dialog Box

Note Editor Dialog Box

The Note Editor opens when you select Edit Note from the Annotation menu. 

The text portion of the note appears in the upper half of the box. Use the GLX’s 
keypad (or an attached USB keyboard) to enter new text or edit existing text.18 
Press  to open the Text menu, which contains options related to entering and 
editing text. 

Text Menu

To type a capital letter, select Shift or Caps Lock.19 To take the keypad out of 
multipress text mode (to type only numerals), select Num Lock. To delete the 
entire text portion of the note, select Delete Text.

The audio portion of the note is graphically represented in the lower half of the 
Note Editor along with the audio recording duration and size. Press  to open 
the Audio Note menu, which contains options for recording and playing audio.14 

Audio Note Menu

To record new audio, select Record Audio Note and begin speaking; press  
to stop recording.14 When you record new audio, the note’s previous audio is 
overwritten. To play the audio portion of the note, select Play Audio Note from 
the Audio Note menu.16 To delete the audio, select Delete Audio Note.

Two other menu options, Record Quality and Record Level, allow you to set the 
GLX’s audio sample rate, bits per sample, and microphone volume before you 
record audio. The properties set using these options are identical to those in the 
Audio Settings dialog box (which is accessed from the Settings screen); see 
page 87 for details.

When you have finished changing the text and audio portions of the note, press 
 to accept changes and close the Note Editor, or press  to cancel 

changes.
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18See “Multipress Text Input Mode” on 
page 90.��

��

19To select an option from the Text or 
Audio Note menu

Keypad
1. Press  or  to open the 

menu.
2. Use the arrow keys to move the high-

light to the desired menu option and 
press ; or press the number on 
the keypad corresponding to the 
desired menu option.

Mouse
1. Click “Audio Note” or “Text” at the bot-

tom of the screen.
2. Click the desired menu option.

�� ��

��

��

��

�� ��



28 T a b l e
Table
Use the Table to display data, edit or enter data manually, and display statistics 
on data sets. The Table can show up to four columns of numeric or text data.

To Open the Table

From the Home Screen, do one of the following:

press , the function key below the Table icon;

use the arrow keys to highlight the Table icon, then press ; or

click the Table icon.

From anywhere in the GLX environment, you can always get to the Table with 
the shortcut + .

The Table Display

Choosing Data to Display

The Table can contain up to four columns.20 Each column can be set to display 
data from one data source. If time is displayed, it occupies its own column. A col-
umn can also be empty (not set up for any data source).

The active fields described below are used to control what data appear in each 
column. (See page 14 for more information about active fields.)

Data Source Select the data source field21 at the top of a column to choose a 
sensor measurement, calculation, manually entered data set, or time, or to clear 
the column. If no data source is assigned to a column, the data source field 
appears as a series of dashes (----).

Data Source menu

��

The Table icon on 
the Home Screen

��

����,�����
+
�
�������

+
�
�������������
���������������������

20See “F4 Tables” on page 31 for 
instructions on changing the number of 
displayed columns.

21To select the data source, units, or 
run number field

Keypad
1. Press  to light up the active fields. 
2. Use the arrow keys to move the high-

light to the desired field. 
3. Press  again to open the menu. 
4. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click the desired field to open the 

menu.
2. Click the desired menu option.
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If the chosen data source does not contain data, the data source name will appear 
at the top of the column, but the cells of the column will remain empty until data 
collection starts.

Also from the data source menu, you can select Properties to edit the name and 
other properties of the currently displayed data set. See “Data Properties” on 
page 69 for more information.

For more information on selecting data from a data source menu when you 
are working with more than one sensor, or with a multiple-measurement sen-
sor, see “Data Source Menus” on page 89.

Units Select the units field21 to choose different units (if available) for the cho-
sen data source.

Run Number Select the run number field21 to choose a different run, or select 
No Data to display nothing.

By default, the Table is set to change the displayed run number in all col-
umns whenever you change it in one column. Refer to “Lock Run Selection” 
on page 31 to change that setting.

The last two options in the run number menu are Delete Run and Rename Run. 
See “Run Number” on page 15 for more information.

Table Scrolling

At any time, up to eight cells of data are visible in each column. Press the up or 
down arrow key to scroll the Table and make other rows of data visible. Press and 
hold the up or down arrow key to make the Table scroll continuously. Press the 
left arrow key to jump to the beginning of the table; press the right arrow key to 
jump to the end.

The rules for scrolling are different when an editable column is visible. See 
page 35

Table Function Keys

In the Table, the function keys are used to control the display of statistics, to edit 
data, and to set the number of columns.

F1 Statistics

From the Statistics menu, you can choose to display any of the following statis-
tics for the displayed data sets:

• Minimum (Min), the lowest value in the data set,

• Maximum (Max), the highest value in the data set,

• Average (Avg), the average of all values in the data set,

• Standard Deviation (σ), a measure of how much the data varies from the 
average, and

• Count (#), the number of values in the data set.

Units menu Run number menu
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The chosen statistics will be displayed at the bottom of every column. To choose 
a statistic, select it from the menu.22 To turn off a displayed statistic, select it 
again.

Select Show All or Hide All to turn on or off all of the statistics.

F2 Edit Cell

When you are navigating in an editable column, press  to edit the selected 
cell. See “Manually Entered Data” on page 32 for instructions on editing data.

F3 Edit

The options in the Edit menu are used when editing or entering data. See “Manu-
ally Entered Data” on page 32 for more information.

New Data Column Select New Data Column from the Edit menu to create an 
editable data set. See “Manually Entered Data” on page 32 for more information.

Insert Cell Insert Cell works only when the dashed Navigating Box is visible23 
(see page 34). When you select Insert Cell, a new cell is added directly above the 
Navigating Box. If the column contains numeric data, the new cell will contain 
the number 0. If the column contains text data, the new cell will be blank. Every 
cell below the new cell shifts down by one position.

Delete Cell Delete Cell works only when the dashed Navigating Box is 
visible23 (see page 34). When you select Delete Cell, the cell that the Navigating 
Box is on is deleted. Every cell below the deleted cell shifts up by one position.

Num Lock Num Lock is only available in the Edit menu when an editable col-
umn is displayed. When Num Lock is turned on (which it is by default), a check 
mark ( ) appears next to it in the menu, and the keypad operates in numbers-
only mode.

When Num Lock is turned off, the keypad can be used in multipress text input 
mode (see page 90) to enter numbers and letters. To turn Num Lock on or off, 
select it from the Edit menu.

Caps Lock Caps Lock is only available in the Edit menu when an editable col-
umn is displayed. When Caps Lock is turned on, a check mark ( ) appears next 
to it in the menu. When used in multipress text input mode, the keypad inputs 
capital letters.

22To select a statistic from the Statis-
tics menu:

Keypad
1. Press  to open the Statistics 

menu.
2. Use the arrow keys to move the high-

light to the desired statistic and press 
; or press the number on the key-

pad corresponding to the desired sta-
tistic.

Mouse
1. Click “Statistics” at the bottom of the 

screen to open the Statistics menu.
2. Click the desired statistic.

��

Table with statistics displayed

��

Edit menu

23To make the Navigating Box appear in 
an editable column, press .���
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F4 Tables

From the Tables menu, you can select to display one, two, three, or four col-
umns.24 If you increase the number of columns, new columns are added to the 
right side (the GLX automatically selects data sources, if available, for new col-
umns). If you decrease the number of columns, they will be removed from the 
right side (the data displayed in those columns disappears, but is not be perma-
nently deleted).

Tables with one, two, three, and four columns

Other options in the Tables menu are described below.

Show Time Select Show Time to add a column of time data in the left-most 
position.25 If there are four columns displayed when you select Show Time, the 
fourth column will be removed and the other three columns will shift to the right 
to make room for the time column on the left. 

Date/Time To turn on this option, select it from the Tables menu. With the 
option turned on, times displayed in the Table appear as the date and time of day 
at which each data point was recorded. With the Date/Time option turned off, 
time data appears as measured from the start of data collection.

The Date/Time format is set in the Settings screen. See page 85.

Lock Run Selection When Lock Run Selection is on (which it is by default), 
all data columns will display the same run number, and changing the run number 

��

Tables Menu

24To select an option from the Tables 
menu

Keypad
1. Press  to open the Tables menu.
2. Use the arrow keys to move the high-

light to the desired menu option and 
press ; or press the number on the 
keypad corresponding to the desired 
menu option.

Mouse
1. Click “Tables” at the bottom of the 

screen to open the Tables menu.
2. Click the desired menu option.

��

25To show time in a column other than 
the first one, select it from the data 
source menu at the top of the desired 
column. See “Data Source” on page 28 
for more information.

Table with Date/Time option
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of one column will cause all of them to change.26 To turn Lock Run Selection off 
or on, select it from the Tables menu.

Export All Data If you have a USB storage device27 (such as a USB flash 
drive), you can use this option to export data in tab-delimited text format. The 
GLX creates a text file on the storage device that you can open on a computer in 
a spreadsheet, mapping software, DataStudio, and other programs.

See page 83 for other ways to save and open data on a USB storage device.

Connect the storage device to the GLX’s USB port and select Export All Data 
from the Tables menu. A dialog box appears showing which data sets will be 
exported. Highlight any of these data sets and press  to exclude it. To select 
other data sources for exporting press  to add a single data source or press 

 to add all data sources that have been set to “visible” in the Sensors screen. 
Press  (OK) to create the export file on the USB storage device.28

Before exporting data for use with mapping software, display time in the first 
column and turn on the Date/Time option (see page 31).

To view the exported data, disconnect the storage device from the GLX and con-
nect it to a computer. You will find the text file at the root level of the storage 
device. Its filename encodes the date and time at which the data was exported; for 
instance, if you exported data on October 28, 2005 at 11:22:53 AM, the filename 
will be “Export10282005112253.txt”. You can open this file in a text editor, 
spreadsheet, or other program designed to import tab-delimited data.29

Print If there is a printer connected to the GLX, select Print to print one page of 
data. The GLX will print the data that are visible on the screen, plus as much 
additional data as will fit on one page.30

Print All Select Print All to print the entire contents of the displayed data sets, 
including data that are not currently visible on the screen (data that you would 
have to scroll up or down to see). If necessary, the GLX will print multiple pages.

Manually Entered Data

In addition to collecting data from sensors, the GLX allows you to enter data in 
the Table display via the keypad or an attached keyboard. Any data that you have 
entered can later be edited.

Entering a New Data Set

Creating a New Data Column Before you can enter data, an editable data 
column must exist. To create one, press  to open the Edit menu and select 
New Data Column.

The keypad shortcut for creating a new data column is , , pressed in 
sequence.

The new editable column takes the place of the first blank column in the Table. If 
there is no blank column, and there are three or fewer other columns, the new 
editable column is added on the right side of the table. If the Table is already dis-
playing four columns, the new editable column replaces the fourth column.

26See “Run Number” on page 29 for 
instructions on changing the run number 
displayed in a column.

27The USB storage device must be for-
matted using the FAT16 or FAT32 file 
system. Most flash drives are formatted 
this way. Other mass-storage devices 
such as portable hard drives and audio 
players may also be compatible. You can 
use a USB card reader, however the 
card must be in the reader before you 
connect the reader to the GLX.

��

��

�� 28If you export data while data collection 
is in progress, the text file will contain the 
data collected up to that point, and the 
GLX will continue to collect data.

29To import the file into DataStudio, open 
the File menu and select Import Data.

30For more information on printing, see 
“Printing” on page 91.

���
��

������
���
�
�
�������

��

��

�� �����



 X p l o r e r  G L X  U s e r s ’  G u i d e 33
Entering Numeric Data In a New Column In the new editable column, you 
will see a box around the first cell and a blinking cursor inside the cell.

1. Type a number on the keypad (or attached keyboard), then press .

When editing data in the Table,  has the same effect as .

2. The box and cursor will step to the next cell in the column. Enter another 
value and repeat. 

3. When you are finished, press . (You must press  to lock in the last 
value before you press .)

If you would like to change or add to the data after you have pressed , 
refer to “Editing an Existing Data Set” on page 34.

Entering Text Data in a New Column In addition to numeric data, the Table 
allows you to create a column of text. 

1. Create a new data column as described on page 32.

2. Press  to open the Edit menu. If Num Lock is turned on, select it to turn 
it off and enable multipress text input mode. (If you are using an attached 
keyboard, this step is unnecessary.) 

For more information, see “Num Lock” on page 30 and “Multipress Text Input 
Mode” on page 90.

3. Type a non-numeric string of text and press .

The non-numeric text string can contain numerals, but it must have at least 
one letter or punctuation mark, so the GLX knows that it is supposed to be 
text. This limitation applies to only one cell in the column. After non-numeric 
text has been entered in one cell, the GLX will treat everything in that column 
as text, even if it looks like a number.

4. A dialog box will appear, reading: “Treat this column as text data?” Press 
 to select OK.

The column is now configured to contain text data. If you enter a numeric 
value it will be treated as text only. You can recognize a text-only data set by 
its left-justification (contents appear on the left side of the column) as 
opposed to numeric data, which is always right-justified.

5. Continue entering text in subsequent cells. Press  after you type in each 
cell to lock in that text string and step to the next cell. You can press  on 
a blank cell to leave it empty.

6. When you are finished entering data, press . (You must press  to lock 
in the last value before you press .)

If you would like to change or add to the text data after you have pressed 
, refer to “Editing an Existing Data Set” on page 34.
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Naming Manually Entered Data and Adding Units

By default, new editable data sets are named “Data 1,” “Data 2,” etc., and they do 
not have defined units. To change the name and add units, open the data source 
menu and select Data Properties.31

For more information, see “Data Source” on page 28, and “Data Properties” 
on page 69. 

Editing an Existing Data Set

The above section, “Entering a New Data Set” starting on page 32, describes 
how to create and enter data in a new column. This section describes how to 
change and add to a manually entered data set that has previously been cre-
ated.

Whenever you have one or more editable columns displayed in the Table, one of 
the editable cells is surrounded by a box. The box is either an Editing Box (solid 
lines) or a Navigating Box (dashed lines).

Editing Box The Editing Box32 is drawn with solid lines, and always contains a 
blinking cursor. It may be on a cell that already contains data, or it may be on an 
empty cell.

To move the Editing Box to a different cell, refer to “Navigating Box” below.

If the Editing Box is on an empty cell, anything that you type on the keypad (or 
attached keyboard) will appear in that cell.

When the Editing Box is on a cell that already contains data, what you type will 
either replace or amend the contents of the cell, depending on whether the con-
tents are highlighted.

• If the cell contents are highlighted, they will be replaced by any number or 
text that you type. If you press , the entire contents of the cell will be 
deleted.

• If the cell contents are not highlighted, they will be amended at the location 
of the blinking cursor. If you press , the character to the left of the cursor 
will be deleted.

By default, when the Editing Box appears on a cell, the contents (if any) are high-
lighted. To remove the highlight, press the left or right arrow key, then use the 
left or right arrow key to move the blinking cursor to the position where you 
would like to make an edit.

After you have changed the cell contents, you must press  to lock in the 
change. If you want to cancel the change, or leave the cell without entering data, 
press  instead of .

If the contents of a cell are not highlighted, you can restore the highlight by 
pressing .

Navigating Box The Navigating Box33 is drawn with dashed lines. Use the up 
and down arrow keys to move it within an editable column. Use the left and right 
arrow keys to move it to other editable columns.

31To open the data source menu and 
select Data Properties

Keypad
1. If the blinking cursor is visible, 

press .
2. Press  to light up the active fields.
3. Use the arrow keys to move the high-

light to the data source field.
4. Press  to open the menu.
5. Use the arrow keys to highlight Data 

Properties and press ; or press 
the number on the keypad corre-
sponding to Data Properties.

Mouse
1. Click the data source field to open the 

menu.
2. Click Data Properties.

���

32If you do not see the Editing Box, 
press .��
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33If an editable column exists, but you do 
not see the Navigating Box, press .���
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Position the Navigating Box on a cell where you would like to enter or edit data, 
then press  to make the Editing Box appear. To restore the Navigating Box, 
press .

If you would like to add data to the bottom of a data set, position the Navigating 
Box on the first empty cell below the existing data and press .

Table Scrolling with Manually Entered Data

At any time, up to eight cells of data are visible in a manually entered data col-
umn. As with regular Table scrolling (see page 29), use the up or down arrow key 
to scroll the Table up or down and make other rows of data visible. 

To scroll the Table when manually entered data column is displayed, the dashed 
Navigating Box must be visible.34 To scroll up, press the up arrow key repeatedly 
(or press and hold it) to move the Navigating Box to the first visible cell, then 
continue to press (or hold) the key. To scroll down, press the down arrow key 
repeatedly (or press and hold it) to move the Navigating Box to the last visible 
cell, then continue to press (or hold) the key.

All columns scroll together. The Table will not scroll past the bottom of the col-
umn containing the Navigating Box. In the table picture below, the Navigating 
Box is at the end of the shorter data column. To scroll the Table down, press the 
left arrow key to place the Navigating Box on the longer manually entered col-
umn.
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34If the Navigating Box is not visible, 
press .���
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Graphing Manually Entered Data

Numeric Data After you have created an editable numeric data set in the Table, 
you can display it in the Graph. In the Graph, select the editable data from the 
horizontal or vertical data source menu (see page 15).

Text Data A text data set can be displayed on the horizontal axis of the Graph. 
First select a numeric data as the vertical data source, then select the text data as 
the horizontal data source (see page 15). The text from each cell of the Table 
appears on the Graph as a label next to the corresponding data point.

Graph displaying manually entered 
text data on the horizontal axis
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Digits Display
Use the Digits display to show data from up to eight data sources. This display 
monitors and shows live data even when the GLX is not recording.

To Open the Digits Display

From the Home Screen, do one of the following:

use the arrow keys to highlight the Digits icon, then press ; or

click the Digits icon.

Choosing Data to Display

Data Source Select the data source field35 at the top of each section to select a 
data source. A data source would usually be a sensor measurement or a calcula-
tion based on a sensor measurement. 

Sensor measurements or calculations based on sensor measurements can 
vary while data collection is in progress. If you select a static data source 
(such as manually entered data), the Digits display will show only the last 
data point.

For more information on selecting data from a data source menu, see “Data 
Source Menus” on page 89.

Also select the data source field to access the Data Properties of the displayed 
data. See “Data Properties” on page 69 for more information.

Units Select the units field35 at the top of each display to select different units 
for the selected data source (if available).

Digits Function Keys

Press , , , or  to divide the display into two, four, six, or 
eight segments. The GLX automatically selects data sources, if available, for new 
segments.

+
�
�������  ����

Digits display

The Digits icon on 
the Home Screen

35To select a data source field

Keypad
1. Press  to light up the active fields. 
2. Use the arrow keys to move the high-

light to the data source or units field. 
3. Press  again to open the menu. 
4. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click the data source or units field to 

open the menu.
2. Click the desired menu option.

�� �� �� ��
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Meter
The Meter display simulates an analog meter with a needle that deflects in pro-
portion to a sensor measurement or sensor-based calculation. This display moni-
tors and shows live data even when the GLX is not recording.

Meter display

To Open the Meter Display

From the Home Screen, do one of the following:

use the arrow keys to highlight the Meter icon, then press ; or

click the Meter icon.

Choosing Data to Display

Data Source Select the data source field36 at the top of the Meter display to 
select a data source. A data source would usually be a sensor measurement or a 
calculation based on a sensor measurement. 

Sensor measurements or calculations based on sensor measurements can 
vary while data collection is in progress. If you select a static data source 
(such as manually entered data), the Meter display will show only the last 
data point.

For more information on selecting data from the a data source menu, see 
“Data Source Menus” on page 89.

Units Select the units field36 at the top of the display to select different units for 
the selected data source (if available).

Auto Scale and Reset

Press  to automatically scale the Meter. If the GLX is recording data, the 
lower and upper limits of the meter will be reset to equal the lowest and highest 
values measured thus far in the current or most recent data run. Press  to 
restore the default scale.

Print

Press  to print the Meter. See page 91 for more information.

+
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The Meter icon on 
the Home Screen

36To select a data source or units field

Keypad
1. Press  to light up the active fields. 
2. Use the arrow keys to move the high-

light to the desired field. 
3. Press  again to open the menu. 
4. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click the desired field to open the 

menu.
2. Click the desired menu option.
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Chapter 2: Ut i l i ty  Screens
This chapter describes the Output screen, Calculator, Notes screen, and Stopwatch.

Output
The Output screen is the control panel for generating sound through the GLX’s 
built-in speaker or through headphones or amplified stereo speakers connected to 
the signal output port. 

To Open the Output Screen

From the Home Screen do one of the following:

use the arrow keys to highlight the Output icon, then press ; or

click the Output icon.

Navigating in the Output Screen

The Output screen is divided into three parts: Output Settings, Left Output Chan-
nel, and Right Output Channel. There are three controls within each part, for a 
total of nine controls. One of the controls is always highlighted. Use the arrow 
keys to move the highlight. Press  to select the highlighted control. If a menu 
opens, use the up and down arrow keys to highlight the desired setting and press 

. If a cursor appears, type the desired value and press . The Volume, Fre-
quency, and Phase controls can also be set using  and .

If you are using a mouse, click the control that you would like to set; then 
click the desired menu option, or type the desired value.

Output Function Keys

F1 and F3 On/Off

Press  to turn the left channel on or off, press  to turn the right channel 
on or off.

F2 and F4

When the Frequency control for the left or right channel is highlighted, press 
 or  to set the step size for that channel. From the menu that opens, 

select one of the step sizes or select Custom Step to enter any value. The step size 
determines the amount by which the frequency changes when you press , 

, , or  (see “Frequency” below).

The Output icon on the 
Home Screen
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Output function keys
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Output Settings1

Output Device

Highlight the Output control and press  to select the output device that you 
are using.

Headphones Select this option to play sound through headphones connected to 
the signal output port on the left side of the GLX.

Internal Speaker If there is nothing connected to the signal output port, select 
Internal Speaker to play sound through the GLX’s built-in speaker.

External Speaker Select this option to play sound through a pair of amplified 
stereo speakers connected to the signal output port.

Power Amplifier Selecting this option puts the Output screen into a special 
mode for the optional GLX Power Amplifier.

Volume

The Volume setting determines the overall loudness of the output sound. High-
light the Volume control and press  or  to change it incrementally; or 
press  to select the desired volume from a menu.

Speaker Config

When Output Device is set to Headphones or External Speaker, the two options 
for Speaker Config are Stereo and Mono. When Output device is set to Internal 
Speaker, Mono is the only option. In Mono configuration, the signals from both 
channels are combined within the GLX; both external speakers or both sides of 
the headphones play the same combined signal. In Stereo configuration, the Left 
Output Channel plays through the left speaker or the left side of the headphones, 
and the Right Output Channel plays through the right speaker or the right side of 
the headphones.2

Left and Right Output Channels

Wave

Highlight the left or right Wave control and press  to set the wave form of 
each output channel. The options are Sine, Square, Ramp, and Triangle.

Frequency

Highlight the left or right Frequency control and press  or  to change the 
frequency up or down by the value specified above  or ; press  or 

 to multiply or divide the frequency by that value. To enter the frequency 
directly, press . The frequency can be set between 240 and 5000 Hz for the 
internal speaker, or between 60 and 5000 Hz for external speakers and head-
phones.

Phase

Highlight the left or right Phase control and use  or  to adjust the phase up 
or down, or press  and enter the desired phase. The phase of each channel 
can be set between -360° and 360°.

1The output settings in the Output 
screen can also be changed in the 
Audio Settings dialog box, accessed 
from the Settings screen (see page 87). 
When you change the settings in one 
location, they are automatically updated 
in the other location.
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2If you are using stereo headphones to 
demonstrate beats or destructive inter-
ference, set Speaker Config to Mono so 
that each ear can hear both tones.
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Calculator
You can use the GLX Calculator like a regular calculator for finding the result of 
a simple expression, like a graphing calculator for plotting equations, and for per-
forming operations, in real time, on streams of data collected from sensors and on 
sets of manually entered data.

To Open the Calculator

From the Home Screen, do one of the following:

press , the function key below the Calculator icon;

use the arrow keys to highlight the Calculator icon, then press ; or

click the Calculator icon.

From anywhere in the GLX environment, you can always get to the Calculator 
with the shortcut + .

Types of Calculations

The Calculator supports four types of calculations: basic, algebraic, graphing, 
and sensor-based. The following examples will demonstrate the four types.

Basic Calculations

Basic calculations involve only numerals (no constants or variables). Open the 
Calculator and try this:

• On the first blank line, type: 

1 + 1 

The Calculator responds by adding an equal sign and the result. It also dis-
plays the result at the bottom of the screen. Notice that the cursor has moved 
to the next line.

• On the next line type:

9 * (8 + 3) 

To type the multiplication symbol (the asterisk), press . 

For the parentheses, press  once to open the first Functions menu3; use 
the arrows to highlight the pair of parentheses, then press .

Note that  has the same effect as .

��

The Calculator icon on 
the Home Screen
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First Functions menu

3For more information on the Functions 
menus, see page 48.
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• Press the up arrow key to put the cursor back on the above expression and 
modify it to read:

9 * (9 + 3)

When you type something into the middle of an existing expression, the new 
characters are inserted without overwriting anything; press  to delete the 
characters that you don’t want.

Note that the correct result does not appear until you have moved the cursor 
to a different line by pressing  or , or the up or down arrow key.

Algebraic Calculations

Algebraic calculations involve symbols (letters or words) standing for constants. 
When you enter an algebraic expression, the GLX fills in the result if it knows 
the value of every symbol used in the expression. If it does not know the value of 
a symbol, it will prompt you to enter it.

If you are entering an equation to be graphed, leave one symbol undefined. 
See “Graphing Equations” on page 44 for more information.

Try these examples:

• Type:

a + 3 

For the a symbol, press  twice to open the second Functions menu. Use 
the arrow keys to highlight a, then press .

For more information on the Functions menus, see page 48.

The Calculator does not know the value of a, so it prompts you with:

a = 

Type: 

5 

The Calculator fills in the result of the original expression.

• Try entering a new value for a on the next line:4 

a = 6 

Note that the original expression still reads 

a + 3 = 8

This expression has just been 
modified, but the user has not yet 

pressed  or  so it appears to 
show an incorrect result.

�
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Second Functions menu

The Calculator fills in the result of a+3 
when the value of a is entered.

4For the a symbol, press  twice 
and select it from the second Functions 
menu.
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When there is more than one definition for the same symbol, the calculator 
uses the first definition. To avoid confusion, do not define a symbol more 
than once. If you want to change the value of a symbol, use the arrow keys to 
go back to the original definition and change it.

• When you are prompted for the value of a symbol, you can enter another 
expression rather than a simple number. Type:5

b + 3 

When prompted for the value of b, enter:

1 + 1 

The Calculator displays the value of b at the bottom of the screen and fills in 
the result of b + 3 on the line above.

• Rather than a simple expression, you can enter a complete equation for the 
Calculator to evaluate. Enter:6

z = y * 2 

When prompted for the value of y, enter:

4 

The Calculator indicates the value of y at the bottom of the screen. To see the 
value of z at the bottom of the screen, use the up arrow key to put the cursor 
on the definition of z.

Reposition the cursor to see the value of z

+�����
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5For the b symbol, press  twice 
and select it from the second Functions 
menu.
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6For the z or y symbol, press  
twice and select it from the second 
Functions menu.
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• A symbol does not have to be a single letter. The Calculator will recognize 
any text string (without spaces) as a symbol, including text strings that con-
tain numerals. (To type text on the keypad, see “Num Lock” on page 50.)

Graphing Equations

If you enter an equation that contains one undefined variable to the right of the 
equal sign, the GLX can graph it.

• Type:7

y = m * x + b 

• When prompted, assign numeric values for m and b, but not for x.

• Press the up arrow key to place the cursor on y = m * x + b and press . 
The equation is plotted in a preview graph in the lower half of the screen. 

The preview graph will always show the equation that the cursor is on. 
(Move the cursor down to m and see what happens.)

Press  again to turn off the preview graph.

• The preview graph is a simplified version of the Graph screen, without all of 
the scaling and analysis features.8 For the normal full-screen Graph, press 

+ , then select the calculation ( ) from the data source menu of 
the vertical axis.

Examples of text strings used as 
symbols in algebraic calculations

7For the y, m, x, or b symbol, press 
 twice and select it from the sec-

ond Functions menu.
��

7�������������

Enter values for m and b, but not x

��

������

��
The preview graph shows the equation 

that the cursor is on

��

8If you are using a mouse, you can scale 
the preview graph by direct manipulation 
(see page 17).��
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See “Data Source” on page 15 for more information about selecting data in 
the Graph.

• You don’t have to use x as the undefined variable; whichever symbol you 
leave undefined on the right side of the equation will be plotted on the hori-
zontal axis. However, the label on the horizontal axis will always read “x,” 
even if the variable used in the calculation is not x.

Do not leave more than one symbol on the right side of the equation unde-
fined. If you do, the graph will use both of them as model ranges with confus-
ing results.

• The text on the left side of the equation does not have to be y. The text to the 
left of the equal sign is the name of that calculation, and will appear as the 
vertical axis label on the Graph. It can consist of any combination of letters, 
numerals, and spaces.

If you are defining more than one equation to be graphed, use different text 
on the left side of each equation so that you can distinguish between them in 
the data source menu of the Graph.

Sensor-based Calculations

You can create a calculation to automatically transform any data collected by a 
sensor.

• Connect a temperature probe to one of the ports on the left side of the GLX. 
Press  to collect data for a few seconds. Press  again to stop.
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• Open the calculator. On the first blank line, enter:9

d = [Temperature (°C)] - 20

Instead of typing “[Temperature (°C)]”, select it from the [Data] menu.10

Open the [Data] menu; select Temperature and °C

• Press the up arrow key to place the cursor on the calculation. Press  to 
view the calculation on the preview graph. Note how the calculated data dif-
fers from the original temperature data.

• Press +  to open the full-screen Graph. Press  twice to open the 
vertical data source menu and choose the calculation (see right).

See “Data Source” on page 15 for more information about selecting data in 
the Graph.

• Press  to begin collecting data again. Note that the calculation is per-
formed in real time on the new data.

• Calculations have no units by default. To assign units to a calculation, select 
Data Properties from the data source menu in the Graph (see “Data Proper-
ties” on page 69).

• In addition to sensor-collected data, calculations can operate on other data 
sources, such as manually entered data sets, other calculations, and time. To 
insert any data source into a calculation, press  and select it from the 
[Data] menu.

Uses of Sensor-based Calculations

Shift Data Vertically In the example above, the sensor-based calculation sub-
tracts 20 °C from the measured temperature. This calculation might be used in an 
experiment where the difference between the measured temperature and room 
temperature is of interest (a study of Newton’s law of cooling, for instance). The 
calculation in the example shifts the temperature graph down by 20 °C.

Time-shift Data When a data plot appears on the Graph with Time on the hori-
zontal axis, the plot can be shifted right or left with a time-based calculation.

For example, the graph shown at the right is from an experiment in which a tem-
perature probe was dipped into warm water, then removed, wiped dry, and 
allowed to cool. The relevant data start after the probe was dried, about 14 sec-
onds from the start of data collection. To make the analysis simpler, the graph 
needs to be shifted left so that the relevant data start at time zero. To do so, create 
the calculation below. (To insert [Time (s)], press  and select it from the 
[Data] menu.)

[Time (s)] - 14

9For the d symbol, press  twice and 
select it from the second Functions 
menu.

��

10To select Temperature from the 
[Data] menu

Keypad
1. Press  to open the [Data] menu.
2. Use the up or down arrow key to high-

light Temperature and press ; or 
press the number on the keypad cor-
responding to Temperature. 

3. The units menu will open. Use the up 
or down arrow key to highlight °C and 
press ; or press the number on the 
keypad corresponding to °C.

Mouse
1. Click [Data] to open the menu.
2. Click Temperature.
3. The units menu will open. Click °C.
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In the Graph, choose the calculation 
from the data source menu

��

This data plot needs to be time-
shifted

��
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Plot the calculation on the horizontal axis in place of Time to create the graph 
shown below. (See page 28 for instructions on selecting data for the horizontal 
axis.)

Convert Units of Measure Most of the sensors used with the GLX are pro-
grammed with SI units (or the International System of Units) and, in some cases, 
other common units. If you wish to make a measurement using units that are not 
programmed into the sensor, create a calculation to convert the measured data.11

For example, if you are using a Motion Sensor, which measures position in 
meters, and you want to convert the measurement to centimeters, create the cal-
culation below. (To enter text, see “Num Lock” on page 50.)

position in cm = [Position(m)]*100

Calculate an Experimental Value In some experiments, it is possible to cal-
culate an experimental value based on a sensor measurement. For example, in an 
experiment where a Motion Sensor measures the acceleration of an object, you 
can use the Calculator to calculate the net force:

force = mass * [Acceleration (m/s/s)]

The Calculator will prompt you for the value of mass.

Compare Measurements from Two Sensors When collecting data with 
two sensors, a calculation can be used to compare the separate measurements. 
For example, if you are using two temperature probes, named “Temperature” and 
“Temperature2,” and you want to know the temperature difference between 
them, create the calculation:

[Temperature (°C)] - [Temperature2 (°C)]

Graph Linearization In some cases, such as the examples below, you may 
want to linearize data so that you can use the Linear Fit tool in the Graph display 
(see “Linear Fit” on page 19). To do so, use the Calculator to calculate the square, 
square root, natural log, etc., of the measured data. (See “F1 Functions” on 
page 48 for more information on these and other functions.)

• The graph to the right shows period (T) versus length (L) data from a simple 
pendulum. The graph can be linearized by plotting T2 versus L. The slope of 
the graph (shown below on the left) is 4π2/g, where g is the free-fall acceler-
ation. Alternatively, the graph can be linearized by plotting T versus . On 
the graph (shown below right), the slope is .

This data plot has been time-shifted 
by -14 s

11For certain measurements (tempera-
ture, for instance), it is not necessary to 
calculate a units conversion because the 
sensor is programmed with other com-
mon units of measure (°C, °F, and K), 
which can be selected from the units 
field of any display. See pages 15 
and 29.

Period vs. Length for a 
simple pendulum

L
2π g⁄

T vs. √⎯L for a simple pendulumT2 vs. L for a simple pendulum
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• The position versus time graph of an object in free fall (below right) exhibits 
a typical quadratic relationship. The object was dropped from a height of 
0.79 m, with the release occurring 2.2 s after the start of data collection. The 
graph can be linearized (as shown below right) by replacing Time on the hor-
izontal axis with the calculation ([Time (s)]-2.2)^2. The slope of the best-fit 
line is , where a is the acceleration of the object.

• Voltage versus time graph for a discharging capacitor is shown below on the 
left. The graph the natural log of voltage versus time is a linear (below right). 
The slope of the line is , where C is the capacitance and R is the 
resistance through which the capacitor discharges.

Calculator Function Keys

F1 Functions

Press  (or click Functions) repeatedly to access the three Functions menus. 
These menus contain the following items.

• Functions: sin, cos, tan, arcsin, arccos, arctan, ^2, log, ln, sqrt, 10^, e^

• Operators: ^ (the exponent operator)

• Constants: π

• Commonly used symbols: x, y, z, m, a, b, c, d, α, ω λ, θ

• Sample expressions: y = 2x +3, y = x^2, y = sin(x), y = e^x sin(x)

• Parentheses: a pair of parentheses and a single right parenthesis 

• Special Functions: limit, mod, abs, random

• Output-control Functions: outstate, outswitch, outfreq, outvolume

• Logic Operators and Functions: <, >, inrange, and, or, not

a 2⁄

Linearized free-fall dataPosition vs. Time of an object in
free fall

1 RC⁄–

Linearized data for a discharging 
capacitor

Voltage versus Time data for a 
capacitor

The first and second Functions 
menus

��
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Special functions, output-control functions, and logic operators and functions 
are typically used to control the GLX’s digital and audio output. See “Output-
control Calculations” on page 50 for detailed explanations of these functions 
and operators.

Inserting a Function When you select an item from one of the Functions 
menus, it is inserted at the cursor location.12 If the item includes a pair of paren-
theses, the cursor will be positioned between them.

Degrees/Radians A calculation containing a trigonometric function can be set 
to operate in degrees or radians. This setting is applied to each calculation sepa-
rately. The lower right corner of the Calculator indicates whether the calculation 
that the cursor is on is set for degrees or radians. 

To switch the setting, press  to open the Edit menu and select (or deselect) 
Radians. After you have switched the setting for a calculation, you must press 

 or  to make the GLX reevaluate the calculation.

Predefined Constants The symbol π is a predefined constant. The Calculator 
will recognize its value as 3.141592 when it is used as part of an expression or on 
the right side of an equation.

The symbol e is a predefined constant equal to 2.718282. The capital letter E can 
be used interchangeably with e. Typically e is used with the exponent operator (^) 
to form e^, the exponential function.13

F2 [Data]

Press  (or click [Data]) to select a data source to insert into an equation. See 
“Sensor-based Calculations” on page 45 for more information.

The [Data] menu contains sensor measurements, manually entered data, calcula-
tions, and time.

F3 Graph

Press  or (click Graph) to plot the equation that the cursor is on in the pre-
view graph on the lower half of the screen. See “Graphing Equations” on page 44 
for more information.

12To select an item from the Func-
tions menus

Keypad
1. Press  once to open the first 

menu, or twice to open the second 
menu.

2. Use the arrow keys to highlight the 
desired item and press .

Mouse
1. Click Functions once to open the first 

menu, or twice to open the second 
menu.

2. Click the desired item.
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13When using the constant e, be careful 
not to enter it in a way that the GLX will 
mistake for scientific notation. See 
page 91 for more information.
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F4 Edit Menu

Press  (or click Edit) to open the Edit menu, which contains the options 
described below.

Num Lock When Num Lock is on (which it is by default), an icon ( ) appears 
in the lower right corner of the screen.

To turn Num Lock on or off, select Num Lock from the Edit menu.14

With Num Lock on, you can type only numerals (not letters or punctuation 
marks) with the keypad. Multiple presses of a key will not cycle through multiple 
characters. (That way you can type “100,” for instance, without having to wait 
between zeros.) The single exception is the letter E, which you can always type 
by pressing decimal point key ( ) twice.

With Num Lock off, the keypad operates in multipress text input mode (see 
page 90), allowing you to enter letters and punctuation marks.

It is often unnecessary to turn off Num Lock because commonly used letters and 
other symbols can be selected from the Functions menus, and the names of data 
sources can be selected from the [Data] menu.

Radians Select or deselect this option to switch the highlighted calculation to 
radians or degrees. See “Degrees/Radians” on page 49.

Clear Expression This option removes the expression that the cursor is on and 
leaves a blank line.

Delete Expression This option removes the expression that the cursor is on 
and shifts up everything below it to fill in the blank line.

Insert Expression This option shifts the expression that the cursor is on (and 
everything below it) down by one line to create a blank line at the cursor location.

Data Properties Select this option to open the Data Properties dialog box for 
the highlighted calculation. See page 69 for more information.

Print If there is a printer connected to the GLX, select Print to print the Calcula-
tor screen.15

Output-control Calculations

The functions and operators described below can be selected from the third Func-
tions menu.16 With them, you can write expressions in the Calculator that control 
the GLX’s audio outputs, and the outputs of connected Digital Adapters.

Edit menu
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14To select an option from the Edit 
menu

Keypad
1. Press  to open the Edit menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click Edit to open the menu.
2. Click the desired menu option.

��
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15For more information on printing, see 
“Printing” on page 91.

16See “F1 Functions” on page 48.
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Special Functions

These special functions do not directly control output, but can be useful in com-
bination with the output-control functions.

limit(min, max, x) The limit function is used keep a varying value within a 
specified range. The function has three arguments: min, max, and x. 

• If x < min, then limit(min, max, x) = min. 

• If x > max, then limit(min, max, x) = max. 

• If min ≤ x ≤max, then limit(min, max, x) = x.

mod(numerator, denominator) The mod function is equal to the remainder 
when numerator is divided by denominator. The arguments numerator and 
denominator can be any number (not just whole numbers). If denominator = 0, 
then mod(numerator, denominator) = 0.

abs(x) The abs function is equal to the absolute value of its argument.

random() The random function equals a randomly generated number between 0 
and 1. Each time the function is evaluated, a new random value is generated. 
Note that the random function appears with a pair of parentheses after it, but it 
cannot have anything between the parentheses.

Output-control Functions

The output-control functions set the output of the GLX’s audio channels and con-
nected Digital Adapters. The output-control functions work only when data col-
lection is in process. Each function must be used as part of a sensor-based 
calculation (the calculation must include data from a sensor or time). Any prop-
erty of the audio output that is not specified in the Calculator will be determined 
by the setting in the Output screen (see page 39). In the Functions menu, the 
names of these functions are abbreviated to outstate, outswitch, outfreq, and out-
volume.

outputstate(GLXPort, AdapterChannel, state) Use the outputstate func-
tion to switch on or off a Digital Relay connected through a Digital Adapter.17

The first argument of the function, GLXPort, can equal 1, 2, 3, or 4; it identifies 
the port that the Digital Adapter is connected to. The second argument, 
AdapterChannel, can equal 1 or 2 and identifies which channel of the adapter the 
Digital Relay is connected to. The third argument, state, can equal any number 
and determines whether the relay is OFF or ON. 

• If state = 0, then the relay is OFF.

• If state ≠ 0, then the relay is ON.

outputswitch(Channel, state) Use the outputswitch function to turn on or off 
the left or right audio output channel.18 The first argument, Channel, can equal 1 
(for left) or 2 (for right) and identifies which audio channel is to be controlled. 
The second argument, state, can equal any number and determines whether the 
audio output is OFF or ON.

• If state = 0, then the audio output is OFF.

• If state ≠ 0, then the digital output is ON.

17The Digital Relay is PASCO part 
CI-6462. The Digital Adapter is PASCO 
part PS-2159.

See “Relay Control” on page 67 for 
instructions on connecting and configur-
ing the adapter.

18Whether the output is played through 
the output port (to a pair of headphones 
or amplified speakers) or through the 
GLX’s built-in speaker depends on the 
Output setting in the Output screen (see 
page 40).
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outputfreq(Channel, frequency) Use the outputfreq function to set the fre-
quency of the audio output signal.18 The first argument, Channel, can equal 1 (for 
left) or 2 (for right) and identifies which channel is to be controlled. The second 
argument, frequency, sets the frequency, in Hz, of the output signal. The fre-
quency can be set between 250 and 5000 Hz for the built-in speaker, or between 
60 and 5000 Hz for headphones or external speakers.

outputvolume(volume) Use this function to set the loudness of the output sig-
nals.18 The argument of the function can be set between 0 (for no output) and 10 
(for the loudest possible output). The function controls both audio channels 
together.

Logic Operators and Functions

A logic function has two possible values: 0 and 1. A logic operator (< or >) is 
used to build an expression that can have a value of 0 or 1.

Less Than and Greater Than If an expression such as a < b is true, then it 
equals 1. If the expression is false, then it equals 0.

inrange(min, max, x) This function has three arguments: the first two, min 
and max, define the upper and lower limit of a range, and the third, x, is an input 
value to be compared with that range. If min ≤ x ≤max, then the function equals 
1. If x < min, or x > max, then the function equals 0.

and(a, b) This function equals 0 if either of the arguments equals 0; otherwise 
the function equals 1.

or(a, b) This function equals 0 if both of the arguments equal 0; otherwise the 
function equals 1.

not(x) This function equals 1 if the argument equals 0; otherwise the function 
equals 1.

Audio Temperature Indicator

In this example, the GLX is programed to emit a sound when the temperature 
exceeds 30 °C. The frequency of the sound increases as the temperature 
increases.

Connect a temperature sensor to the GLX. In the Calculator, enter these two 
expressions:

outputswitch(1,[Temperature (°C)]>30)

outputfreq(1,[Temperature (°C)]*10)

Select the outputswitch and outputfreq functions from the  Functions menu. 
Select the [Temperature (°C)] measurement from the  [Data] menu.

Press  to start data collection. Place the temperature sensor in warm water. 
Then allow it to cool again. When the temperature reaches 30 °C, the GLX emits 
a tone at 300 Hz. As the temperature rises, the frequency of the tone rises.

Audio Temperature Indicator Example

��
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Notes Screen
Use the Notes screen to record experiment instructions, information about the 
sensors and displays that you have set up, notes on recorded data, or any other 
text information.

To Open the Notes screen

From the Home Screen, do one of the following:

use the arrow keys to highlight the Notes icon, then press ; or

click the Notes icon.

Entering, Reading, and Printing Text Notes

Enter text via the GLX keypad or a connected USB keyboard.

See “Multipress Text Input Mode” on page 90 or “Using a USB Keyboard” on 
page 90.

To input a single capital letter, first press  to turn on Shift. To input all capi-
tal letters, turn on Caps Lock by pressing . To disable multipress text input 
mode (for typing just numbers), turn on Num Lock by pressing .

The GLX can store multiple notes pages. To start a new page, press  to open 
the Notes menu and select New Page.19

If more than one page exists, you can also press  to select a previously cre-
ated page for viewing and editing, or to delete the currently displayed page. The 
page number of the visible page and the total number of pages are indicated in 
the lower right corner of the screen.

To print the currently displayed page on a connected printer, press  and 
select Print. To print all notes pages, select Print All.

For more information, see “Printing” on page 91.

The Notes icon on the 
Home Screen
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19 To select an option from the Notes 
menu

Keypad
1. Press  to open the Notes menu. 
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click the page number in the lower 

right corner to open the Notes menu.
2. Click the desired menu option.
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The Notes menu
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Stopwatch
With the Stopwatch screen, you can use the GLX like a conventional stopwatch.

To Open the Stopwatch

From the Home Screen, do one of the following:

use the arrow keys to highlight the Stopwatch icon, then press ; or

click the Stopwatch icon.

Timing with the Stopwatch

The numbers displayed on the stopwatch indicate elapsed time in minutes and 
seconds.

Press  to start timing. Press  again to stop timing.

When timing is stopped, press  to set the displayed elapsed time back to 
00:00.00

The Stopwatch icon on 
the Home Screen
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Chapter 3: Set t ings and Fi les

Sensors Screen
In many cases, the sensor set-up process requires nothing more than simply plug-
ging in a sensor. However, if you would like to change any of the sensor settings, 
or configure a sensor that you have not physically plugged in, or change the 
mode of data collection, go to the Sensors screen. Also use the Sensors Screen to 
configure the GLX’s microphone as a sound sensor.

Sensors screen

To Open the Sensors Screen

From the Home Screen, do one of the following:

press , the function key below the Sensors icon;

use the arrow keys to highlight the Sensors icon and press ; or

click the Sensors icon.

From anywhere in the GLX environment, you can always open the Sensors 
Screen with the shortcut + .

Working with Multiple Sensors

An icon for each sensor connected to the GLX appears at the top of the screen.1 
A box around one of the icons indicates the selected sensor. Use the left and right 
arrow keys (or mouse) to select the sensor that you want to set up. The settings 
for the selected sensor appear in the lower part of the screen.

��

The Sensors icon on
the Home Screen

��

1In some cases, an icon for a sensor that 
is not physically connected to the GLX 
appears in the Sensor screen. Such 
icons are designated with .

)����
����������
���������������

Top portion of the Sensors screen;
this GLX is connected to an accelera-

tion sensor and a force sensor
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Sensor Settings

To change any of the settings, use the arrow keys to highlight the settings and 
press .

If you are using a mouse, click the desired setting.

Sample Rate Unit Select Sample Rate Unit2 to choose how the sampling rate 
will be measured. The choices are samples per second; or seconds, minutes, or 
hours (time between samples).

Sample Rate Select Sample Rate3 to set the sensor’s rate of data collection 
(measured in the units selected above).

Open the Sampling Rate menu or change the

sampling rate with  and 

Reduce/Smooth Averaging This feature is a type of oversampling. You can 
use it to:

• reduce what would be a large data set to a manageable size,

• smooth noisy data,

• improve the effective resolution of a sensor.

Select Reduce/Smooth Averaging and choose the number of points to be aver-
aged.4 The number of points represents the factor by which the effective sam-
pling rate, data set size and noise level are reduced.

2 To select Sample Rate Unit

Keypad
1. Use the arrow keys to highlight Sam-

ple Rate Unit
2. Press  to open the menu.
3. Use the arrow keys to highlight the 

desired units and press ; or press 
the number on the keypad corre-
sponding to the desired units.

Mouse
1. Click Sample Rate Unit to open the 

menu.
2. Click the desired units.
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3To select Sample rate

Keypad
1. Use the arrow keys to highlight Sam-

ple Rate.
2. Press  to open the menu.
3. Use the arrow keys to highlight the 

desired rate and press ; or press 
the number on the keypad corre-
sponding to the desired rate.

or

1. Use the arrow keys to highlight Sam-
ple Rate.

2. Press  or  to increase or 
decrease the value.

Mouse
1. Click box to the right of Sample Rate 

to open the menu.
2. Click the desired rate.

�

�

�

4To select Reduce/Smooth Averaging

Keypad
1. Use the arrow keys to highlight 

Reduce/Smooth Averaging.
2. Press  to open the menu.
3. Use the arrow keys to highlight the 

desired number of points and press 
; or press the number on the key-

pad corresponding to the desired 
number of points.

Mouse
1. Click the box to the right of Reduce/

Smooth Averaging to open the menu.
2. Click the desired number of points.

,��
#��
����

$(
�����
#��
����

<=(
�����
#��
����



 X p l o r e r  G L X  U s e r s ’  G u i d e 57
Zero Automatically On Start This setting appears for sensors that support 
zeroing (such as acceleration, rotary motion, and drop counter sensors). The three 
choices are “On,” “Off,” and “Zero Now.” When “On” is selected (which it is by 
default), the sensor measurement is adjusted with each new data run to make the 
first sample zero. When “Off” is selected, the measurement is not automatically 
zeroed. When you select “Zero Now,” the measurement is adjusted to make 
present value zero, but it will not be re-zeroed at the start of data collection.

Measurements Each of the sensor’s measurements have a “Visible” or “Not 
Visible” tag. Visible measurements appear in the data source menus of the dis-
play screens. Select a measurement to change its setting from “Visible” to “Not 
Visible,” or vice-versa.5 

A measurement set to “Not Visible” does not appear in the displays’ data 
source menus; however, it is still accessible by selecting “More” from the 
menu. See “Expanding the Data Source Menu” on page 89.

Sensors Function Keys

F1 Mode

The Mode menu contains options for how the GLX collects data. When you 
select a sampling mode6, that mode is applied to all sensors.

Continuous Sampling Continuous Sampling is the default and most com-
monly used mode. In this mode, when you press , the GLX starts to collect 
and record data from every sensor at a constant rate. Data collection stops when 
you press  again.

The rate of data collection is determined separately for each sensor. See 
“Sample Rate” on page 56 for more information.

Manual Sampling Select Manual Sampling from the Mode menu to record a 
series of single manually triggered samples. See page 60 for instructions on set-
ting up and using manual sampling.

F2 Data Properties

To open the Data Properties dialog box for a sensor measurement, first use the 
arrow keys to highlight the measurement, then press . See page 69 for a 
description of the Data Properties dialog box.

5To change the visibility of a mea-
surement

Keypad
1. Use the arrow keys to highlight the 

measurement.
2. Press .

Mouse
Click on the word “Visible.”

6To select a sampling mode

Keypad
1. Press  to open the Mode menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click Mode to open the menu.
2. Click the desired menu option.

��

��
Modes menu
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F3 Microphone

The Microphone menu contains options for setting how the GLX uses its built-in 
microphone. The selected option is indicated by a check mark ( ) appearing 
next to it in the menu.7

Sound Sensor When Sound Sensor is selected, the GLX’s microphone 
becomes a sensor that collects data showing the waveform of sound. The sound 
sensor appears in the upper part of the Sensors screen, just like any other sensor.

Like other sensors, the Sound Sensor settings include Sample Rate Unit, Sample 
Rate, and Reduce/Smooth Averaging; however you typically would not change 
any of these settings because the sample rate is automatically set by the Graph in 
Scope Mode.

The Sensitivity setting sets the gain of the Sound Sensor.8 For very loud sounds 
set the Sensitivity lower; for softer sounds, set it higher. To make the Sound Sen-
sor automatically adjust its sensitivity based on the loudness of the sounds that it 
detects, set the Sensitivity to Automatic.

The Sound Sensor is most commonly used with the Graph display in Scope 
mode. Press  and  together to go to the Graph display. Then press  
to open the Graphs menu, and press  to select Scope mode. Press . Whis-
tle or hum; you will see sound wave in the Graph. (See page 22 for more infor-
mation on Scope mode.)

Sound Level When Sound Level is selected, the GLX’s microphone measures 
the loudness of sound in decibels (on the dBA scale). 

The Sound Level sensor operates at a much lower sampling rate than the Sound 
Sensor. Like most other sensors, you would normally use the Sound Level sensor 
in continuous or manual sampling mode (see page 57), not in Scope mode.

Audio Notes With this default setting, the microphone is configured to record 
the audio portion of data notes (see “Data Annotation” on page 25). If you have 
previously recorded sound-sensor or sound level data, selecting Audio Notes is 
equivalent to unplugging the Sound or Sound Level sensor. The GLX will pre-
serve any sound data sets that have been recorded, but it will not collect new data 
from the microphone.

7To select an option from the 
Microphone menu

Keypad
1. Press  to open the menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired option.

Mouse
1. Click Microphone to open the menu.
2. Click the desired option.

��

)����
����

8To change the Sensitivity

Keypad
1. Use the arrow keys to highlight 

Sensitivity.
2. Press  to open the menu.
3. Use the arrow keys to highlight the 

desired setting and press ; or 
press the number on the keypad cor-
responding to the desired setting.

or

1. Use the arrow keys to highlight 
Sensitivity.

2. Press  or  to increase or 
decrease the value.

Mouse
1. Click box to the right of Sensitivity to 

open the menu.
2. Click the desired setting.

�
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F4 Sensors

The Sensors menu contains the following options for adding, removing, and cali-
brating sensors.9

Add Select this option to set up a sensor without physically connecting it. A 
menu containing all PASPORT sensors will open. Use the arrow keys to highlight 
the desired sensor and press .

Remove Use this option to delete the selected sensor without disconnecting it 
from the GLX. All data collected by that sensor will be deleted.

If there are multiple sensors, select the sensor that you want to delete before 
selecting the Remove option. See “Working with Multiple Sensors” on 
page 55.

It is not necessary to select Remove from the Sensors menu in order to discon-
nect a sensor; you can simply unplug it. 

When you physically unplug a sensor (after recording data), the icon for the sen-
sor remains in the upper part of the Sensors screen with  above it. All data 
recorded from that sensor, and the sensor’s settings (such as sampling rate) are 
preserved in the GLX. If that sensor is ever reconnected, it will be installed in its 
old place with the same settings. If you would like to remove the archived data 
and settings, select the icon of the unplugged sensor10, then select Remove from 
the Sensors menu. 

Calibrate Select Calibrate from the Sensors menu to open the Calibration dialog 
box. See page 71 for a description of the dialog box and instructions on calibrat-
ing a sensor.

Analog Adapter with a ScienceWorkshop Sensor Set-up

You can connect an analog ScienceWorkshop sensor to the GLX via an Analog 
Adapter (PS-2158). When you connect the Analog Adapter to the GLX, a special 
menu listing all ScienceWorkshop sensors appears. From this menu, select the 
sensor that you have connected (or will connect) to the adapter.11 After you have 
selected it, the sensor appears in the top portion of the Sensors screen, just like a 
PASPORT sensor.

In addition to the regular sensor settings (see page 56), a Sensitivity setting 
appears in the Sensor screen. This setting controls the gain of the Analog Adapter 
and can be set to Low (1X), Medium (10X), or High (100X). The gain is the fac-
tor by which the resolution of the sensor is improved, and by which the range is 
decreased.

ScienceWorkshop Sensors menu (left) and
Sensors screen with a ScienceWorkshop sensor (right)

9To select an option from the Sensors 
menu

Keypad
1. Press  to open the menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired option.

Mouse
1. Click Sensors to open the menu.
2. Click the desired option.

��

10To select a sensor icon

Keypad
Press the left or right arrow key to move 
the box to the icon in the upper portion of 
the Sensors screen.

Mouse
Click the icon in the upper portion of the 
Sensors screen.

11To select a sensor form the 
ScienceWorkshop Sensors menu

Keypad
1. Connect an Analog Adapter to the 

GLX to launch the menu.
2. Use the arrow keys to highlight the 

desired sensor. Arrows ( , ) 
appear on the menu to indicate that 
some sensors are not visible. Press 
the up or down arrow key multiple 
times to move the highlight beyond the 
visible portion of the menu. The menu 
will scroll to bring other sensors into 
view. To skip directly to the last sen-
sor on the menu, move the highlight to 
the first sensor, then press the up 
arrow key.

3. Press .

Mouse
1. Click the up or down arrow on the 

menu ( , ) to bring the desired 
sensor into view.

2. Click the desired sensor.
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Manual Sampling Mode

In Manual Sampling mode, the GLX records a single sample from each measure-
ment only when you trigger it by pressing . Follow these steps to set up Man-
ual Sampling mode and record data.

Set Up

1. Press  +  to go to the Sensors screen.

2. Press  to open the Mode menu.

3. Use the arrow keys to highlight Manual and press .

The Data Properties dialog box appears. This box specifies the name and 
units of the (optional) manually entered data. By default, the name is “Key-
board Data” and the units are unnamed.

4. If you plan to manually enter data to go with each sample, enter the name 
and units of this data in the Data Properties box. (See page 69 for instruc-
tions on using the Data Properties box.)

5. Do one of the following:

• Press  (OK) to enter Manual Sampling mode with the manually 
entered data option.

• Press  (No Data) to enter Manual Sampling mode without the 
option of manually entering data.

• Press  (Graph) to enter Manual Sampling mode with a Graph dis-
play automatically set up to display a sensor measurement on the verti-
cal axis and manually entered data on the horizontal axis.

Sampling

1. Press . The GLX starts measuring, but not recording. A blinking flag 
icon ( ) appears in the upper right-hand corner of the screen.

2. When you are ready to take a data point, press . The GLX instantly 
records a single sample from each measurement.

3. If you have selected the manually entered data option, the GLX prompts you 
to enter data. Type in the data (either numeric or text12) and press  
(OK). 

4. Repeat steps 2 and 3 to record additional samples.

5. When you have finished recording all samples, press .

Cell-selective Sampling

You can collect data in manual sampling mode while viewing any display; how-
ever, using the Table display allows additional flexibility. After setting up the 
GLX in manual sampling mode as described above, follow these steps to record 
data into specific table cells.

1. Press  +  to open the Table display.

��
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12To type text data, press  to dis-
able Num Lock. The first time the GLX 
detects non-numeric data, it will ask you 
to confirm that the data should be treated 
as text.
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2. Press . The GLX starts measuring, but not recording. A blinking flag 
icon ( ) appears in the upper right-hand corner. Another flag icon appears 
at the left side of the first table row.

3. Press the right arrow key. Notice that the flag icon moves to first cell of one 
column. If there is another column displaying collected data (not manually 
entered) press the right arrow again to move the icon to that column. This 
icon indicates which cell will collect data when you press . If the icon is 
at the left end of the row, all cells in that row will collect data.

4. Use the arrow keys to select which cell or cells in the first row you wish to 
collect data.

5. Press .

6. If you have selected the manually entered data option, the GLX prompts you 
to enter data. Type in the data and press  (OK).

7. To collect more data, use the arrow keys to position the flag icon on the sin-
gle cell or row where you want to collect data. If the selected cells already 
contain data, that data will be overwritten.

8. Press .

9. Repeat steps 7 and 8 to record additional samples.

10. When you have finished recording all samples, press .

Why Use Cell-selective Sampling?

Redo a Sample Cell-selective sampling is useful for redoing data points. For 
instance, suppose that you are measuring the pH of several different solutions. 
You place the pH probe in a solution and press  to record a sample. You then 
realize that you made a mistake—you forgot to wait for the measurement to sta-
bilize. To correct the mistake, press the up arrow to return the flag icon to the first 
row. Press  again to overwrite the data on that row with a new sample. 

You can redo any sample even if you have recorded subsequent samples; use the 
arrow keys to return the flag icon to any previously recorded row or cell and 
press . Remember to move the icon back to an empty row if you want to take 
a new sample without overwriting an old one.

Alternate Between Sensors If you have two or more sensors connected to 
the GLX, you may want to record single samples from each sensor separately. To 
do this you would select a single cell (instead of a whole row) for each sample. 
For example, you have several solutions and you would like to measure the pH 
and conductivity of each. Place the pH probe in the first solution. Press the right 
arrow key to select a single cell in the pH column. Press  to record only in 
that cell. Remove the pH probe from the solution and place the conductivity 
probe in the same solution. Use the arrow keys to select the cell in the conductiv-
ity column (in the same row). Press  to record into that cell. Repeat this pro-
cess for all other solutions. In this way you will record pH-conductivity data pairs 
without having to make pH and conductivity measurements simultaneously.

Only selected cell will collect data

All cells in selected row will collect 
data

Only selected cell will collect data

Previously recorded data in selected 
row will be overwritten

��
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Timing Screen
Use the Timing screen to set up measurements made with photogates, Smart Pul-
leys and other switch- or counting-type sensors.

To Open the Timing Screen

The Timing screen usually launches automatically when you connect a switch- or 
counting-type digital sensor to the GLX through a Photogate Port or a Digital 
Adapter.13

If a timer for a sensor has already been set up, the Timing screen will not auto-
matically launch when that sensor is plugged in. To manually open the Timing 
screen from the Home Screen, do one of the following:

use the arrow keys to highlight the Timing icon and press ; or

click the Timing icon.

Theory of Timing

Certain digital sensors connected to the GLX through a Digital Adapter or Photo-
gate Port operate differently from most other sensors. Rather than collecting data 
at a constant rate, they send a signal to the GLX only when an event happens. For 
instance:

• when a photogate switches from being blocked to unblocked, or vice-versa;

• when the spoke of a pulley enters or exits a photogate; or

• when a nuclear sensor detects a particle.

The GLX can be configured to measure the time span of a particular sequence of 
events. Examples of sequences include:

• blocked-unblocked, or “time-in-gate;”

• blocked-blocked, or “time-between-gates;” and

• blocked-blocked-blocked, used to measure the period of a pendulum.

The “blocked” event occurs when a photogate switches from being 
unblocked to blocked. The “unblocked” event occurs when a photogate 
switches from being blocked to unblocked.

Whenever the specified sequence occurs, the GLX records the time span of the 
sequence as a data point. It also records the time at which the sequence occurred, 

The Timing Screen

13Photogate Port is PASCO part 
PS-2123A. Digital Adapter is PASCO 
part PS-2159.

The Timing icon on
the Home Screen
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measured from the start of data collection to the midpoint of the sequence. From 
these measurements and user-entered (or default) constants, the GLX derives 
other measurements such as position, velocity, and acceleration. The configura-
tion of what sequences the GLX measures and what secondary measurements it 
derives is called a timer.14

The GLX is programmed with nine timers. The timer that you choose depends on 
the sensor (or combination of sensors) that you are using and the type of mea-
surement that you would like to make. The following example details the proce-
dure for selecting and setting up the “Photogate Timing” timer. The general 
procedure for other timers is similar, and the specifics of each timer are described 
on pages 64 through 67.

Setting Up the “Photogate Timing” Timer

In this example, we will connect and set up a single photogate to measure the 
velocity of an object of known width.

1. Connect a Photogate Port or Digital Adapter and a single photogate to the 
GLX. 

If the Timing Screen does not open automatically, go to the Home Screen, 
use the arrow keys to highlight the Timing icon, and press . Then press 

 to open the Add menu.

2. You will see the Add menu, which contains the timer options. For this exam-
ple, select Photogate Timing.15

Once you have chosen a timer, there are two types of things to set:

• measurements, which can be set as “visible” or “not visible,” and

• constants, which, in this case, are Flag Length and Photogate Spacing.

3. In this example there is only one photogate, so set Time Between Gates and 
Velocity Between Gates to “Not Visible.”16

14One exception, the “General Counting” 
timer, measures the number of events 
that occur within a specified period. See 
page 66 for details.

��

15To select a timer from the Add menu

Keypad
1. Press  to open the Add menu.
2. Use the up and down arrow keys to 

highlight the desired timer and press 
; or press the number on the key-

pad corresponding to the desired 
timer.

Mouse
1. Click Add to open the menu.
2. Click the desired timer.

��

�����
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16To change the visibility of a mea-
surement:

Keypad
1. Use the arrow keys to highlight the 

measurement.
2. Press .

Mouse
Click the word “Visible.”
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4. Set Time in Gate and Velocity in Gate to “Visible.”

5. Pretend that you have a cart with a 5 cm flag on it; set the Flag Length con-
stant to 0.05 m. (Highlight Flag Length and press , then type 0.05.)

6. In this case, photogate spacing is irrelevant, so leave the Photogate Spacing 
field blank.

Viewing and Collecting Data from a Timing Sensor

After you have set up a timer, its measurements are available from the data 
source menus of the Graph (see page 15), Table (page 28) and other displays.

To start collecting data, press .

Working with Multiple Timers

If there is more than one timer, an icon for each timer appears at the top of the 
screen. To set up each one, select it with the left and right arrow keys or with the 
mouse.

Note that in certain cases, a single timer operates with multiple sensors, so hav-
ing more than one sensor does not necessarily mean that you will have (or need) 
more than one timer.

Timing Screen Function Keys

F1 Add

The Add menu usually launches automatically when you connect a photogate or 
other timing sensor. If you wish to set up a timer for a sensor that you have not 
yet connected, or for a sensor that is already connected, open the Timing screen 
and press . From the Add menu, select one of the following timers.17 

If you are using a Digital Adapter, the Add menu may include Motion Sensor, 
Rotary Motion Sensor, and Relay Control. See page 67 for information on 
these special options.

Photogate and Picket Fence Select this timer for a single photogate used 
with a picket fence or photogate tape. The constant, Band Spacing, is the distance 
(in meters) between the centers of the dark bands on the picket fence or photo-
gate tape. 

The measurements are Position, Velocity, and Acceleration. Each time the photo-
gate is interrupted by a band of the picket fence, the timer registers a change in 

���������� ��������������

�� 17To select a timing option from the 
Add menu

Keypad
1. Press  to open the Add menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click Add to open the menu.
2. Click the desired option.

��

��
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Position equal to the Band Spacing. Velocity and Acceleration are calculated 
based on the time intervals between the changes in Position.

Picket fences include PASCO parts ME-9377A and ME-9804. Photogate 
tape is included with parts ME-6664 and ME-6666.

Smart Pulley (Linear) Use this timer for measuring linear motion with a 
Smart Pulley (or a combination of photogate and pulley). The constant, Spoke 
Arc Length, equals the circumference of the pulley (in meters) divided by the 
number of spokes.18

The measurements are Position, Velocity, and Acceleration. Each time the photo-
gate is interrupted by a spoke, the timer registers a change in Position equal to the 
Spoke Arc Length. Velocity and Acceleration are calculated based on the time 
intervals between the changes in Position.

Smart Pulley (Rotational) Use this timer for measuring rotational motion 
with a Smart Pulley (or a combination of photogate and pulley). The constant, 
Spoke Angle Spacing, equals 360° divided by the number of spokes.

The measurements are (angular) Position, (angular) Velocity and (angular) 
Acceleration. Each time the photogate is interrupted by a spoke, the timer regis-
ters a change in angular Position equal to the Spoke Angle Spacing. Angular 
Velocity and angular Acceleration are calculated based on the time intervals 
between the changes in angle.

Free Fall Adapter Use this timer with PASCO part ME-9207B. The constant, 
Height Of Fall, is the distance (in meters) from the release mechanism to the 
receptor pad.

The measurements are Time Of Fall and Acceleration.

• Time Of Fall is the time interval starting when the ball is released and ending 
when it hits the receptor pad.

• Acceleration is calculated using the formula:

Where a is Acceleration, x is Height Of Fall, and t is Time Of Fall.

Photogate and Pendulum The constant for this timer is Pendulum Width19, 
which is the width of the pendulum bob (or whatever part passes through the 
photogate). 

The measurements are Period and Velocity.

• Period is the time the pendulum takes to complete one cycle of oscillation. A 
period data point is recorded every other time the photogate is blocked.

• Velocity is the Pendulum Width divided by the time-in-gate. A velocity data 
point is recorded every time the pendulum passes through the photogate. For 
more accurate velocity measurements, use a cylindrical (rather than spheri-
cal) pendulum bob.

18The default value, 0.0150 m, is the 
spoke arc length of the inside groove of 
the PASCO Super Pulley (part ME-9450) 
and similar 10-spoke pulleys.

a 2x

t2
------=

19It is necessary to enter Pendulum 
Width only if you are interested in the 
velocity of the pendulum bob.
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Time of Flight Use this timer with a projectile launcher, two photogates, and a 
Time-of-Flight Accessory.20 The constant, Photogate Spacing, is the distance (in 
meters) between the centers of the photogates.

The measurements are Initial Velocity and Time Of Flight.

• Initial Velocity is the Photogate Spacing divided by the time-between-gates.

• Time Of Flight is the elapsed time starting when the projectile blocks the 
first photogate and ending when it hits the Time-of-Flight Accessory.

Photogate Timing Use this timer for general measurements made with one or 
two photogates.21 The constants are Flag Length and Photogate Spacing.

• Flag Length is the length (in meters) of the object that passes through the 
photogates.

• Photogate Spacing is the distance (in meters) between the centers of the pho-
togates. This constant is not relevant if you are using only one photogate.

There are four measurements: Time In Gate, Velocity In Gate, Time Between 
Gates, and Velocity Between Gates.

• Time In Gate is the time that the flag spends inside either gate each time it 
passes through. A data point is recorded every time either photogate detects 
a blocked-unblocked sequence.

• Velocity In Gate equals Flag Length divided by Time In Gate.

• Time Between Gates is the time elapsed between successive interruptions of 
either gate. A data point is recorded every time one of the photogates is 
blocked (except the first time).

• Velocity Between Gates equals Photogate Spacing divided by Time 
Between Gates.

General Counting Use this timer with nuclear sensors, drop counters, and 
other counting-type digital sensors. The constant, Count Time Interval, is the 
period over which the timer counts pulses for each data point. It is also the time 
between successive data points.

The measurement, Pulse Count, is the number of pulses (nuclear events or drops) 
detected during the Count Time Interval. Pulse Count data points are recorded at 
a constant rate, one data point at the conclusion of every Count Time Interval.

Collision Timer Use this timer to measure the velocities of two carts before 
and after they collide. The constant is Flag Length, which is the length (in 
meters) of the objects that pass through the photogates. The flags attached to both 
carts must be the same length.

The measurements, Velocity 1 and Velocity 2, are the velocities measured by 
each photogate. Velocity 1 is Flag Length divided by the time-in-gate of the first 
photogate. Velocity 2 is Flag Length divided by the time-in-gate of the second 
photogate.

Arrange the photogates so that the collision occurs between the photogates.

20The Time-of-Flight Accessory is 
PASCO part ME-6810. Projectile 
Launchers include ME-6800 and 
ME-6801. A Photogate Bracket, part 
ME-6821, is necessary to attach the 
photogates to the launcher.

21Photogate Timing works best for mea-
suring the velocity of a single object that 
blocks only one photogate at a time. To 
measure the separate velocities of two 
objects, use Collision Timer.
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If both carts are traveling in the same direction before the collision, one photo-
gate will measure the initial velocity of both carts. Similarly, if both carts are 
traveling in the same direction after the collision, one photogate will measure 
both final velocities.

If one of the carts is stationary before the collision, its initial position will be 
between the photogates, and its initial velocity will not be measured. If one of the 
carts is stationary after the collision, its final velocity will not be measured.

Digital Input Select the Digital Input timer22 to record the state changes of a 
photogate or other switch-type sensor.

This timer measures the sensor’s Logic State, which has only two possible val-
ues: 0 and 1. A Logic State value of 0 corresponds to a sensor output voltage of 
0 V, and a value of 1 corresponds to an output voltage of 5 V.

In the case of a photogate, if the most recently recorded Logic State value is 0, 
then the photogate is blocked; if the most recent value is 1, then the photogate is 
unblocked. A data point is recorded each time the sensor changes states; thus 
when the photogate switches from being unblocked to blocked, the timer records 
0, and when the photogate switches from blocked to unblocked, the timer 
records 1. 

Typically, the interesting data recorded by the Digital Input timer is not the 
0-or-1 Logic State value, but rather the time-stamps recorded with those values. 
To see the time data, view Time in one column of the Table display and Logic 
State in another column.23

F2 Remove

To remove a timer, press  or . If you have more than one timer set up, 
first use the left and right arrow keys (or mouse) to select the timer that you want 
to remove in the upper part of the screen, then press  or .

If there are data collected by that timer, they will be permanently deleted. (The 
GLX will ask you for confirmation before it deletes the timer.)

Digital Adapter Options

In addition to switch-type sensors, the Digital Adapter (PS-2159) allows the 
GLX to be used with a ScienceWorkshop Motion Sensor, a ScienceWorkshop 
Rotary Motion Sensor, or a Digital Relay. 

To set up the GLX for one of these devices, connect the Digital Adapter to the 
GLX and connect the sensor or relay to the adapter (in either order). The Add 
menu will open automatically with Motion Sensor, Rotary Motion Sensor, and 
Relay Control among the options. (These options do not appear if you press 

 to open the menu.)

ScienceWorkshop Motion Sensor or Rotary Motion Sensor To use one 
of these sensors24 with a Digital Adapter, connect the yellow and black plugs of 
the sensor to ports 1 and 2 (respectively) of the adapter and connect the adapter to 
the GLX. The Add menu will open automatically; select Motion Sensor or 
Rotary Motion Sensor. To set the sample rate and other sensor properties, go the 
Sensors screen (see page 55).

Relay Control To set up the GLX for control of a Digital Relay25 through a 
Digital Adapter, connect the relay to the adapter and connect the adapter to the 

22If the Add menu is too long to fit on the 
screen, arrows ( , ) appear on the 
menu to indicate that some of the menu 
options are not visible.

Press the up or down arrow key multiple 
times to move the highlight beyond the 
visible portion of the menu. The menu will 
scroll to bring other options into view.

If you are using a mouse, you can 
click the arrows to scroll the menu.

23See page 28 for instructions on choos-
ing data to display in the Table.
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24The ScienceWorkshop Motion Sensor 
is PASCO part CI-6742. The 
ScienceWorkshop Rotary Motion Sen-
sor is PASCO part CI-6538.

25The Digital Relay is PASCO part 
CI-6462.
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GLX. The Add menu will open automatically; select Relay Control.22 Both ports 
of the adapter will be configured for Relay Control (though they are controlled 
separately), so you can connect a second relay to the adapter with no additional 
set-up required. You can connect up to four Digital Adapters, each with two 
ports, for up to eight separately controlled output channels. See page 51 for infor-
mation about controlling digital output through the Calculator.

To use a Digital Relay and a digital sensor simultaneously, connect them to sepa-
rate adapters. 
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Data Propert ies

Every data set and data source in the GLX has data properties, which control how 
the data are displayed in the Graph, Table, and other screens.

To Open the Data Properties Dialog Box

To access and edit the properties of a data source, set up the Graph or Table to 
display the data source, then open the data source menu and select Properties.26 
The Data Properties dialog box will open.

You can also access the data properties of a sensor measurement from the Sen-
sors screen. In the Sensors screen, press . (See page 55 for more informa-
tion.)

When you are finished viewing or editing the data properties, press  (OK) to 
close the dialog box and return to the previous screen, or press  to cancel 
any changes.

Navigating in the Data Properties Dialog Box

Measurement Name The Measurement Name is the label that designates a 
data source on a graph axis or at the top of a table column. You may want to edit 
the Measurement Name to add more information about that measurement 
(change “Temperature” to “Water Temperature,” for instance) or to shorten it 
(change “Force” to “F,” for instance).

To edit the Measurement Name, use the up and down arrows keys to highlight it 
and press  (or click it if you are using a mouse). Type the new name on the 
keypad and press  (or press  to cancel).

See “Multipress Text Input Mode” on page 90 for instructions on using the 
keypad to enter text.

Measurement Unit The Measurement Unit is the name of units that are dis-
played on a graph axis or at the top of a table column.

You many want to edit the Measurement Unit to add units to a calculation or 
manually entered data set, or to abbreviate or spell out the units of a sensor mea-
surement. For instance, you might change “m” to “meters.”

To edit the Measurement Unit, use the up and down arrows keys to highlight it 
and press  (or click it if you are using a mouse). Type the new unit name on 
the keypad and press  (or press  to cancel).

��
��

Data Properties dialog box

26 For instructions on displaying data in 
the Graph and selecting items from the 
data source menu, see pages 13 and 15. 
For instructions on displaying data in the 
Table and selecting items from the data 
source menu, see pages 28 and 28.��
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See “Multipress Text Input Mode” on page 90 for instructions on using the 
keypad to enter text.

Note that changing the name of the units will have no effect on the actual data. 
For instance, if you change the name of the Temperature units from “°C” to “°F,” 
the numeric values of displayed temperature will not change. To change the 
actual unit of measure, select the units field in the Graph (see page 15), Table 
(page 29), or other display; or create a calculation (see page 47).

Numeric Style and Number of Digits Select Numeric Style27 and Number 
of Digits28 to set how numbers are displayed in the Table and Digits displays.

The meaning of Number of Digits depends on the selected Numeric Style, as 
described below.

• Fixed Decimals: in this style, the Number of Digits determines how many 
digits are displayed to the right of the decimal point.

• Significant Figures: the Number of Digits determines the number of signif-
icant figures that are displayed.

• Scientific Notation: all numbers are displayed with a single digit to the left 
of the decimal point, and the other digits to the right, followed by symbol E 
and an exponent. (The E means “times 10 raised to the power of….”) The 
Number of Digits is the total number of digits displayed on both sides of the 
decimal point (not including the exponent).

• Engineering Notation: This style is similar to scientific notation, but there 
are three digits to the left of the decimal place and Number of Digits deter-
mines the number of digits to the right of the decimal place.

• NSEW 000°00.000: Use this style for longitude or latitude data collected 
with a GPS sensor. The data will be displayed in degrees and minutes.

EE for Exponent <= This data property determines the smallest number that 
will be displayed without using exponential notation. A value of -3, for instance, 
means that anything less than or equal to 10-2 will be displayed in exponential 
notation.

EE for Exponent >= This data property determines the largest number that 
will be displayed without using exponential notation. A value of 6, for instance, 
means that anything greater than or equal to 106 will be displayed in exponential 
notation.

Zero |Value| < This data property is the smallest absolute value that will be dis-
played. Any number with a smaller absolute value will be displayed as 0.

27To select a Numeric Style

Keypad
1. Use the arrow keys to highlight 

Numeric Style.
2. Press  to open the menu.
3. Use the arrow keys to highlight the 

desired style and press ; or press 
the number on the keypad corre-
sponding to the desired style.

Mouse
1. Click Numeric Style to open the menu.
2. Click the desired style.

28To select the Number of Digits

Keypad
1. Use the arrow keys to highlight Num-

ber of Digits.
2. Press  or  increase or 

decrease the value.

Mouse
1. Click Number of Digits to highlight it.
2. Press  or  increase or 

decrease the value.

�
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Calibrat ion
Some of the sensors that you use with the GLX can be calibrated in the Calibra-
tion dialog box, which is accessible through the Sensors screen. Calibration can 
make a measurement more accurate or adjust multiple measurements so that they 
agree with each other.

Sensors designed for calibration include the temperature probes included with the 
GLX. Certain other PASPORT sensors are also calibratable. To find out if a sen-
sor can be calibrated, check its documentation, or connect it to the GLX and look 
for it in the Sensor field of the Calibration dialog box.

To Open the Calibration Dialog Box

From the Sensors Screen29 follow these steps.

1. Press  to open the Sensor Menu.

2. Use the arrow keys to highlight Calibrate and press ; or press the num-
ber on the keypad corresponding to Calibrate.

The Calibration dialog box will not open during data collection.

Theory of Calibration

To skip to the practical instructions on calibrating a sensor, see “Navigating in 
the Calibration Dialog Box” on page 73 and “Calibration Procedures” on 
page 75.

One of the functions of the GLX is to take the stream of raw data from a sensor 
and transform it into the calibrated data that you see in the Graph, Table, and 
other displays. If you do not calibrate a sensor yourself, the GLX uses a default 
calibration that is loaded when the sensor is connected.

You can think of the GLX as containing a device that takes in raw data and out-
puts calibrated data.

When you perform a calibration, the GLX redefines the linear equation that 
transforms the raw input into the calibrated output. The linear function is of the 
form:

Or:

This function can be graphically represented as a line.

29See “Sensors Screen” on page 55.
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Two points, Pt 1 and Pt 2, define the line. In the two-point calibration procedure, 
each point is reset by associating a known standard value (for instance, the pH of 
a buffer solution) with a raw input measurement that the sensor sends to the GLX 
when it is in that standard. In a one-point calibration, only one of the points is 
reset by the user.

Types of Calibration

There are three types of calibration: two-point, one-point slope, and one-point 
offset. Any of these calibrations can be performed on a single sensor, or simulta-
neously on multiple similar sensors; however, for any given sensor, the GLX will 
automatically select the most typical calibration type as the default setting.

Two-Point In a two-point calibration, you reset two points to define a new line. 
This type of calibration affects both the slope and the offset. For step-by-step 
instructions on the two-point calibration procedure, see page 75.

Two-point calibration; two points are set to redefine the line

One-Point Slope In a one-point slope calibration, you reset only one point. 
The slope of the line changes so that the line intersects the new point, while the 
offset (or Y-intercept) does not change. For step-by-step instructions on the one-
point slope calibration procedure, see page 76.

One-point slope calibration; the line changes its slope to intersect the new point
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One-Point Offset In a one-point offset calibration, you reset only one point. 
The line shifts so that it intersects the new point, but its slope does not change.

One-point slope calibration; the line shifts to intersect the new point

Offset calibration is usually used to make one sensor agree with another sensor. 
The graph below on the left shows the measurements from two temperature 
probes in the same container of water. Due to normal variation among probes, the 
second probe consistently reads about 0.08 °C higher than the first probe. Nor-
mally this difference would be insignificant; however, an offset calibration can 
be used to bring the sensors into closer alignment. See “One-Point Offset Cali-
bration or Multiple-Measurement Alignment Procedure” on page 77 for step-by-
step instructions.

Navigating in the Calibration Dialog Box

For step-by-step instructions on the calibration procedure, see page 75.

The Calibration dialog box contains a list of fields that are used to select the mea-
surement (or measurements) to be calibrated, and to enter the parameters of the 
calibration. One of the fields is always highlighted. Use the up and down arrow 
keys to move the highlight to a different field. 

You will sometimes see an up or down arrow (  or ) near the bottom of the 
dialog box indicating that more fields are available, but not currently visible. 
When you see the up arrow displayed on the screen, you can press the up arrow 
key on the keypad multiple times to make more fields visible. When you see the 
down arrow displayed on the screen, you can press the down arrow key to make 
more fields visible.
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The top and bottom portions of the Calibration dialog box

Sensor Field Highlight this field and press  or  to cycle through the 
calibratable sensors connected to the GLX.

Measurement Field Highlight this field and press  or  to cycle through 
the calibratable measurements of the selected sensor.

Single/All Field Highlight the Single/All Field and press  to switch 
between “Calibrate selected measurement only” and “Calibrate all similar mea-
surements.”30

Calibration Type In most cases, it is not necessary to access this field because 
the GLX automatically selects the most typical calibration type for the selected 
measurement. 

To override the automatic selection, highlight Calibration Type and press  to 
open the menu. Highlight the desired calibration type and press , or press the 
number on the keypad corresponding to the desired type. The options are 2 Point, 
1 Point Slope, and 1 Point Offset.

Pt 1 Standard Value Highlight this field and press . Enter a value and 
press .

Pt 1 Sensor Input Value It is usually not necessary to access this field 
because its value is entered automatically when you press . 

To enter a value manually, highlight the field and press . Enter a value and 
press .

Pt 2 Standard Value Highlight this field and press . Enter the value of the 
standard and press .

Pt 2 Sensor Input Value It is usually not necessary to access this field 
because its value is entered automatically when you press . 

To enter a value manually, highlight the field and press . Enter the value of 
the standard and press .
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30See “One-Point Offset Calibration or 
Multiple-Measurement Alignment Proce-
dure” on page 77 for more information.
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Because they are not needed, the fields for Pt 1 are hidden when the 1 Point 
Slope calibration type is selected, and the fields for Pt 2 are hidden when the 
1 Point Offset calibration type is selected.

Calibrated Output and Raw Input Two live values are displayed at the bot-
tom of the Calibration dialog box: the Calibrated Output Measurement and the 
Raw Input Measurement. The Raw Input Measurement is the data transferred 
from the sensor to the GLX. The Calibrated Output Measurement is the value 
resulting from the currently defined calibration. The Calibrated Output Measure-
ment is displayed in the Graph, Table, and other displays.

Note About Raw Input Measurement

The value and units of the raw input measurement data can be confusing because 
they do not necessarily have an obvious meaning. Depending on which sensor 
you are using, the raw input may represent the default calibration, the voltage 
produced by an electrode in the sensor, or the digital output of the sensor’s ana-
log-to-digital converter.

Keep in mind that it does not matter what the value is, or what its units are. It is 
only important that the raw sensor input varies in direct proportion to the quantity 
being measured.

Calibration Procedures

If you don’t know whether a two-point or one-point slope calibration is best 
suited for a particular sensor, follow steps 1–3 of either procedure and 
observe the Calibration Type that is automatically selected.

Two-Point Calibration Procedure

A two-point calibration requires two known standards. For instance, if you are 
calibrating a pH sensor, you might use two buffer solutions: one of pH 4 and the 
other of pH 7.

The fields of the Calibration dialog box are identified on page 74.

1. From the Sensor field, select the desired sensor.

2. From the Measurement field, select the desired measurement.

3. Set the Single/All field to “Calibrate selected measurement only.”

4. From the Calibration Type menu, select 2 Point, if it is not already selected.

5. Place the probe in the first known standard.

6. Enter the value of the standard in the Standard Value field for Pt 1.

7. Observe the Raw Input Measurement displayed near the bottom right corner 
of the screen and wait until it has stabilized.
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76 C a l i b r a t i o n
8. Press  to read the sensor input value of Pt 1. 

Note that the Raw Input Measurement has been automatically entered into 
the Pt 1 Sensor Input Value field, and the standard value is now displayed as 
the Calibrated Output Measurement.

9. Place the probe in the second known standard.

10. Enter the value of the standard in the Standard Value field for Pt 2.

11. Observe the Raw Input Measurement displayed near the bottom right corner 
of the screen and wait until it has stabilized.

12. Press  to read the sensor input value of Pt 2.

Note that the Raw Input Measurement has been automatically entered into 
the Pt 2 Sensor Input Value field, and the standard value is now displayed as 
the Calibrated Output Measurement.

13. Press  to accept the new calibration and return to the Sensors screen, or 
press  to cancel the new calibration and revert to the previous or default 
calibration.

One-Point Slope Calibration Procedure

A one-point slope calibration requires one known standard. For instance, if you 
are calibrating a dissolved oxygen sensor, you might use 100% saturated water, 
for which you can look up the oxygen concentration based on temperature and 
pressure.

The fields of the Calibration dialog box are identified on page 74.

1. From the Sensor field, select the desired sensor.

2. From the Measurement field, select the desired measurement.

3. Set the Single/All field to “Calibrate selected measurement only.”

4. From the Calibration Type menu, select 1 Point Slope, if it is not already 
selected.

5. Place the probe in the known standard.

��

�����������������
��
���
����
��
)�
��������
������$�������
��
����
���

8�������
��
��
#
��������

��

��

��

��

	���
�������
����
����

��������������������
������

�
����������
����
����

�����#�������
��#����
�
����
����

��

��
��



 X p l o r e r  G L X  U s e r s ’  G u i d e 77
6. Enter the value of the standard in the Standard Value field for Pt 2.

7. Observe the Raw Input Measurement displayed near the bottom right corner 
of the screen and wait until it has stabilized.

8. Press  to read the sensor input value.

Note that the Raw Input Measurement has been automatically entered into 
the Pt 2 Sensor Input Value field, and the standard value is now displayed as 
the Calibrated Output Measurement.

9. Press  to accept the new calibration and return to the Sensors screen, or 
press  to cancel the new calibration and revert to the previous or default 
calibration.

One-Point Offset Calibration or Multiple-Measurement Align-
ment Procedure

If you are making two or more simultaneous measurements of the same type, it is 
sometimes desirable to slightly adjust the calibrations so that all of the measure-
ments agree. For instance, if you are using several temperature probes, you may 
find that they have slightly different readings when immersed in the same con-
tainer of liquid; a multiple-measurement alignment will make all of the probes 
read the same temperature.

This procedure is a one-point offset calibration performed on two or more similar 
measurements simultaneously.

The fields of the Calibration dialog box are identified on page 74.

1. From the Sensor field, select the desired sensor.

2. From the Measurement field, select the desired measurement.31

3. Set the Single/All field to “Calibrate all similar measurements.”

4. From the Calibration Type menu, select 1 Point Offset.

5. Place all the probes so that they are all measuring the same thing. It is not 
necessary to know the value of what they are measuring at this point. (For 
instance, place all the temperature probes into the same container of water.)

6. Press . Note that the Calibrated Output Measurement has been auto-
matically entered into the Pt 1 Standard Value field, and the Raw Input Mea-
surement has been automatically entered into the Pt 1 Sensor Input Value 
field. 

7. Press  to accept the new calibration and return to the Sensors screen, or 
press  to cancel the new calibration and revert to the previous or default 
calibration.

To confirm that the measurements are aligned, open the Digits display and view 
two or more of the measurements simultaneously while recording data. They 
should be identical or very close.

For information on the Digits display, see page 37.
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31In this case, the calibration of the 
selected measurement will not change. 
Rather, the calibrations of all other simi-
lar measurements will be changed to 
match the selected measurement.
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Data Files Screen
Collected data, calculations, notes, display configurations, and sensor settings are 
all stored in the GLX’s memory. You can save data in a file during or after an 
experiment, or save a file without data to use as the starting point of an experi-
ment. Use the Data Files screen to view, create, copy, move, and delete these files 
and their components. In this screen you can also transfer files to and from a sec-
ond GLX or a flash drive connected to the USB port.

To Open the Data Files Screen

From the Home Screen, do one of the following:

use the arrow keys to highlight the Data Files icon, then press ; or

click the Data Files icon.

Navigating in the Data Files Screen

The Data Files screen is divided into two sections: the Folder Selector and the 
File List. The Folder Selector is used to select one of the GLX’s two data-storage 
locations. The File List displays the files stored in the selected folder.

At any time, the focus is either on the Folder Selector or the File List, indicated 
by a dark box surrounding that section. The focused section also has one of its 
items highlighted.

Press the down arrow key to move the focus from the Folder Selector to the File 
List section. Press the up arrow key (when the highlight is on the top entry of the 
File List) to move the focus from the File List to the Folder Selector.

If the File List is empty, the focus cannot be moved to it.

Navigating in the Folder Selector

There are two folders in the Folder Selector: RAM and Flash. When the Folder 
Selector has the focus, the selected folder is highlighted. Press the left and right 
arrow keys to switch between RAM and Flash. The size and free capacity of the 
selected folder are indicated below the Folder Selector. The files in the selected 
folder are displayed in the File List section.

Press the down arrow key to move the focus to the File List of the selected folder. 
When the focus is not on the Folder Selector, the selected folder is indicated by a 
dashed box.

The Data Files icon on 
the Home Screen
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For more information on the RAM and Flash data-storage locations, see 
page 82.

Navigating in the File List

When the focus is on the File List, a highlight appears on one of the entries. Press 
the up and down arrow keys to move the highlight. 

The entries in the File List consist of:

The Active File This is the open file that you are currently working with. It 
always appears as the first entry in the RAM file list. Any data that is recorded 
becomes part of the active file.

The active file may be saved or unsaved (see “F2 Save” on page 80). If you have 
collected data or you have changed any settings since the last time you saved the 
active file, the saved version of the active file may not match the current state of 
the GLX.

Saved Files These are files that are stored but not necessarily open. The file list 
indicates the size of each file and the date on which it was last saved. When you 
open a saved file (see “F1 Open” on page 80), it becomes the active file. 

File Contents By default, the file contents are hidden. To view the contents of a 
file, highlight the file and press the right arrow key. To hide the contents, press 
the left arrow key. The icon to the left of the file indicates whether a file can be 
expanded or contracted. 

The file contents include the following types of components, which can be recog-
nized by their icons.

• Sensors and timers. Every sensor or timer that appears in the Sensors 
screen of the file receives a separate entry in the file list. (See “Sensors 
Screen” on page 55.)

• Data runs. If the file contains data collected from sensors, each data run 
appears as a file list entry with the time at which data collection started. A 
data run represents all of the data recorded from all of the connected sensors 
within a single period of data collection. By default, data runs are named 
Run #1, Run #2, etc., but they can be renamed (see “Rename” on page 81).

• Manually entered data. Each column of data that has been entered in the 
Table appears as a separate entry. (See “Manually Entered Data” on 
page 32.)

• Calculations. Every equation or expression entered in the Calculator 
appears as a separate entry. (See “Calculator” on page 41.)

• Displays. If the Graph or Table in the file has been altered from its default 
settings, it appears in the file list. If multiple graph pages exist, each page 
appears separately. (See “Graph” on page 13 and “Table” on page 28.)

• Notes. If one or more Notes pages exist in the file, they are represented by a 
single entry. (See “Notes Screen” on page 53.)

The GLX saves all the components of a file, but not all of them appear in the File 
List. The hidden components include the Digits display configuration, Output 
settings, and data properties.
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Mouse Navigation

If you are using a mouse, click RAM or Flash to view the File List for each 
folder. Click the file or file component to highlight it. Click the icon to the left of 
a file to show or hide the file contents.

Data Files Function Keys

F1 Open

To open a saved file, highlight it in the File List and press  (or click Open).

If changes have been made to the current active file since it was last saved, a dia-
log box will ask if you want to save the file. Select Yes ( ) to save the active 
file before the new file is opened. Select No ( ) to open the new file without 
saving the active file; any changes you have made to the active file since it was 
last saved will be lost. Select cancel ( ) to keep the active file open and not 
open a new file.

To make the active file revert to its last-saved state, highlight it and press  
(Open). When the dialog box asks if you want to save changes, select No ( ).

F2 Save

Press  (or click Save) to save the active file. If a previous version of the file 
had been saved in RAM, it will be overwritten. If the active file had originally 
been opened from the Flash folder, a new copy will be saved in the RAM folder.

F3 Delete

To delete a file, highlight it in the File List and press  (or click Delete). A 
dialog box will ask for confirmation before the file is deleted; select OK ( ) 
or Cancel ( ).

You can use  instead of  to delete a single file.

If you delete the active file, it will be unloaded from the GLX and the last copy 
saved in RAM will be deleted.

To delete a data run or manually entered data set from the active file, highlight it 
and press  (or click Delete). To delete an individual data run or data set 
from a saved file, the file must first be opened.

When the Folder Selector is active, the  option is Delete All. Highlight the 
RAM or Flash folder and press  (or click Delete All) to delete the entire 
contents of that folder.

F4 Files

Press  (or click Files) to open the Files menu. The contents of this menu 
change depending on what item is highlighted in the File List or Folder Selector. 
Possible menu options are described below.

New File This option is always available from the Files menu. Select it to 
unload the current active file and create a new active file.32 
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32To select an option from the Files 
menu

Keypad
1. Press  to open the Files menu.
2. Use the arrow keys to highlight the 

desired menu option and press ; 
or press the number on the keypad 
corresponding to the desired menu 
option.

Mouse
1. Click Files to open the Files menu.
2. Click the desired menu option.

��



 X p l o r e r  G L X  U s e r s ’  G u i d e 81
If changes have been made to the current active file since it was last saved, a dia-
log box will ask if you want to save the file. Select Yes ( ) to save the current 
active file before it is unloaded. Select No ( ) to unload the file without sav-
ing it; any changes you have made since it was last saved will be lost. Select can-
cel ( ) to keep the current active file open and not create a new file.

Save As This option appears in the Files menu when the active file is high-
lighted. Select Save As to save the active file with a new name.

Enter the new file name on the keypad (see “Multipress Text Input Mode” on 
page 90) and press .

Move File Move File appears in the Files menu when a saved file (other than 
the active file) is highlighted. Use this option to move the highlighted file from 
the RAM folder to the Flash folder, or vice versa.

When you select Move File, an icon appears in the Folder Selector section of the 
screen. Press the left or right arrow key to place the icon next to RAM or Flash 
and press . The file will be moved to that folder.

You cannot move the active file, because that file must remain in the RAM 
folder. To place the active file in the Flash folder, press  to save it, then use 
Copy File (see below) from the Files menu.

Move All Files This option appears in the Files menu when the Folder Selector 
has the focus and the selected folder contains saved files other than the active 
file. Move All Files is similar to Move File, but it moves every saved file in the 
selected folder, except the active file, to the folder that you choose.

Copy File This option appears in the Files menu when any saved file is high-
lighted. Copy File is similar to Move File, but, instead of moving the file, a copy 
of the file is placed in the folder that you choose.

If Copy File is used on the active file, the last saved state of the active file will be 
copied. Any changes that have been made to the active file since you last saved it 
will not be part of the copied file.

If you place the copied file in a different folder, it will have the same name as the 
original. If you place it in the same folder, the words “Copy of” will be added to 
the original name.

Copy All Files This option appears in the Files menu when the Folder Selector 
has the focus. Copy All Files is similar to Copy File, but it copies every saved file 
in the selected folder to the folder that you choose.

Rename This option is available when a file in the RAM folder or a data run in 
the active file is highlighted. Follow these steps to change the name of a file or 
data run.

1. Highlight the file or data run.

2. Select rename from the Files menu.

3. Enter the new file name on the keypad (see “Multipress Text Input Mode” on 
page 90) and press  (or press  to cancel the name change).

You can rename a file or run without opening the Files menu. Highlight the file 
or run and press . Type the new name and press .
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RAM and Flash

The GLX has two types of memory for file storage: RAM and Flash, represented 
by two folders in the Data Files screen. By default, files are saved in the RAM 
folder. Whether it is most appropriate to store a file in RAM or Flash depends on 
how you intend to use the file.

Files in the RAM folder are saved in the GLX’s random access memory. With a 
capacity of about 12 MB, the RAM folder is large enough to store many files, 
including ones containing large data sets. Files can be saved to RAM quickly and 
easily.

Files copied to the Flash folder are stored in a special type of programmable 
read-only memory. Use the Flash folder to store files that you do not want to be 
easily altered, such as configuration files for experiments or sample data files. 
When you open a file from the Flash folder and save it again, it does not over-
write the original file; rather, it saves a copy in the RAM folder. This property 
prevents users from accidentally saving collected data over a file designed to be 
used as an experiment set-up file.

Files saved in either RAM or Flash will remain saved even if the GLX’s battery 
runs too low for normal operation. When the battery drains to a critical level, the 
GLX shuts down, reserving enough energy to maintain the RAM memory until it 
can be connected to AC power. However, if you store the GLX for several days 
without power connected after the battery has drained to the critical level, it is 
possible for the battery to run so low that RAM is erased. 

Flash memory does not require any power to store data permanently. You can 
leave the GLX unpowered for any amount of time without losing files saved in 
the Flash folder.33

File Size Limits

In order to reserve enough free RAM capacity to save a data file, the GLX limits 
a single file to 4 MB. If that size limit is reached, data collection will automati-
cally stop. To collect data after the file-size limit has been reached, delete exist-
ing data or start a new file. Data collection will also stop if the size of the data file 
exceeds the free space remaining in RAM. Since a 4-MB file typically contains 
over 100000 data points (depending on the sensors used), most users will not be 
affected by these limits.

33See page 94 for more information 
about battery power and data storage.
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Using the GLX with a USB Storage Device

If you have a USB storage device34 (such as a USB flash drive), you can use it to 
add storage capacity to your GLX, back up data, and transfer data to another 
GLX or a computer.

See also “Export All Data” on page 32 for instructions on exporting data as a 
tab-delimited text file to USB storage.

Connect a storage device to the larger USB socket (labeled with ) on the 
side of the GLX.

File Transfer 

When a USB storage device is connected to the GLX, a third icon appears in the 
Folder Selector of the Data Files screen.

This icon represents the USB storage “folder.” Use this folder like the standard 
RAM and Flash folders to open, delete, move, copy, and rename files (see pages 
80–81). You cannot open a file directly from USB storage; you must first move 
the file to the GLX’s RAM or Flash folder. After you have saved files on the stor-
age device, you can unplug it and connect it to any other GLX to open the files. 

If you connect the storage device to a computer, you will find the files on the 
device’s root level. See page 101 for instructions on opening these files in 
DataStudio, or page 104 for instructions on opening them in the GLX Simulator. 
You can also copy GLX files35 from the computer to the storage device, and later 
open these files on a GLX. When you copy or save a GLX file from your com-
puter to the storage device, you can put it at the root level or in a folder; when the 
device is connected to a GLX, the GLX searches through the entire device and 
displays all GLX files in the Data Files screen. 

Backup and Restore GLX Files

To back up the GLX, go to the Data Files screen and press  to open the Files 
menu; select Backup GLX Files. All data files in the Ram and Flash folders and 
all settings are copied to the flash drive. To restore these files and settings, press 

 to open the Files menu and select Restore GLX Files. Once a GLX has 
been backed up onto a storage device, you can restore the files and settings onto 
any other GLX.

The back-up and restore operations may erase and overwrite files and settings on 
the GLX or flash drive. When you back up a GLX, any previous GLX back-up 
data on the flash drive is overwritten. When you restore backed-up data, all previ-
ous files and settings on the GLX are overwritten. 

Data that you have stored using the GLX backup operation can only be accessed 
using the restore operation. If you want to save multiple files that can be accessed 
individually, use the Move All Files or Copy All Files options from the Files 
menu (see page page 81).

If you connect the flash drive to a computer after you have backed up a GLX, 
you will find a folder named GLXBackup, which contains the back-up data. 
This folder and the files in it are intended only for access by the GLX when it 
performs the restore operation.

34The USB storage device must be for-
matted using the FAT16 or FAT32 file 
system. Most flash drives are formatted 
this way. Other mass-storage devices 
such as portable hard drives and audio 
players may also be compatible. You can 
use a USB card reader, however the 
card must be in the reader before you 
connect the reader to the GLX.
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A third folder appears when a USB 
storage device is connected

35GLX files on your computer may have 
been transferred there from another GLX 
(see page 100) or created using the GLX 
simulator (see page 103).
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Backup and Restore options in the 
Files menu
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GLX-to-GLX File Transfer

To transfer files directly between two GLXs, connect the larger USB port of one 
GLX to the smaller USB port of the other GLX using the included USB host-
connection cable. 

The GLX connected by the larger USB port is the host unit, and the one con-
nected by the smaller port is the remote unit. All GLX-to-GLX file-transfer oper-
ations are controlled in the Settings screen of the host unit.

When a remote GLX is connected, two additional folders appear in the Settings 
screen of the host GLX, which represent the RAM and Flash folders of the 
remote unit. Use these folders like the host RAM and Flash folders to open, 
delete, move, and copy files (see pages 80–81). You cannot open a file directly 
from the remote GLX; you must first move the file to the host GLX’s RAM or 
Flash folder.

The Data Files screen with a remote GLX connected
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Use the host-connection cable to connect two GLXs
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Settings Screen

Settings screen

The Settings screen contains the controls for how the GLX environment looks 
and acts.

To Open the Settings Screen

From the Home Screen, do one of the following:

use the arrow keys to highlight the Settings icon, then press ; or

click the Settings icon.

Settings

To change any of the settings, use the arrow keys to highlight the setting and 
press .

If you are using a mouse, click the desired setting.

Name If the active file (see page 79) has not been named, the GLX’s name 
appears in the Top Bar. By default, the name of the GLX is “XplorerGLX.” If 
you are working with more than one GLX and would like to uniquely identify 
each one, change the name of each GLX. Highlight Name and press . Type 
the new name36 and press .

Date Format The date shown in the Top Bar can be displayed in two formats: 
month/day/year (MM/DD/YY) or day/month/year (DD/MM/YY). Highlight 
Date Format and press  to switch between the two options.

Time Format The time shown in the Top Bar can be displayed in either 12-hour 
or 24-hour format. Highlight Time Format and press  to switch between the 
two options.

See “F1 Set Date and Time” below to manually set the date and time.

Auto Power Off This setting controls how many idle minutes the GLX will 
wait before it automatically shuts off or goes into sleep-between-samples mode 
when running on battery power. See “Auto Power Off” on page 8 for more infor-
mation.

Highlight Auto Power Off and press  to open the menu. Use the arrow keys 
to highlight the desired time and press .

��
��

��

The Settings icon on 
the Home Screen

36See “Multipress Text Input Mode” on 
page 90.
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Back Light From anywhere in the GLX environment, the easiest way to turn 
the screen’s back light on or off is to hold  and press .

You can also operate the back light from the Settings screen. Highlight Back 
Light and press  to open the menu. Use the arrow keys to highlight the 
desired menu option and press  or press the number on the keypad corre-
sponding to the desired menu option. The options are:

• Off;

• On;

• Keypress (10 s): the back light is normally off, but turns on when you press 
any key and stays on for 10 seconds; and

• Keypress (30 s): the back light is normally off, but turns on when you press 
any key and stays on for 30 seconds.

Screen Contrast From anywhere in the GLX environment, hold down  
and press the up or down arrow key to adjust the screen contrast.

From the Settings screen, you can also highlight Screen Contrast and press  
to make the screen darker or  to make it lighter.

Language The GLX has several language options. Highlight Language and 
press  to open the menu. Use the arrow keys to highlight the desired lan-
guage and press . 

An arrow ( ) in the lower right corner of the menu indicates that more 
menu options are available, but not visible; press the down arrow key to 
move the highlight to the bottom of the menu, then press the arrow key again 
to make more options visible.

Sensor Auto-Display Sensor Auto-Display causes the GLX to automatically 
launch a display (such as the Graph) when you plug in a single sensor while 
viewing the Home Screen, or when you turn on the GLX with a sensor con-
nected. This feature is designed to simplify basic data collection with a single 
sensor.

Sensor Auto-Display is on by default. To turn it off, highlight it in the Settings 
screen and press .

Startup Action There are two options for Startup Action. By default, the Star-
tup Action is set to “Open New Experiment,” which causes the creation of a new, 
empty data file every time the GLX starts up.

The other Startup Action option is “Open Last File,” which makes the GLX open 
the most recently saved file whenever it starts up. It is convenient to use this 
option if you plan to turn the GLX off and on during an activity, or if the GLX is 
likely to automatically turn itself off due to being left idle.

To change the Startup Action, highlight it in the Settings screen and press .
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Settings Screen Function Keys

F1 Set Date and Time

The date and time are set automatically when you connect the GLX to a com-
puter running DataStudio.

Follow these steps to set the date and time manually.

1. Press . A dialog box will open with settings for Month, Day, Year, 
Hour, Minute, and Second. 

2. Use the up and down arrow keys to highlight the setting you would like to 
change.

3. Press  or  to increase or decrease the selected setting; or press , 
enter the setting on the keypad and press  again.37

4. Repeat steps 2 and 3 until all desired settings have been changed.

5. Press  to accept changes or press  to cancel changes.

F2 Audio Settings Dialog Box

From the Settings screen, press  to open the Audio Settings dialog box.38 
The audio settings determine how audio notes (see page 25) are recorded and 
played back. Some of the Output screen’s default settings (see page 39) are also 
based on these settings. After changing any of the settings, press  to accept 
the changes or  to cancel.

Sample Rate and Bits Per Sample These two settings determine the quality 
and size of recorded audio notes. Higher values of either setting result in higher-
quality audio, but also make audio notes use more of the GLX’s memory.

Mic Input Volume This setting determines the sensitivity of the GLX’s micro-
phone when used for recording audio notes. When set to Automatic, the mic vol-
ume adjusts itself in response to the present sound level.

Speaker Volume This setting determines the loudness of audio-note playback 
and sound output. 

Output Device To play audio notes and sound output through the GLX’s built-
in speaker, set Output Device to Internal Speaker. Set Output Device to Head-
phones or External Speaker if you have headphones or powered stereo speakers 
connected to the GLX’s signal output port.

Speaker Configuration This setting determines how sound generated in the 
Output Screen is played through headphones or external speakers. If Output 
Device is set to Headphones or External Speakers, the two options are Mono and 
Stereo; if Output Device is set to Internal Speaker, the only option is Mono.

F4 Version

Press  to see the version numbers of the Firmware, Core, and Power Man-
ager installed on your GLX. These version numbers represent the updatable por-
tions of the GLX’s operating system.

��
����
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37If the Time Format is 12-Hour (AM/
PM), then a menu will open when you 
highlight Hour and press ; use the up 
and down arrow keys to select the hour 
and press  again.�� ��
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Audio Settings dialog box
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38To change an audio setting

Keypad
1. From the Settings screen press  

to open the Audio Settings dialog box.
2. Use the arrow keys to highlight the 

desired setting.
3. Press .
4. If a menu opens, use the arrow keys 

to select the desired value and 
press .

Mouse
1. At the bottom of the Settings screen, 

click Set to open the Audio Set-
tings dialog box.

1. Click the desired setting.
2. If a menu opens, click the desired 

value.
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Chapter 4: Navigat ion and Input

Data Source Menus
The axes of the Graph, the columns of the Table, the sections of the Digits dis-
play, and the Meter each have a data source field, which you access to choose 
what data to display. Selecting any of these data source fields opens a data source 
menu containing a list of all available data sources.

Identifying a Data Source

• In one of the simplest cases—a GLX with one single-measurement sensor 
connected, and no calculations or manually entered data—the data source 
menu contains two items, as illustrated to the right. In this example, there is 
only one data source option, so it is selected automatically. 

Selecting the other option in the menu, Data Properties, opens the Data 
Properties dialog box for the selected measurement. See “Accessing Data 
Properties” on page 90.

• In this example, the GLX is connected to two single-measurement sensors: a 
Temperature Sensor and a Relative Pressure Sensor. There are two data 
sources to choose from. The selected data source has a check mark next to it. 
The two data sources are from two different sensors, so each has a different 
icon. 

• Certain sensors make more than one measurement. The data source menu 
pictured here is from a GLX connected to a Pressure/Temperature Sensor. 
Note that the two data sources have the same icon, indicating that they both 
come from the same sensor.

• The menu pictured to the right is from a GLX connected to two sensors: a 
Temperature Sensor and pH/ORP/ISE/Temperature Sensor. The pH/ORP/
ISE/Temperature Sensor makes several measurements, one of which is Tem-
perature. There are two data sources named “Temperature,” one from the 
pH/ORP/ISE/Temperature Sensor and one from the Temperature Sensor. 
You can tell which sensor each temperature measurement is from by looking 
at the icons next to the measurement names.

Expanding the Data Source Menu

• The menu pictured to the right is from a GLX connected to a Motion Sensor.

The Motion Sensor makes three measurements: Position, Velocity, and 
Acceleration. Only one measurement, Position, is visible. The “More” 
option that appears with a Motion Sensor icon indicates that other measure-
ments are available from that sensor, but are not shown. Select “More” to see 
the other available measurements.

• In the menu pictured to the right, two sensors are present that each have hid-
den measurements. There are two “More” options, one for each sensor. They 
can be distinguished by their different icons.
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Accessing Data Properties

Selecting the Data Properties option from a data source menu opens the Data 
Properties dialog box for the selected measurement. In this example, the Data 
Properties for Relative Pressure would open.

To access the Data Properties of another measurement, first select that measure-
ment from the data source menu, then open the menu again and select Data Prop-
erties.

For information on the Data Properties dialog box, see page 69.

Mult ipress Text Input Mode
Multipress text input is used to enter numbers and letters through the keypad of 
the GLX. Each of the GLX’s input keys has a number and several letters or punc-
tuation marks printed on it. In multipress mode, repeatedly pressing a key will 
cycle through these characters.

The 7 key ( ) will cycle through punctuation marks, not all of which are 
printed on the key. The characters in the cycle are:

7 ? ! @ ( ) , : ; & ~ % # < >

The 0 key ( ) cycles through two characters: 0 and a space. 

The decimal point key ( ) cycles through two characters: a period (or decimal 
point) and E, which is used often in scientific notation.

Using a USB Keyboard
For most users, text entry is faster and easier with a USB keyboard1 connected to 
the GLX. A keyboard also allows the input of capital letters in areas of the GLX 
environment where Shift and Caps Lock are not available.

Most keys on the GLX’s keypad have an obvious equivalent key on an attached 
USB keyboard. The less obvious keyboard equivalents are shown in the table 
below.

GLX Key USB Keyboard Equivalent

Enter and Return

Home

F5

F6

Backspace and Delete

* (asterisk)


��




��

1PASCO part PS-2540 or PS-2541

�
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Scientif ic Notation
The GLX displays very large and very small numbers using scientific notation. 
You can also input any number using scientific notation. On the GLX, the letter 
E, when it is placed between two numbers (with no spaces) is interpreted as 
meaning “times 10 raised to the power of….”

The letter E can always be input by pressing the decimal point key ( ) twice, 
even when the GLX is not in multipress text input mode.

Below are some examples of scientific notation and their normal equivalents.

5E2 = 500

1.234E5 = 123400

56.789E1 = 567.89

6.518E-3 = 0.006518

A lowercase e can be used interchangeably with uppercase E:

4.35e5 = 4.35E5 = 435000

A number expressed in scientific notation must not have a space adjacent to the 
E. The number to the left of the E can contain a decimal point, but one is not 
required. The number to the right of the E must not contain a decimal point.

Printing
The Graph, Table, Calculator, Sensors, Output, Notes, Meter, and Stopwatch 
screens can all be printed on certain models of printers2 connected to the GLX’s 
USB port. In these screens, select the print command (or commands) from the 

 menu.

To install a printer on the GLX, simply connect it to the GLX’s USB port using 
the cable that came with your printer. Drivers for compatible printers are factory 
installed on the GLX and updated whenever the GLX receives a firmware update 
(see page 93).

��

2The list of compatible printers is contin-
ually increasing as new printer models 
become available. For an up-to-date list 
of compatible printers, visit 
www.pasco.com or contact PASCO tech-
nical support at:

support@pasco.com
or
(916) 786-3800
or
(800) 772-8700

��
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Chapter 5: Hardware Maintenance and
Operation

Firmware Update
From time to time, PASCO issues a free update to the firmware that runs on the 
GLX. Updates include new and improved features and bug fixes. Send in the reg-
istration card that you received with your GLX, or register at 
www.pasco.com/glx to be notified of new updates.

To check the version of firmware currently installed on your GLX, open the Set-
tings screen (see page 85) and press .

You can always download the latest update from www.pasco.com/glx. Follow the 
instructions at the website to download the update to your computer or a USB 
flash drive. When you download the firmware update, also download the latest 
revision of this Users’ Guide from the same web page. 

Installing updates may delete files saved in the RAM and Flash folders of the 
GLX. Transfer stored files to your computer before upgrading the GLX. (See 
“Transferring Files” on page 100.)

Updating from a Computer

Once the update is on your computer, connect the GLX to the USB port and run 
DataStudio. When DataStudio detects a GLX running an older firmware version, 
it will give the option of upgrading that GLX. (See “GLX with DataStudio” on 
page 99.)

Updating from a USB Flash Drive1

Connect the USB flash drive containing the update to the GLX’s USB port. Open 
the Data Files screen (see page 78). Press  to open the Files menu and select 
Upgrade GLX Firmware.

Battery and Power

Battery Charging

To charge the battery, simply connect the GLX to the AC power adapter. The 
GLX will automatically power on. If its battery is less than fully charged, the 
GLX will begin to charge the battery and remain powered on until the battery is 
fully charged.2

If the battery is fully charged and AC power is connected, the GLX will automat-
ically save data and shut down after 60 minutes of idle time.3 It will periodically 
power on and top off the battery as needed.

The typical full charging time for a new battery at room temperature is about 14 
hours. When practical, allow the GLX to charge its battery in a room-temperature 
or cooler environment. Place the GLX on a flat surface with its stand unfolded to 
accommodate air flow and heat dissipation.

Version numbers displayed in the
Settings screen

��

��

1To update the firmware from a flash 
drive, the previous firmware version must 
be 1.35 or later.

��

2The icon in the upper-right corner of the 
display indicates the condition of the bat-
tery. See page 11 for details.

3The GLX is considered idle when
• the GLX is not collecting data,

• the Stopwatch is not running,

• the GLX is not connected to a com-
puter running DataStudio, and

• the GLX is not receiving input through 
its keypad, a mouse, or a USB key-
board.

See “Timed Auto Power Off” on page 8 
for more information.
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While charging, the GLX monitors its own temperature to prevent overheating. 
The maximum recommended ambient temperature for charging is 32 °C (90 °F) 
without sensors, or 28 °C (82 °F) with four maximum-load sensors4 connected. If 
the GLX becomes too hot, it will temporarily stop charging to allow itself to cool, 
resulting in a longer charge time.

Battery Power and Data File Storage

The GLX’s RAM (random-access memory) requires a small amount of power. In 
order to preserve stored data, the GLX automatically shuts down when its battery 
begins to run low. At that point, AC power must be connected within three days 
to preserve data files stored in the RAM folder.

When powered off, disconnected from AC power, and starting with a fully 
charged battery, the GLX will store RAM data for two weeks.

Flash memory does not require power. Data files stored in the Flash folder will 
be preserved indefinitely even if the battery runs down or is removed. 

For permanent storage, save files in the GLX’s Flash folder or transfer files to a 
USB Flash drive or a computer.5

GLX Storage

To maximize the long-term performance of the battery, keep it charged as much 
as possible. Note that the battery will drain slowly even when the GLX is pow-
ered off and disconnected from AC power. When you are not using the GLX, fol-
low these storage guidelines:

• Whenever possible: Keep the GLX connected to AC power.

• Unplugged for more than a few days: Backup your data and allow the bat-
tery to fully charge before disconnecting the AC power.

• Unplugged for more than a month: Backup your data, allow the battery to 
fully charge, then follow the instructions under “Manual Internal Disconnec-
tion” below. A disconnected battery or a GLX in “deep sleep” mode can be 
stored for up to a year before you should recharge it.

Battery Disconnection

Automatic Internal Disconnection

When it is unplugged and turned off, the GLX uses a small amount of battery 
power to preserve data saved in RAM. In order to avoid fully discharging the bat-
tery (which is not good for it), the GLX will go into “deep sleep” mode when 
either of these conditions is met:

• The GLX has been unused and unplugged for two weeks.

• The battery has drained to a critical level.

When the GLX enters deep sleep mode, it disconnects its battery by opening a 
switch on its circuit board. At this point, data saved in RAM is lost, but data 
saved in Flash is preserved. Connect the GLX to AC power or press the reset but-
ton (on the back of the GLX) to turn it back on.

4A maximum-load sensor is one that 
draws 100 mA of current from the GLX, 
such as the PASPORT CO2 sensor. Most 
PASPORT sensors draw much less cur-
rent.

5See “Data Files Screen” on page 78 for 
more information.
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Manual Internal Disconnection

If you anticipate that your GLX will be left unused and unplugged for more than 
a month, manually put it into deep sleep mode. This will make it more likely that 
the battery will be charged the next time you use it. Follow these steps:

1. Leave the GLX plugged in until the battery is fully charged.

2. Unplug the AC Adapter.

3. Open the Settings screen (see page 85).

4. Press  to open the Battery Set menu. Press  to select Disconnect 
Battery.

5. You will see a warning message (right). If you are sure that you want to dis-
connect the battery, press  for OK.

6. The GLX disconnects its battery and powers off. To turn the GLX back on, 
connect the AC adapter or press the reset button on the back (using a paper 
clip).

Battery Disconnection for Early Hardware Versions

Some earlier versions of the GLX do not contain a switch for internal battery dis-
connection.6 If you have one of these models and you follow the manual discon-
nect instructions above, the GLX will display a message indicating that it does 
not support internal battery disconnection. If this is the case, store the GLX con-
nected to AC power or remove the battery door on the back of the GLX and 
unplug the battery. (Do not connect the AC adapter when the battery in not 
installed.)

Battery Capacity

The operating time for a single battery charge depends on many factors including 
the age and history of the battery, the number and type of sensors connected, the 
use of sound output, and the backlight. At an ambient temperature of 25 °C, a 
GLX with a newer battery, no PASPORT sensors connected (using only the 
included temperature and voltage probes), sound output turned off and backlight 
off will operate for about six to seven hours before it automatically saves data 
and shuts down.

You can maximize the operating time by unplugging sensors when they are not 
collecting data, using the backlight only when necessary, and turning off the 
GLX while not in use. 

If the GLX will be collecting data over a long time, set the sampling period of all 
sensors to 30 s or greater (see page 56). This will allow the GLX to conserve 
power by “sleeping” between samples. In this mode of data collection, the battery 
will last for several days or more.

Battery Reconditioning and Replacement

As with all rechargeable batteries, the GLX’s nickel metal hydride battery will 
lose capacity with age and repeated use. Under typical conditions, the battery can 
be used for about 500 charge-discharge cycles before capacity loss becomes sig-
nificant.

�� �������������������������
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6A GLX that does not contain an internal 
battery switch can be identified by the 
first four digits of its serial number, which 
will be less than 0626. These units were 
manufactured in 2005 and early 2006. 
You will find the serial number on the bar-
code sticker on the back of the GLX. 
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When the battery’s capacity begins to decrease, it will continue to function, but it 
will require more frequent recharging, and the maximum unpowered time for the 
GLX to store data in RAM will decrease. 

If this happens, try to recondition the battery by running it through three com-
plete, uninterrupted charge-discharge cycles: Disconnect the AC adapter. Plug in 
a sensor. Start data collection and wait until the GLX shuts down due to low bat-
tery. Plug in the AC adapter and let the GLX charge uninterrupted until the bat-
tery gauge indicates full (about 14 hours). Repeat this cycle at least two more 
times.

If the battery can not be reconditioned, replace it with a new battery7 (PASCO 
part PS-2527): Use a Phillips screwdriver to remove the screws securing the bat-
tery door on the back of the GLX. Remove the door, unplug the old battery, and 
install the new battery in its place. Replace the door. 

To calibrate the GLX’s battery gauge for the new battery, run it through one full 
charge-discharge cycle: Connect the AC adapter and allow the battery to fully 
charge. Then disconnect the AC adapter, plug in a sensor, start data collection, 
and allow the battery to discharge until the GLX automatically shuts down.

Resett ing

To Start a New Experiment

To start a new experiment without turning off the GLX, go to the Data Files 
screen (see page 78), press  to open the Files menu, and press  to select 
New File. Previous data, displays, and sensor settings will be unloaded from the 
GLX and returned to their default configurations.

To Force the GLX to Restart

The following procedures are not necessary in normal GLX operation. They will 
force the GLX to restart and may also result in the loss of data saved in RAM.

• Press and hold  for 5 seconds. The GLX will power off.

• Press the key sequence , , . The GLX will restart.

• Use a paperclip to press the recessed Reset button on the back of the GLX 
(see picture). The GLX will power off or restart depending on the state of its 
battery and the presence of AC power.

To Restore the GLX to Factory Configuration

These procedures are not recommended during normal GLX operation. All 
data files and system settings will be deleted. The normal method for delet-
ing files stored in RAM or Flash is described on page 80.

Follow these steps to reset system settings to factory defaults and delete saved 
data in RAM.

1. Turn the GLX off then on again.

2. When the Splash Screen is visible, press the key sequence - .

7To avoid damage to the GLX, remove 
the AC adapter before disconnecting the 
battery.

To preserve data files in the GLX’s RAM 
folder, transfer them to the Flash folder, a 
USB storage device, another GLX, or a 
computer. See “Data Files Screen” on 
page 78 and “Using the Xplorer GLX with 
a Computer” on page 99 for instructions.

��

Start a new experiment
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3. Connect the GLX to a computer running DataStudio to re-install sensor data 
sheets.

Follow these steps to reset system settings to factory defaults and delete saved 
data in RAM and Flash.

1. Turn the GLX off then on again.

2. When the Splash Screen is visible, press the key sequence - .

3. Connect the GLX to a computer running DataStudio to re-install sensor data 
sheets.

Operating Temperature
The GLX can be operated and stored without damage at temperatures between 
-10 °C and 40 °C. Do not leave the GLX in a parked car or other environment 
that may exceed this range. Protect the GLX from long-term exposure to direct 
sunlight, which may heat the unit above the specified limit even if the surround-
ing air temperature is less than 40 °C. Temperatures at the extremes of this oper-
ating range may affect battery performance, measurement accuracy, and display 
contrast. Whenever possible, use and store the GLX at or close to normal room 
temperature.

���
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Chapter 6: Using the Xplorer GLX
with a Computer

The GLX can be connected to a computer1 to transfer files, to collect data using 
DataStudio software, and to install updates to the GLX.

GLX with DataStudio
When used with a computer, the GLX requires DataStudio version 1.9.5 or later.2 
Before connecting the GLX to your computer, install the version of DataStudio 
that you received on a CD-ROM with your GLX or download the most recent 
version from www.pasco.com.

Connecting the GLX to a Computer

With the GLX powered on, use the USB host-connection cable (included with 
the GLX) to connect the smaller USB port of the GLX to the USB port of your 
computer.

Launching DataStudio

• If there is a new file saved on the GLX3, your computer will automatically 
launch DataStudio when the GLX is connected.

• If there are sensors connected to the GLX, but no new files, the PASPortal 
window will open when the GLX is connected to the computer. In the 
PASPortal window, click Launch DataStudio.

• If the PASPortal window or DataStudio does not automatically launch, start 
DataStudio via the icon on your computer’s desktop. When you see the 
“Welcome to DataStudio” window, click Create Experiment.

1Supported operating systems include 
Windows 98/2000/ME/XP, Mac OS 9, 
and Mac OS X.

2For file transfer and firmware updates, 
the GLX Simulator can be used instead 
of DataStudio. See “GLX Simulator” on 
page 103.

������
����

3A new file is one that has been saved 
since the last time the GLX was con-
nected to a computer.

Desktop icon
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Transferring Files

GLX File Manager

If DataStudio detects a GLX with new files saved on it, it automatically opens the 
GLX File Manager. 

You can also manually open the GLX File Manager with these steps.

1. Click the Setup button (in DataStudio’s main button bar). The Experiment 
Setup window will open.

2. In the Setup window, click the Manage Files icon. The GLX File Manager 
will open.

The left side of the GLX File Manager window shows the files that are saved in 
the RAM and Flash folders of the GLX. Click a file or folder to select it; the 
selected file or folder is highlighted in blue.

 The right side of the window contains five buttons, described below.

Open The Open button is available when a file is selected. When you click 
Open, the selected file will be copied from the GLX. DataStudio will translate it 
into a DataStudio file and open it. The original file will remain on the GLX.

Download Click the Download button to copy a file or files from the GLX to 
your computer.

If a GLX folder is selected, the Download button is labeled “Download All.” 
When you click the button, DataStudio will prompt you to select a folder on your 
computer to copy the GLX files into. The files on your computer will have the 
same name as the files on the GLX. The original files will remain on the GLX.

When a single GLX file is selected, the Download button is labeled “Download 
to Computer.” Click the button to download the file. DataStudio will prompt you 
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to select a folder on your computer and a file name for the downloaded copy of 
the file.

GLX files saved on your computer’s disk have the file extension .glx. They can 
be opened with DataStudio or copied to another GLX.

Delete Click the Delete button to delete a file or files from the GLX.

When a GLX folder is selected, the Delete button is labeled “Delete All.” Click 
the button to delete all of the files in the selected folder. 

When a single GLX file is selected, click the Delete button to delete the file.

Before deleting a file from the GLX, DataStudio will prompt you for confirma-
tion. Click “Yes” to proceed with the deletion, or click “No” to cancel the dele-
tion.

Upload To copy a GLX file from your computer to the GLX, first select the 
GLX folder that you would like the file to be saved in, then click the Upload but-
ton. DataStudio will prompt you select a file on your computer’s disk to be 
uploaded. 

The file to be uploaded must be a GLX file with a .glx extension. GLX files can 
be created by a GLX or by the GLX Simulator.

Done Click Done to close the GLX File Manager.

To Transfer Files Between GLXs Through DataStudio

You can also transfer files directly from one GLX to another; see “GLX-to-
GLX File Transfer” on page 84.

1. Connect the first GLX to a computer, start DataStudio, and open the GLX 
File Manager.

2. Select the GLX file to be copied and click the Download button to save the 
file to your computer’s disk. 

3. Disconnect the first GLX and connect the other GLX. 

4. Click the Upload button and select the file that you have just saved on the 
computer. The file will be copied to the connected GLX.

To Open a GLX File in DataStudio

To open a file that has been copied from the GLX to your computer, click the File 
menu in DataStudio and select Open Activity. In the File Open dialog box, select 
the file to be opened. DataStudio will translate the file into a DataStudio file and 
open it.

How GLX Files Translate to DataStudio Files

The GLX and DataStudio use different file formats. DataStudio can open GLX 
files, but the GLX cannot open DataStudio files. When you open a GLX file in 

-�������������
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DataStudio, the file is translated into a DataStudio file. Most components of the 
GLX file, listed below, appear in the new DataStudio file.

• Numeric data sets

• Data properties of data sets and measurements

• Sensor settings, such as calibrations and samples rates

• Timers

• Sampling mode

• Data displays

• Calculations

• Notes pages, which appear in DataStudio as a Workbook display

To comply with the DataStudio file format, certain components of the original 
GLX file may be altered, including the following.

• Text data sets. DataStudio 1.9.5 does not support text data sets. They are 
replaced in the DataStudio file with a numeric data set containing zeros in 
place of the text.

• Tools in the Graph and Table displays, such as linear fit and statistics.

• Graph scale settings.

• Sound Output settings.

Once a file has been opened in DataStudio (either directly from the GLX, or after 
having been downloaded to the computer’s disk) it is a DataStudio file. If you 
save it, it will be saved with a .ds extension.

Collecting Data with DataStudio

When the GLX is connected to a computer running DataStudio, sensor setup and 
data collection are controlled from DataStudio. The GLX operates in DataStudio 
Mode, acting only as an interface routing data from the sensors to the computer.

While in DataStudio-connected mode, the GLX screen reads “DataStudio Con-
nected.” In this mode, only two of the GLX keys are functional:  and . 
You can press  on the GLX instead of clicking the Start or Stop buttons in 
DataStudio. If DataStudio is in Manual Sampling mode,  on the GLX has the 
same function as the Keep button in DataStudio.

For complete instructions on using DataStudio, click DataStudio’s Help menu.

GLX Sound and Sound Level Sensors in DataStudio

To use the GLX’s microphone as a sound sensor or sound level sensor in 
DataStudio, you must manually select it in the Experiment Setup window. Click 
the Setup button in DataStudio to open the Experiment Setup window. In that 
window, click the button labeled “Add Sensor or Instrument” and select GLX 
Sound Level Sensor or GLX Sound Sensor from the PASPORT sensors list.
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GLX Simulator
When you install DataStudio version 1.9.5 (or later) on a Windows computer, a 
second piece of software, the GLX Simulator, is also installed. To start the simu-
lator, run the executable file4 XplorerGLX.exe.

The GLX Simulator behaves like a real GLX. To “press” keys on the Simulator 
keypad, click them with the computer’s mouse, or press the equivalent key on the 
computer’s keyboard. (See page 90 for keyboard equivalents.)

Up to four PASPORT sensors connected to your computer through any type of 
PASPORT interface will be treated by the Simulator like sensors connected to a 
real GLX. 

The GLX Simulator

Virtual Motion Sensor

If you are using the GLX Simulator without real sensors, you can select the Vir-
tual Motion Sensor to simulate a sensor. The Simulator will behave like a real 
GLX connected to a Motion Sensor measuring an object oscillating with a fre-
quency of about 0.6 Hz and with an amplitude of 0.8 m.

4The GLX Simulator is usually installed 
in
c:\Program Files\DataStudio\

The Simulator requires Windows 2000 
or Windows XP
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Simulated data from the Virtual Motion Sensor

Screen Capture

Click the Copy Screen button to copy an image of the Simulator’s screen to the 
computer’s clipboard. The image can then be pasted into another application 
(such as a word processor) by selecting Paste from that application’s Edit menu.

Screen Mirroring

When a real GLX is connected to the computer, the Mirror GLX Screen option 
appears in the Simulator. Select this option to make the screen of the real GLX 
appear in the Simulator. The Copy Screen button will capture an image of the 
real GLX’s screen.

File Transfer between Simulator and GLX

Files that you have created or modified in the Simulator can be saved and trans-
ferred to a real GLX with the following procedure.

1. In the Simulator, open the Data Files screen (see page page 78).

2. Click  to open the Files menu.

3. Click Copy to Disk. The Simulator will prompt you to select a folder and 
name for the file to be saved.

4. Transfer the saved file to the GLX through DataStudio (see page 100) or a 
USB storage device (see page 83).

You can also open a GLX file in the Simulator. In the Data Files screen of the 
Simulator, click  to open the Files menu and click Copy from Disk.
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Part 2:

Sample Activit ies

The following pages contain step-by-step instructions for science 
activities and experiments that can be done with the GLX, its 
included temperature and voltage probes, and commonly available 
supplies; no PASPORT sensors are required.
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Act iv i ty 1: Calor imetry

Background

In this experiment, you will add a hot piece of metal to room-temperature water 
and measure the temperature change of the water. How does doubling the mass 
of the added metal affect the temperature change?

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Equipment Set-Up

1. Fill a Styrofoam cup with hot water.

2. Tie a string to each mass, and lower all three masses into the hot water. Let 
the masses warm up for about 10 minutes.

3. Label two other cups “Cup 1” and “Cup 2.” Put 250 ml of room-temperature 
water into each cup.

4. Put one temperature probe in each cup of room-temperature water. Use a 
paperclip to secure each probe to the rim of the cup so that the end of the 
probe is about midway between the bottom and the surface of the water. 

Equipment Quantity

Xplorer GLX 1

Fast-response Temperature 
Probes

2

20 g Brass Masses 3

Styrofoam Cups 3

String 1 m

Hot Water (50 to 70 °C) 500 ml

Room-temperature Water 500 ml

�� �����
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GLX Set-Up

1. Connect the temperature probes.1

a) Connect the probe in Cup 1 to one of the temperature ports on the left 

side of the GLX.

b) Connect the probe in Cup 2 to the other temperature port.

c) If there are other sensors connected to the GLX, remove them.

2. Set up the Graph to display both temperatures versus time.

a) Press  to return to the Home Screen; press  to open the Graph.

b) The Graph will automatically be set up for the first temperature probe. 

Press  to open the Graphs menu, press  to select Two Measure-

ments mode. The second temperature probe will be added to the Graph.

Data Collection

1. Press  to start data collection.

2. Remove the masses from the hot water. Lower one mass into Cup 1; lower 
two masses into Cup 2.

3. Gently stir the water in both cups.

4. Press  to automatically scale the Graph.

5. After both temperature measurements have stabilized, press  to stop data 
collection.

Analysis

1. Use the Delta Tool to find the temperature change in Cup 1.

a) Press  to open the Tools menu; press  to turn on the Delta 

Tool.

b) Press the up arrow to move one of the cursors to the first data point.

c) Hold  and press  to swap control to the other cursor; press the 

down arrow key to move that cursor to the last data point.

The Delta Tool should now show the changes in temperature and time 

from the first to the last data point.

Cup 1 temperature change = _____________________

1Optional: after connecting the probes, 
perform the alignment calibration 
described on page 77.

Graph in Two Measurements mode
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2. Create a new graph page showing only the temperature in Cup 2 versus 
time.

a) Press  to open the Graphs menu; press  to select New Graph 

Page.

b) On the new graph page, press  twice to open the data source menu. 

c) Press the down arrow key to highlight Temperature2 and press .

3. Use the Delta Tool to find the temperature change in Cup 2.

a) Press  to open the Tools menu; press  to turn on the Delta 

Tool.

b) Press the up arrow to move one of the cursors to the first data point.

c) Hold  and press  to swap control to the other cursor; press the 

down arrow key to move that cursor to the last data point.

The Delta Tool should now show the changes in temperature and time 

from the first to the last data point.

Cup 2 temperature change = _____________________

4. How does the temperature change in Cup 2 compare to the temperature 
change in Cup 1?

5. If you repeated this experiment with three masses in Cup 2, what do you 
think the temperature change of Cup 2 compared to Cup 1 would be?

6. Why did this experiment call for Styrofoam rather than glass contain-
ers?

�� 
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Activ i ty 2: Melt ing Point Depression

Background 

How does the addition of salt affect the melting point of a solution? In this exper-
iment, you will measure the temperature over time of frozen salt water and pure 
water as they melt. From the recorded data, you will identify and compare the 
melting points of both liquids.

Pre-lab: Prepare Frozen Solutions

Prepare the frozen solutions at least one day in advance.

1. Make a solution of 1 g NaCl in 100 ml of deionized water. Add enough to a 
test tube to fill it to a depth of about 1 cm.

2. Add the same amount of deionized water to a second identical test tube.

3. Place a fast-response temperature probe in each test tube. The ends of the 
probes should be immersed. Use tape to secure the probes in place.

4. Label both test tubes and label the connectors of both probes for easier iden-
tification.

5. Place both test tubes (along with the probes) in a freezer.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Equipment Quantity

Xplorer GLX 1

Fast-response Temperature 
Probes

2

Test Tubes 2

Test Tube Rack 1

Deionized Water 110 mL

NaCl 1 g
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Procedure

1. Remove the frozen solutions from the freezer.

2. Connect the temperature probes.

a) Connect the temperature probe measuring the pure water ice to Temper-

ature Port 1 on the left side of the GLX.

b) Connect the other probe to Temperature Port 2.

3. Press  to start data collection.

4. Set up the Graph to display both temperature measurements.

a) Press  to return to the Home Screen; press  to open the Graph.

b) Press  to open the Graphs menu; press  to select Two Measure-

ments mode.

c) Press  to automatically scale the Graph.

5. Continue data collection until both solutions have reached 5 °C. Press 
 to stop data collection.

Analysis

Describe the temperature versus time plots of both solutions. How are they simi-
lar? How do they differ? Which solution melts at a lower temperature?

Graph in Two Measurements mode 
displaying both temperatures

��
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Act iv i ty 3: Heat Transfer by Radiat ion

Background

You may have observed that dark objects heat up faster than light-colored objects 
when exposed to sunlight, but how does the color of an object affect its rate of 
cooling? In this experiment you, will record the temperature of two water-filled 
cans as they cool. One can is painted black, the other can is unpainted. Which can 
do you think will cool faster?

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Equipment Set-Up

1. Place a fast-response temperature sensor in each can. Secure the probes with 
tape.

2. Prepare hot water (50 to 70 °C), but don’t fill the cans yet.

GLX Set-Up

1. Connect the temperature probes.

a) Connect the probe measuring the black can to Temperature Port 1 on the 

left side of the GLX.

b) Connect the probe measuring the unpainted can to Temperature Port 2.

Equipment Quantity

Xplorer GLX 1

Fast-response Temperature 
Probes

2

Aluminum Can, Painted Black 1

Aluminum Can, Unpainted1 1

Hot Water (50 to 70 °C) 500 mL

Tongs or Mitt (for handling hot 
cans)

1

1Use empty beverage containers or 
PASCO part TD-8570A, which includes 
one black can and one unpainted can.
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2. Set the sampling periods of both probes to 10 seconds.

a) Press  to return to the Home Screen; press  to open the Sensors 

screen.

b) Observe the top part of the screen and note which sensor (“Temperature 

Sensor” or “Temperature Sensor 2”) is selected.

c) With Sample Rate Unit highlighted, press  to open the menu; press 

 to select seconds.

Select seconds from the Sample Rate Unit menu

d) Press the down arrow to highlight Sample Rate; press  until the 

value is set to 10 seconds.

e) Press the left or right arrow to select the other sensor.

f) Repeat steps c and d to set the sampling rate for the newly selected sen-

sor to 10 seconds.

3. Set up the Graph to display both temperatures.

a) Press  to return to the Home Screen; press  to open the Graph. 

The Graph is automatically set up to display data from the first tempera-

ture probe.

b) Press  to open the Graphs menu; press  to select Two Measure-

ments mode. The second temperature measurement will be added to the 

Graph.

Data Collection

1. Fill both cans with equal amounts of hot water.

2. Press  to start data collection.

3. Press  to automatically scale the Graph.

4. Gently swirl the cans as data will be collected for about 15 minutes.

5. Press  to stop data collection.

Analysis

Which can cooled faster? Why?
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Set the Sample Rate to 10 seconds
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Graph prepared to display both tem-
perature measurements
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Act iv i ty 4: Newton’s Law of Cool ing

Background

Newton’s Law of Cooling states that the rate of temperature change of a body is 
proportional to its relative temperature, r, or the body’s temperature minus the 
temperature of the surroundings. Mathematically, Newton’s Law of Cooling can 
be written:

(eq. 1)

where dT/dt is the rate of temperature change and k is a constant greater than 0.

Another way to write Newton’s Law of Cooling is

(eq. 2)

where r is the relative temperature at time t, and r0 is the relative temperature at 
t = 0. A graph of Equation 2 is shown to the right.

In this experiment, you will record and graph the temperature of a hot object (a 
test tube full of sand) as it cools. You will then compare the experimental data 
with the theoretical graph.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Equipment Quantity

Xplorer GLX 1

Fast-response Temperature 
Probes

2

Styrofoam Cups 2

Test Tube 1

Tape 10 cm

Sand 100 g

Hot Water (50 to 70 °C) 500 mL

dt
dT
------ kr–=
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Procedure

Equipment Set-Up

1. Place the end of a fast-response temperature probe in the test tube, then fill 
the test tube about one-third full of sand, as pictured to the right. The probe 
should be embedded in the sand. Use tape to secure the probe.

2. Partially fill a cup with hot water (50 to 70 °C) and immerse the sand-filled 
portion of the test tube. Let the sand warm up for a few minutes while you 
set up the GLX.

3. Tape a second temperature probe to the inside wall of an empty cup. (This 
probe will be used to measure the temperature of the surrounding air.)

GLX Set-Up

1. Connect the first temperature probe to the GLX.

a) Connect the temperature probe that is in the test tube to Temperature 

Port 1 on the left side of the GLX.

b) If there are other sensors connected to the GLX, remove them.

2. Set the sampling rate to 30 seconds between samples.

a) Press  to go to the Home Screen.

b) Press  to open the Sensors screen.

c) Use the up and down arrow keys to highlight Sample Rate Unit. Press 

, then press  to select “seconds.”

d) Press the down arrow key to highlight Sample Rate. Press  or  to 

set the time between samples to 30 seconds.

3. Rename the measurement.

a) In the Sensors screen, use the arrow keys to highlight the measurement 

named “Temperature”

b) Press  to open the Data Properties box.

c) Use the up and down arrow keys to highlight Measurement Name and 

press  to make it editable.

d) Type “object temp” and press .1 

�
���

�
��

�������%&'

���
��
����

����

�

�

Immerse the sand-filled portion of 
the test tube in hot water

Set the sampling rate to 30 s 
between samples
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1To enter text, use multipress text entry 
(see page 90) or an attached USB key-
board (see page 90).
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e) Press  to accept the changes and return to the Sensors screen.

4. Connect the second sensor to the GLX.

Connect the temperature probe that will measure the air temperature to 

Temperature Port 2 of the GLX. You will see the new icon appear in the 

upper part of the Sensors screen with a box around it. 

5. Set the sample rate of the second sensor and rename the measurement.

a) Repeat step 2 to set the sampling rate of the second sensor to 30 seconds 

between samples.

b) Repeat step 3 to set the Measurement Name to “air temp.”

6. Set up the Graph display to plot Object Temperature and Air Tempera-
ture versus Time.

a) Press  to return to the Home Screen.

b) Press  to open the Graph display. The display will be automatically 

set up to graph object temp versus Time. 

c) Press  to open the Graphs menu, and press  to select Two Mea-

surements mode. Air temp will be added to the Graph.

Data Collection

1. Remove the test tube from the hot water and dry it thoroughly with a paper 
towel.

2. Place the test tube in the empty cup so that the sand is several centimeters 
away from the air temperature probe.

3. Press  to start data collection.

4. Press  to automatically scale the Graph.

5. After the sand has cooled to about 30 °C, press  to stop data collection.
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Graph prepared to display object 
temp and air temp vs. Time
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Place the test tube in the empty 
cup so that the sand is several 

centimeters away from the air tem-
perature probe
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Analysis

Observe the graph of Object Temperature versus time and Air Temperature ver-
sus Time. If the experiment were allowed to run indefinitely, what would the 
relationship between object and air temperature eventually be?

1. Create a calculation for relative temperature.

a) Press  to return to the Home Screen; press  to open the Calcu-

lator.

b) If you see the Num Lock symbol  in the lower right corner of the 

screen, press  to open the Edit menu, then press  to turn Num 

Lock off.

c) Enter:

r = [object temp (°C)] - [air temp (°C)] 

Use multipress text entry to type “r”. 

To insert [object temp (°C)] and [air temp (°C)] press  to open the 

[Data] menu, select the desired data from the menu, and select units of 

°C.

d) Remember to press  to complete the calculation.

2. Make a new graph of r versus t.

a) Press  to return to the Home Screen; press  to open the Graph.

b) Press  to open the Graphs menu; press  to select New Graph 

Page.

c) Press  twice to open the data source menu. Select r from the menu.

3. Does the graph of Relative Temperature versus Time appear to agree 
with Equation 2?_______________

4. What is the initial relative temperature at Time = 0?

To find the initial relative temperature, press the up arrow key to move 

the Data Cursor to the first data point.

Initial temperature, r0 = __________

In order to find the value of the constant k for this cooling curve, you can use 
another expression of Newton’s Law of Cooling, derived from Equation 2:

(eq. 3)

On a graph of ln(r/r0) versus t, the slope will equal −k.

��

Open the [Data] menu and select 
the desired data to insert into the 

calculation
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5. Create a calculation for ln(r/r0)

a) Press  to return to the Home Screen; press  to open the Calcu-

lator.

b) On a blank line, enter:

ln(r/r0) 

c) To insert the ln() function, press  to open the Functions menu, use 

the arrow keys to highlight ln(), and press .

d) The Calculator will prompt you on the next line to enter the value of r0. 

Type the initial relative temperature and press .

6. Make a graph of ln(r/r0) versus t.

a) Press  to return to the Home Screen; press  to open the Graph 

display.

b) Press  to open the Graphs menu; press  to select New Graph 

Page.

c) Press  twice to highlight the data source menu. From the menu 

select ln(r/r0).

7. Apply a linear fit and find the value of k.

a) Press  to open the Tools menu; press  to select Linear Fit.

b) Press the down arrow key to make the dashed box surround the entire 

data set.

c) The slope of the best-fit line equals k.

k = _________________ (include units)

Now that you have experimental values for the constants r0 and k, you can substi-
tute them into Equation 2 and compare that model to the collected data.

8. Enter Equation 2 into the Calculator using your experimental values of 
r0 and k.

a) Press  to return to the Home Screen; press  to open the Calcu-

lator.

b) On a blank line, enter:

r model = r0 * e^(-k*t) 
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c) To insert the function e^, press  to open the Functions menu, use 

the arrow keys to highlight e^, and press .

Also open the Functions menu to select and insert the pair of parenthe-

ses.

d) The Calculator will prompt you to enter the values of k and t. (It does 

not prompt you for r0 because you entered that constant in step 5.)

e) Enter the value of k that you found in step 7 and press .

f) Time is the variable that will be plotted on the horizontal axis, so do not 

enter a value for t.

9. Compare collected relative temperature data with the modeled data.

a) Press  to return to the Home Screen; press  to open the Graph 

display.

b) Press  to open the Graphs menu; press  to select New Graph 

Page.

c) Press  twice to highlight the data source menu. From the menu, 

select r (the collected data).

d) Press  to open the Graphs menu; press  to select Two Measure-

ments mode.

e) Press  to turn on the highlight, then press the left arrow key repeat-

edly until the second data source (on the right side of the Graph) is high-

lighted.

f) Press  to open the data source menu and select r model.

10. Does the modeled equation agree with the collected data? If it deviates, 
can you explain why?
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Act iv i ty 5: Microcl imate Temperature
Variat ion

Background

In this activity, you will measure and record the air temperature at different out-
door locations within a small area to investigate how ground cover and nearby 
objects affect air temperature.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Preparation

Sketch a map of the area you will be investigating. Mark several locations on the 
map and assign each a different short name. For each location, note the type of 
ground cover (concrete, grass, bare earth, etc.) and nearby objects, such as build-
ings or trees.

GLX Set-Up

1. Connect a temperature probe.

a) Connect a fast-response temperature probe to one of the temperature 

ports on the left side of the GLX.

b) If there are other sensors connected to the GLX, remove them.

2. Put the GLX into Manual Sampling mode.

a) Press  to return to the Home Screen; press  to open the Sensors 

screen.

b) Press  to open the Mode menu.

Equipment Quantity

Xplorer GLX 1

Fast-response Temperature 
Probe

1

�� �����

��

��

��

��

��



122 M i c r o c l i m a t e  T e m p e r a t u r e  V a r i a t i o n
c) Press the down arrow key to highlight Manual and press .

d) The Data Properties window will open with the Measurement Name set 

to “Keyboard Data.” Press  to accept this setting.

3. Press  to return to the Home Screen; press  to open the Table. 
The Table will be automatically set up to display Temperature and Key-
board Data.

Data Collection

1. Press . The GLX is now measuring temperature, but not recording it.

2. Take the GLX to one of the locations marked on your map.

3. Hold the probe about 1 meter above the ground, but do not touch the end of 
the probe. Shield the probe from direct sunlight. Wait about 15 seconds to 
allow the probe to equilibrate.

4. Press  to record a single temperature measurement.

5. The GLX will prompt you for Keyboard Data. Press  to turn off Num 
Lock. Type the location name (press each key repeatedly to cycle through 
different letters). 

Press . When the GLX asks if you would like to treat the data as text, 
press  for OK.

6. Move to another location. Hold the probe 1 meter above the ground and out 
of direct sunlight. Wait 15 seconds. Press  to record a measurement. 
When the GLX prompts you, type the location name and press .

7. Repeat step 6 for all of the other locations marked on your map.

8. After you have recorded the temperature at every location, press  to 
complete data collection.

Analysis

1. Copy the recorded temperatures from the GLX to your map.

2. Based on your data, describe how different types of ground cover and nearby 
objects appear to affect the air temperature.
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Table prepared to display Tempera-
ture and Keyboard Data
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Act iv i ty 6: Voltage versus Resistance

Background

In this experiment, you will construct the circuit pictured to the right and measure 
the voltage (relative to the negative terminal of the battery) at points A through F. 
For each point in the circuit, the GLX will record the measured voltage (V) and 
the total resistance across which the voltage was measured (r).

Sketch a prediction of the graph of V versus r. Explain your prediction in terms of 
what you know about

• how current flows through the circuit;

• the relationship between voltage, current, and resistance; and

• the total resistance of two or more resistors in series.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Equipment Set-Up

1. Using the battery, battery holder, resistors, and alligator clip leads, construct 
the circuit pictured on the previous page.

Equipment Quantity

Xplorer GLX 1

Voltage Probe 1

Resistors, 1000 Ω 5

Battery and Battery Holder 
(“AA,” “C,” “D,” or similar)

1

Short Alligator Clip Leads 6

*
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2. Lay out the circuit on a piece of paper so you can label the parts of the cir-
cuit. Label points A through F and the positive and negative terminals of the 
battery.

GLX Set-Up

1. Connect the voltage probe to the GLX.

a) Connect the voltage probe to the voltage port on the left side of the 

GLX.

b) If there are other sensors connected to the GLX, remove them.

2. Configure the GLX for manual sampling.

a) Press  to return to the Home Screen; press  to open the Sensors 

screen.

b) Press  to open the Mode menu; press  to select Manual.

The Data Properties dialog box for the manually entered resistance data 

will open. 

c) With Measurement Name highlighted, press ; type “r” and press 

.

d) Press the down arrow key to highlight Measurement Unit. Press , 

type “ohm”, and press .

e) Press  to approve these data properties and close the Data Proper-

ties window.

3. Prepare the Graph to plot voltage versus resistance.

a) Press  to return to the Home Screen; press  to open the Graph.

The Graph will be automatically set up for voltage versus time. In the 

next step, you will select resistance (instead of time) for the horizontal 

axis.

b) Press  to turn on the highlight; press the down arrow key to high-

light “Time.”

c) Press  to open the data source menu.

d) In the data source menu, use the arrow keys to highlight “r” and press 

.
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Graph prepared to plot V vs. r

Data Collection

1. Press . The GLX is now measuring voltage, but it is not recording data.

2. Connect the black lead of the voltage probe to the negative terminal of the 
battery.

3. Place the red lead of the probe in contact with the circuit at point A.

4. Press  to record a single voltage measurement. 

5. The GLX will prompt you to enter r, the total resistance across which the 
voltage is measured. (For point A, r = 0.) Type the value of r and press 

.

6. Repeat steps 3, 4, and 5 for points A through F.

7. When you are finished recording data, press .

Analysis

1. Press  to automatically scale the Graph.

2. Does your data appear to agree with your prediction?

3. Apply a linear fit to the graph and find the slope.

a) Press  to open the Tools menu; press  to select Linear Fit.

b) What is the slope (including units) of the best-fit line?

slope = __________ 

c) What physical quantity does the slope represent?
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Act iv i ty 7: Induced Electromot ive Force

Background

When a permanent magnet passes through a coil, the changing magnetic flux 
induces and electromotive force (EMF) or voltage in the coil. According to Fara-
day’s Law of Induction:

where ε is the induced EMF, N is the number of turns in the coil, and  is 
the rate of change of magnetic flux through the coil.

In this activity, you will drop a magnet through a coil while the GLX records and 
graphs the induced EMF versus Time. The area under the under the curve repre-
sents the total change in flux.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Equipment Set-Up

1. Clamp or mount the coil so that the magnet can be dropped through it.

2. Place something soft under the coil to prevent the magnet from breaking.

3. Connect the voltage probe to the coil so that it will measure the voltage 
across the coil.

Equipment Quantity

Xplorer GLX 1

Voltage Probe 1

Coil1 1

Bar Magnet 1

1Use a coil with a few hundred turns, 
such as the one included with PASCO 
part CI-6512.

ε N
dφ
dt
------–=

dφ dt⁄
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GLX Set-Up

1. Connect the voltage probe to the GLX.

a) Connect the voltage probe to the voltage port on the left side of the 

GLX.

b) If there are other sensors connected to the GLX, remove them.

2. Set the sampling rate to 200 Hz.

a) Press  to return to the Home Screen.

b) Press  to open the Sensors screen.

c) Press the down arrow key to highlight Sample Rate.

d) Press  repeatedly to set the Sample Rate to 200 Hz.

3. Open the Graph display.

a) Press  to return to the Home Screen.

b) Press  to open the Graph display. The display will be automatically 

set up to graph Voltage versus Time.

Data Collection

1. Hold the magnet about 2 cm above the coil.

2. Press ; drop the magnet through the coil; press  again.

Analysis

1. Scale the Graph.

a) Press  to automatically scale the Graph.

b) Press  to enter Scale mode, press  again to enter Move mode. 

Use the left and right arrow keys in both modes to zoom in on the posi-

tive and negative peaks.

See page 16 for detailed instructions on using Move and Scale modes.

2. Find the area under the first peak.

a) Press  to open the Tools menu; press  to select the Area Tool.
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b) Use the left and right arrow keys to move the right side of the dashed 

box to the right side of the first peak.

c) Hold  and press  to swap the cursor to the other side of the 

dashed box.

d) Use the left and right arrow keys to move the left side of the dashed box 

to the left side of the first peak.

See page 20 for detailed instructions on using the Area Tool.

Area under the first peak = _________________ (include sign and 

units)

3. Find the area under the second peak.

Repeat step 2 to position the dashed box around the second peak.

Area under the second peak = _________________

4. Compare the incoming flux (area under the first peak) to the outgoing 
flux (area under the second peak).

5. Why is the outgoing peak higher than the incoming peak?

6. Why are the peaks opposite in direction?
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Act iv i ty 8: Capaci tor  Discharge

Background

In the circuit pictured above, the rate at which the voltage, V, decreases is directly 
proportional to the voltage. Mathematically, this can be written:

(eq. 1)

where dV/dt is the rate of voltage change, and τ is a constant greater than 0 
known as the Capacitive Time Constant. The negative sign indicates that the 
voltage decreases over time.

Equation 1 can be rewritten:

(eq. 2)

where V is the voltage at any given time, t; and V0 is the voltage at t = 0.

In this experiment, you will create a circuit like the one in the diagram. The GLX 
will measure and graph voltage over time as the capacitor discharges. From the 
collected data, you will determine the capacitive time constant, τ, of your circuit.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

Equipment1 Quantity

Xplorer GLX 1

Voltage Probe 1

Capacitor (between 0.015 
and 1 F)

1

Resistor (between 100 and 
1000 Ω)

1

Battery and battery holder 
(“AA,” “C,” “D,” or similar)

1

Alligator Clip Leads 4

1Use separate electronic components or 
the PASCO EM-8678 Charge/Discharge 
board, which includes a capacitor, resis-
tors, and battery holder.

� ��

dV
dt
------- τV–=

ln
V
V0
------ τt–=
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4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

Equipment Set-Up

1. Create the circuit pictured above. Note that the negative terminal of the bat-
tery is connected, but the positive terminal is not. The voltage probe is con-
nected so that it will measure the voltage across the capacitor.

2. Record your values of capacitance and resistance. (Measure them directly if 
you have capacitance and resistance meters, or record their nominal values.)

C = __________________

R = __________________

GLX Set-Up

1. Connect the voltage probe to the GLX.

a) Connect the voltage probe to the voltage port on the left side of the 

GLX.

b) If there are other sensors connected, remove them.

2. Set up the Graph to plot Voltage versus Time.

Press  to return to the Home Screen; press  to open the Graph. 

The display will be automatically set up to graph Voltage versus Time.

Data Collection

1. Charge the capacitor by temporarily connecting the positive terminal of the 
battery to the positive terminal of the capacitor. Keep the connection for 
about 5 seconds before proceeding to the next step. (Do not leave this con-
nection in place for too long, as it will drain the battery.)

2. Disconnect the positive terminal of the battery and immediately press  to 
start data collection.

3. Press  to automatically scale the Graph.

4. After the voltage has dropped below 0.1 V, press  to stop data collection.
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Analysis

From Equation 2, it is apparent that, on a graph of ln(V⁄V0) versus t, the slope 
would equal −τ. In this analysis, you will find the value of the constant V0, calcu-
late ln(V⁄V0) for every recorded value of V, create a graph of ln(V⁄V0) versus 
Time, and find its slope.

1. What was the voltage recorded at t = 0?

Press the up arrow key to move the Data Cursor to the first recorded point. 

The coordinates of the point are displayed at the top of the Graph.

V0 = ________________

2. Create a calculation for ln(V⁄V0).

a) Press  to return to the Home Screen; press  to open the Calcu-

lator.

b) On a blank line, enter2

ln([Voltage (V)]/v0) 

To insert the ln() function, press  to open the Functions menu, used 

the arrow keys to highlight ln(), and press .

To insert [Voltage (V)], press  to open the [Data] menu and select 

Voltage.

To type the letter v on the GLX keypad using multipress text input, turn 

off Num Lock3 and press  several times until the letter v appears.

c) The Calculator will prompt you on the next line to enter the value of v0. 

Type the initial voltage and press .

+
�
������� �������
���

��

2For more information on multipress text 
entry, see page 90.
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3If Num Lock is on (as indicated by the 
icon  in the lower right corner of the 
screen), press  then press  to 
open the Edit menu and turn off Num 
Lock.

For more information on multipress text 
entry, see page 90.
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3. Make a graph of ln(V⁄V0) versus t.

a) Press  to return to the Home Screen; press  to open the Graph 

display.

b) Press  to open the Graphs menu; press  to select New Graph 

Page.

c) Press  twice to highlight the data source menu. Select ln(v/v0) from 

the menu 

4. Apply a linear fit and find the value of τ.

a) Press  to open the Tools menu; press  to select Linear Fit.

b) Press the down arrow key to make the dashed box surround the entire 

data set.

c) The slope of the best-fit line equals τ.

τ = _________________ (include units)

5. (Optional) Repeat the experiment with different resistors. Make a graph 
of R versus τ. What is the relationship between time constant and resis-
tance?

6. (Optional) Repeat the experiment with different capacitors. Make a 
graph of C versus τ. What is the relationship between time constant and 
capacitance?
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Act iv i ty 9: Construct ive and Destruct ive
Inter ference

Background

When two sound waves with identical frequencies and amplitudes combine, they 
may interfere constructively or destructively. When constructive interference 
occurs, the resulting tone is louder than either of the individual tones. When 
interference is destructive, the combined tone is less loud than the individual 
tones. For two waves of equal frequency, the type of interference depends on the 
phase relationship between the waves.

In this activity, you will use the GLX to generate two tones at 440 Hz while vary-
ing the phase of one.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

1. Press  to return to the Home Screen.

2. Use the arrow keys to highlight the Output icon and press .

3. If the Speaker Configuration is not already set to Mono, use the arrow keys 
to highlight Speaker Configuration and press  to set it to Mono.

4. Use the arrow keys to highlight the Phase of the Right Output Channel (as 
pictured to the right).

5. Press  to turn on the Right Output Channel.

6. Press  and  to vary the phase of the Right Output wave. As you vary 
the phase of the wave between -360° and +360°, how does the sound 
change?

7. Set the phase of the Right Output wave back to 0°.
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8. Press  to turn on the Left Output Channel. How does the addition of the 
Left Output wave affect the sound that you hear? 

9. Press  and  to vary the phase of the Right Output wave again. As you 
vary the phase of the Right Output wave between -360° and +360°, how 
does the sound of the combined waves change?

10. Listen to the sound. At what values of phase does maximum destructive 
interference occur?

11. Press the left arrow key to highlight the Phase of the Left Output Channel. 
Press  to set the phase to 30°.

12. Press the right arrow key to highlight the Phase of the Right Output Channel 
again. While listening to the combined tone, vary the phase of the Right Out-
put wave between -360° and +360°.

13. With the Left Channel phase set at 30°, at what values of phase (for the 
Right Channel) does maximum destructive interference occur?
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Act iv i ty 10: Beat Frequency
Background

When two sound waves with slightly different frequencies combine, the pattern 
of interference produced is known as beats. The rate at which the beats occur is 
the beat frequency.

In this activity, the GLX will generate two tones whose frequencies differ by ∆ f, 
and you will hear the resulting beats. By varying the frequency of one of the 
tones, you will discover the relationship between ∆ f and beat frequency.

Before You Begin

Start a new experiment on the GLX.

1. Press  to go to the Home Screen.

2. Use the arrow keys to highlight the Data Files icon and press  to open 
the Data Files screen.

3. Press  to open the Files menu and press  to select New File.

4. When the GLX asks if you would like to save the previous file, press  
to save or  not to save.

Procedure

GLX Set-Up

1. Press  to return to the Home Screen.

2. Use the arrow keys to highlight the Output icon and press .

3. If the Speaker Configuration is not already set to Mono, use the arrow keys 
to highlight Speaker Configuration and press  to set it to Mono.

4. Use the arrow keys to highlight the Frequency of the Left Output Channel 
(as pictured to the right) and press  to increase the Frequency to 441 Hz.

5. Press  to open the Left Step Size menu. Press the up arrow key to high-
light Step 0.1, then press .
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Data Collection

1. Press  and  to turn on the Left and Right Output Channels. 
Describe what you hear.

2. In the chart on the next page, write the frequencies of the Left and Right 
Output Channels ( f left and f right).

You will use the GLX’s Stopwatch screen to time the beat period. Since it is not 
practical to measure the very short time between two beats, you will time 10 full 
beat cycles and later divide by 10 to calculate the period. Start timing on beat 
“zero” and stop timing on beat “ten,” as illustrated below.

3. Press  to return to the Home Screen; use the arrow keys to highlight 
Stopwatch and press .

4. Count the beats, “zero, one, two, three, …, ten.” Press  on beat “zero” 
to start timing. Press  again on beat “ten” to stop timing.

5. Write the elapsed time of 10 cycles in the chart below.

6. Press  to reset the Stopwatch.

7. Press  to return to the Home Screen; use the arrow keys to highlight Out-
put and press .

8. Use the arrow keys to highlight the Frequency of the Left Output Channel.

9. Press  twice to increase the Frequency by 0.2 Hz.

10. Record the Frequencies of the Left and Right Output Channels in the next 
line of the chart.

11. Repeat steps 3 through 10 until you have written data in 6 lines of the chart.
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12. While viewing the Output Screen, press  and  to turn off both out-
put channels.

Analysis

1. For each line of the chart, calculate and record the frequency difference 
(∆ f = f left − f right) and beat period, Tbeat. (You can do these calculations in 
your head.)

2. Press  to return to the Home Screen; press  to open the Calculator. 
Use the calculator to calculate the beat frequency, f beat, for each line of the 
chart.

3. According to your data, what is the relationship between ∆ f and f beat?

�� ��

Left Channel 
Frequency

f left

Right Channel 
Frequency

f right

Frequency 
Difference

∆ f

Elapsed Time for 
10 Beat Cycles

Beat Period

Tbeat

Beat Frequency

f beat

��

f beat 1 Tbeat⁄=
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Index

A
abs function 51
AC power 6
Analog Adapter 59
and() function 52
Annotation 25
Area Tool 20
Audio notes 25
Audio output 39, 50
Audio Settings 87
Audio temperature indicator, example 52
Automatic display launching 86
Automatic file opening 86
Automatic shut down 8, 85
Autoscale 16
Averaging 56

B
Back light 6, 86
Backup GLX (to USB storage device) 83
Battery

and file storage 94
capacity 95
charging 93
gauge 11
internal disconnection 94
reconditioning 95
replacement 95

Bits per sample (audio recording) 87

C
Calculator 41
Calibration 71

multiple-measurement 73, 77
navigating in dialog box 73
one-point offset 73
one-point slope 72
step-by-step instructions 75
two-point 72

Cell-selective manual sampling 60
Collision Timer 66
Computer

connecting GLX to 7
DataStudio 99
file transfer to 100, 104
GLX Simulator 103
using GLX with 99

Connected lines in Graph 22
Continuous Sampling mode 57
Contrast 6
Coordinates in Graph 16
Copying a file 81
Create Calculation from Linear Fit 22

D
Data annotation 25
Data Cursor 16, 22
Data Files screen 78
Data notes 25
Data Properties 69, 90
Data source menus 89
DataStudio 99
Date 85, 87

Date/Time (in Table) 31
Deep sleep mode 94
Deleting

calculations 50
data runs 16
files 80
Graph pages 25
sensors 59
Table cells 30

Delta Tool 18
Derivative 20
Digital Adapter 67
Digital Input timer 67
Digital output 51, 67
Digits display 37

E
Editing data 34
EE for Exponent settings 70
Engineering notation 70
Equipment included with GLX 4
Excel, export data to 32
Export All Data (as tab-delimited text) 32

F
File transfer

between GLXs 84
to and from computer 100, 104
to and from USB storage device 83

Files 78
copying 81
deleting 80
moving 81
opening 80
renaming 81
saving 80, 81
size limits 82

Firmware update 93
Flash drive (USB)

for file storage 83
for firmware update 93

Flash memory 82
Free Fall Adapter timer 65

G
General Counting timer 66
GLX settings 85
GLX Simulator 103
GLX storage 94
GLX-to-GLX File Transfer 84

Graph display 13
Area Tool 20
Autoscale 16
Delta Tool 18
Derivative 20
Graphs menu 22
Linear Fit 19
pages 24
Scale/Move 16, 17
Scope mode 22
Slope Tool 19
Smart Tool 18
Statistics 19
Swap Cursors 21
Tools menu 17
Trigger 20
Two Graphs mode 24
Two Measurements mode 23
Two Runs mode 24
Zoom Tool 21

Graphing
equations 44
manually entered data 36

greater than operator 52

H
Hardware maintenance 93
Headphones 7, 40
Home Screen 9

I
inrange function 52

K
Keyboard 7, 90

L
Language 86
less than operator 52
limit function 51
Linear Fit 19
Linear Fit Cal 22
Lock Run Selection 31

M
Maintenance 93
Manual sampling 60
Manually entered data 32, 36
Mapping software, export data to 32
Measurements

name 69
unit 69
visibility 57

Memory Gauge 11
Memory types 82
Meter display 38
Mic Input Volume 87
Microphone 58

in DataStudio 102
mod function 51
Mouse 7
Moving a file 81
Multiple-measurement alignment 73, 77
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Multipress text input 90

N
Name of GLX 85
New Page

Graph 24
Notes 53

not() function 52
Note Editor dialog box 27
Notes (data annotation) 25
Notes screen 53
Numeric styles 70

O
On/Off button 6
One-point offset calibration 73, 77
One-point slope calibration 72, 76
Opening a file 80
or() function 52
Oscilloscope emulation 22
Output Device (audio) 87
Output screen 39
Output-control calculations 50
outputfreq function 52
outputstate function 51
outputswitch function 51
outputvolume function 52

P
Page

Graph 24
Notes 53

PASPORT sensors 6
Photogate and Pendulum timer 65
Photogate and Picket Fence timer 64
Photogate Timing 66
Power button 6
Power source 6
Printing 91

Q
Quick Start 5

R
RAM (random-access memory) 82
random function 51
Recording modes 57
Recording Status icons 11
Reduce/Smooth Averaging 56
Relay control 67
Renaming

data run 16
file 81

Resetting 96
Restore (from USB storage device) 83

S
Sample activities 105
Sample rate (audio recording) 87
Sampling modes 57
Sampling rate 56
Saving a file 80, 81
ScienceWorkshop sensors 59, 67
Scientific notation 70, 91
Scope mode 22
Screen contrast 6, 86
Screen mirroring and capture 104
Sensor Auto-Display 86

Sensors
calibration 71
multiple 55
removing 59
sampling rate 56
ScienceWorkshop 59, 67
set-up 55

Sensors screen 55
Settings screen 85
Set-up options for GLX 6
Shut down 7

automatic 8
manual 7
resuming after 8

Signal output 7, 39, 50
Significant figures 70
Sleep between samples 8
Slope Tool 19
Smart Pulley timer 65
Smart Tool 18
Sound level sensor 58

in DataStudio 102
Sound sensor 58

in DataStudio 102
Speaker Configuration

in Audio Settings dialog box 87
in Output Screen 40

Speaker Volume 87
Speakers 7, 40, 87
Spreadsheet, export data to 32
Start condition 20
Startup Action 86
Statistics

in Graph 19
in Table 29

Sticky Start 8
Stop condition 21
Stopwatch 54
Storage of GLX 94
Swap Cursors 21

T
Table display 28

Edit menu 30
editing 34
manual data entry 32
scrolling 29, 35
Statistics menu 29
Tables menu 31

Temperature probe 6
Temperature, GLX operating range 97
Text data 33
Text data notes 53
Text input via keypad 90
Time 85, 87
Time data in Table 31
Time of Flight timer 66
Timing screen 62
Top Bar 11
Trigger 20
Two Graphs mode 24
Two Measurements mode 23
Two Runs mode 24
Two-point calibration 72, 75

U
Update firmware 93
USB flash drive

for file storage 83
for firmware update 93

USB storage device
for file storage 83
for firmware update 93

V
Version 87
Voltage probe 6

Z
Zero |Value| 70
Zero Automatically On Start 57
Zoom Tool 21



 X p l o r e r  G L X  U s e r s ’  G u i d e 143

Shortcut  Summary

These keys and key combinations work from any screen in the 
GLX environment.

Use these shortcuts when working in the Graph Screen.

Start and stop data collection

Backlight  + 

Contrast  + 

Graph  + 

Table  + 

Calculator  + 

Sensors  + 

Home Screen

Next Screen  + 

Previous Screen  + 

Swap Cursors   + 

Toggle Active Data   + 
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5. No copies of the PASCO Product may be produced for any purpose other than those purposes expressly 
permitted in paragraph 2 above.

6. This license does not transfer any right, title, or interest in the PASCO Product to you except as specifically set 
forth herein. You are on notice that PASCO claims protection of this software product under copyright laws. The 
PASCO Product may have been developed by an independent third party software supplier, which holds copyright or 
other proprietary rights to its software product. You may be held responsible by this supplier for any infringement of 
such rights by you.

7. PASCO reserves the right to terminate this license upon breach. In the event of termination, you will be required 
to return all copies of this product or provide PASCO with a certificate of destruction of all copies.

8. In the event you modify the PASCO Product or include it in any other software program, upon termination of this 
license, you agree either to remove the software product or any portion thereof from the modified program and return it 
to PASCO or to provide PASCO with a certificate of destruction thereof.

9. If this product is acquired under the terms of a (i) GSA contract - use, reproduction or disclosure is subject to the 
restrictions set forth in the applicable ADP Schedule contract, (ii) DOD contract - use, duplication or disclosure by the 
Government is subject to restrictions set forth in subparagraph (c)(1)(ii) of 252.277-7013; (iii) Civilian agency contract - 
use, reproduction, or disclosure is subject to 52.277-19(a) through (d) and restrictions set forth in the accompanying 
End User Agreement. All rights reserved under the copyright laws of the United States, United Kingdom and 
elsewhere. MONOTYPE IMAGING Ltd, Unit 2 Perrywood Business Park, Salfords, Surrey, RH1 5DZ, England.
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